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About 2020 Worksheet 
2020 Worksheet is the most powerful furniture specification software in the office design 
industry.  Select and specify furniture products with the most up-to-date and accurate furniture data. 
Sales teams, design teams and order entry staff can all freely exchange electronic project information. 

With 2020 Worksheet, you can: 

 Quickly select a common set of options and finishes that can be applied to all related products 
in a single worksheet 

 Create a variety of customized reports and presentation materials 

 Assign discounts to an entire worksheet or selected items 

 Import from and export to other applications and manufacturer-specific formats 

 Manage re-configuration projects and inventory 

 Use Custom Catalogs to capture, manage and re-use common furniture configurations 
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Getting started 
When you first open 2020 Worksheet, two windows appear sequentially by default. You can turn them 
on/off at subsequent launch of the program. 

2020 Monthly What's New window (see What's new) 

Startup Wizard (see below) 

From the Startup Wizard dialog box, you get four options: 

 Use the Wizard to create new project folders, configure your existing projects and create a new 
worksheet. For more information see New worksheet using the Wizard. 

 Open an existing worksheet from one of your projects folders. 

 Open a recently used worksheet from one of your projects folders. 

 Start with a blank worksheet in your current project folder. 

Note: If you check Don't show this dialog box (default to a blank worksheet), this dialog box will not 
appear the next time you open 2020 Worksheet or create a new worksheet . However, you can still 
access the Startup Wizard later on by checking the Show startup wizard… box in the Preferences dialog 
from the Tools menu. 

See also Enter and edit items in a worksheet. 
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Hints and procedures 
As in other Windows applications, there are many ways to perform specific tasks in 2020 Worksheet. 

For example, when copying an item, you can: 

 Use the menu bar to select the command 

 Click on an icon on the toolbar 

 Right-click to access the context menu 

Instead of showing different ways of performing the same task, procedures in this help file show you 
only one way so that you can quickly learn how to use the application. 

Note: Make sure all the Worksheet toolbars are displayed for procedures directing you to click icons. 

 

Associated-visual and visual-only 
worksheets 
If you are working with a worksheet created in CAP Designer , two types can be available: 

An associated-visual worksheet (associated.visual.sp4) synchronizes all drawing information 
between Worksheet and CAP Designer with limited user interaction by prompting for an 
update when required. 

A visual-only worksheet (visual.sp4) pushes finish and room information (Visual Impression) 
to the drawing when you open or switch to CAP Designer and you use Update against worksheet. 
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When you open a worksheet, note that: 

 The associated worksheet has the same name as the drawing it was created from with the 
extension (.associated.visual.sp4) A visual worksheet can have a different name (.visual.sp4.) 

 You can open an associated-visual drawing by clicking  on the Worksheet toolbar. This 
command saves the worksheet and automatically updates the associated drawing before 
opening it. 

 You can visualize products in parts (scenes) or in whole (entire design) in Visual Impression, by 

clicking  

 If you no longer want this worksheet to be associated to the CAP Drawing, use the Save As 
command and save as a different file type. 

 If you add an item, the Unplanned icon appears in the first column (Item # column). When you 
update the drawing in CAP Designer, this unplanned item is saved in the drawing's Non-plan 
item list (NPIL). 
 

 
 The Qty value is the sum of non-planned and planned quantities. To view non-planned and 
planned values, activate the Non-plan Ct and Plan Ct columns. 
 
In the example below, there are no non-plan quantities of the first item in the worksheet. 
 

 
 
If you change the Qty, the non-Plan Ct value changes accordingly. Notice that the Unplanned 
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icon also appears in the first column. 
 

 
If you enter a value in Qty that is less than Plan Ct, Worksheet alerts you and resets the value 
back to the planned quantity. 

 You cannot edit the Mfg, Alt Mfg, Cat and Part Number 

 You cannot split items 

 When deleting an item, you will see a warning message 

 You will not be able to flatten outline levels and standards 

 If you have locks in a worksheet, they will be removed when you save the worksheet 

 When you cut or copy an item then paste it, that item will be considered as a non-plan item 
when you update the drawing against the associated worksheet 

 You can convert planned items to specials by checking the Special column 

 If you update preview images, your images will still be there even if you update the worksheet 
from CAP Designer later on. 

 Standards created in Worksheet are considered as non-planned. When you update the drawing 
in CAP Designer, the Standard will be listed in the Non-plan item list. 

 Outline levels created in Worksheet cannot be tied to a CAP bound within the associated 
drawing. As such, you cannot insert outline levels in an associated worksheet. 
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Using Help 
The following sections describe how to use options from the Worksheet Help menu and the Worksheet 
help Toolbar. 

The question mark - Topics option/icon  takes you to the Contents page of this help file. 
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Topics 

This option opens the topics of the help file you are in right now. 

What's new 

From the Help menu, click What’s New. From the window shown below, you can: 

 view announcements on 2020 Technologies commercial software 

 read about and download manufacturer catalog updates 

 view information about new commands, software fixes and known issues 

 download software or catalog updates. See also Check for software updates, Check for catalog 
updates 

 download PDF versions of the 2020 Technologies commercial software user manuals 

 download PDF files of Release Notes (What's New) as they become available 

 find training courses for 2020 Technologies software 
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 view a list of upcoming industry events in which 2020 Technologies will participate 

 obtain 2020 Technologies' contact information 
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User Guide 

To display a PDF format of the current help file for reading or printing, from the Help menu, select User 
Guide. 

Release Notes 

To read notes about the current release, from the Help menu, select Release Notes. 

View the 2020 Technologies website 

From the Help menu select www.2020spaces.com. 
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Diagnostics 

The Diagnostics command from the Worksheet Help menu is used by technical support to troubleshoot 
2020 software. 
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Check for software updates 

From the Help menu select Check for Updates. 
 
The Software Manager appears. From here you can view updates for your system, view update 
descriptions and download and install updates. 
 

For help on the Software Manager click on the Help   link/icon at the bottom right of the window. 

Check for catalog updates 

From the Help menu select Check for Catalog Updates. 
 
The Software Manager appears. From here you can view manufacturer catalogs updates, view update 
descriptions and download and install updates. 
 

For help on the Software Manager click on the Help   link/icon at the bottom right of the window. 

About 2020 Worksheet 

To verify your version number and obtain 2020 contact information, choose Help, About 2020 
Worksheet. 
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Screen components 
This section covers 2020 Worksheet screen components, along with a brief description. Click the 
component part below this illustration to get more details. 

 
 Caption bar 

 Menu bar 

 Toolbars 

 Explorer pane 

 Preview pane 
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 Worksheet area 

 Task pane 

 Status bar 

As in any standard Windows application, you can use context menus to quickly access commands. 

Note: The recommended screen resolution is 1280 x 1024.  The minimum resolution needed is 1024 x 
768.  You will need to set your screen resolution to the minimum to easily work within 2020 Worksheet. 

Caption bar 

The caption bar is primarily a label for the software. 

To show or hide the caption bar, right-click near the caption bar and select Caption Bar.  

Menu bar 

Located on top of the 2020 Worksheet screen (below the caption bar) are menu names (from File to 
Help). They list the tasks you can perform in 2020 Worksheet. 
You can dock/undock and move the menu bar as you would for toolbars. 

To quickly find the help topics and shortcuts that correspond to each menu item, see the following 
under Command reference: 

 File menu 

 Edit menu 

 View menu 

 Item menu 

 Worksheet menu 

 Reports menu 
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 Visualize 

 Tools menu 

 Help menu 

Toolbars 

As in standard Windows applications, toolbars in 2020 Worksheet allow you to perform frequent 
operations quickly with icons (images representing an action or a command). 

You can easily customize toolbars. See the topics below for more information: 

 Show or hide a toolbar 

 Move a toolbar 

 Add and remove buttons 

 Custom toolbars 

There are several built-in toolbars in 2020 Worksheet, each representing a category of commands. You 
may change their position to suit your needs. See the topics below for information on each toolbar: 

 Standard 

 View 

 Item 

 Worksheet 

 Report 

 Visualize 

 Help 
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Show or hide a toolbar 

1. Right-click anywhere in a toolbar area and then mouse over Tool Bars. 

2. Select the toolbar name to toggle the toolbar on or off. 
 

If it is off (no  next to the name), click it and the toolbar will appear on your 

screen (a  will also appear next to its name). Selecting it again will turn it off. 

Move a toolbar 

You can display or hide toolbars, and you can save your selections as a workspace. You can also 
create your own toolbars. 

A toolbar can be floating or docked. A floating toolbar is displayed anywhere in the worksheet area, and 
you can drag a floating toolbar to a new location, resize it, or dock it. A docked toolbar is attached to 
any edge of the worksheet area. You can move a docked toolbar by dragging it to a new docking 
location. Click-hold the left edge of the toolbar to move it around. To dock/undock a toolbar, double-
click on the left ledge. 
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Add and remove buttons 

Customizing a toolbar consists of adding buttons to a built-in (Standard, View, Item, Worksheet, Report 
or Tools) or custom toolbar. 

1. Click the View menu and select Toolbars, Customize. You can also right-click on any toolbar. 
2. Click the Commands tab in the Customize dialog box. 
3. To remove a button from a toolbar, click-hold the button in the Commands pane and then drop 

it anywhere off outside the list. 
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To add a button to a toolbar, under Categories, highlight the toolbar you want to choose icons 
from. Click-hold a button under Commands and then drag it to the desired toolbar. 
 

 
  

4. Click Close when done adding/removing buttons. 

Note: Your custom toolbars will not stay if you have multiple sessions of Worksheet open when you 
customize the toolbars. Make sure only one worksheet is open when customizing. 
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To reset a modified built-in toolbar: 

If you added or removed buttons to a built-in toolbar, here is how you can retrieve the original toolbar: 

1. Choose View, Toolbars, Customize. 

2. Click the Toolbars tab. 

3. Click the modified built-in toolbar. 

4. Click Reset. 

5. Click Close. 

Note:  You cannot reset a custom toolbar. 

Custom toolbars 

Creating a toolbar consists of using buttons from existing 2020 toolbars to make up a custom toolbar. 

1. Click View, Toolbars, Customize. 
2. From the Customize dialog box, click the Toolbars tab. 
3. Click New to create a toolbar. 
4. Type in a toolbar name and click OK. 

An empty toolbar appears. The new toolbar will expand as you add buttons to it. 
5. Click the Commands tab. 
6. Under Categories, highlight the toolbar you want to choose buttons from. 

Click on a button to see its description at the bottom of the dialog. 
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7. Drag the required buttons to the empty toolbar you just created. 
 

 
8. Click Close to end. 

See Delete a custom toolbar. 
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Delete a custom toolbar 

1. Choose View, Toolbars, Customize. 
2. Click the Toolbars tab. 
3. Select the custom toolbar to remove. 

 

 
4. Click Delete. 
5. Click Close. 
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Standard 

 

Icon Name Shortcut Function 

 

New Ctrl+N Create a new worksheet 

 

Open Ctrl+O Open an existing worksheet 

 

Close Ctrl+F4 Close the current worksheet 

 

Save Ctrl+S Save the current worksheet 

 

Save As   Save the current worksheet 
under a different name 

 

Save All   Save all open worksheets 

 

Print Ctrl+P Print the current worksheet 

 

Print Preview   Preview the current 
worksheet before printing 

 

Project 
Properties 

Ctrl+Enter Edit project template settings 

 

Worksheet 
Properties 

Alt+Enter Edit Worksheet properties: 
title, customize column 
settings, page header and 
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footer setup and price 
adjustments 

 

Project 
Management 

Ctrl+M Edit project notes 

 

Import 
Center 

  Import a file into the current 
document 

 

Export 
Center 

  Export a file from the current 
document 

 

Cut Ctrl+Shift+X Cut selected or if nothing is 
selected, the current item 

 

Copy Ctrl+Shift+C Copy selected or if nothing is 
selected, the current item 

 

Paste Ctrl+Shift+V Paste the last item(s) that 
was cut or copied 

 

Undo Ctrl+Z, 

Alt+Backspace 

Undo an action. The drop 
down allows multiple steps 
to be undone at one time 

 

Redo Ctrl+Y, 

Ctrl+Backspace 

Redo an undone action. The 
drop down allows multiple 
steps to be redone at one 
time 

 

Find Ctrl+F Find any string in the 
worksheet 
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Quick Find   Enter a value to search the 
entire worksheet or click the 
dropdown to reuse a 
previous search string 

 

Replace Ctrl+R Replace an existing value 
with a new one 

 

Preferences F10 Edit Worksheet Preferences 

 

Contact 
Manager 

  Add/edit contacts. 

 

Help F1 Open the 2020 Worksheet 
Help file 

View 

 

Icon Name Shortcut Function 

 

View 
Contents 

  Display or hide the Content tab of the 
Explorer pane. 

 

View 
Projects 

  Display or hide the Projects tab of the 
Explorer pane. 

 

View Task 
Pane 

  Display or hide the Task Pane. 
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Full Screen 
View 

Ctrl+Alt+V Turns Full Screen View on and off. 

 

Step In   Display the products in a Standard or 
Outline Level. 

 

Step Out   Display the Standard or Outline Level. 

 

Apply 
Template 

  Opens a drop-down menu to access the 
Manage Template function and all 
available templates that can be 
applied. 

 

View 
Products 

Ctrl+Alt+P Clicking this button turns the product 
lines on or off. 
 
Clicking-holding this button opens a 
flyout menu which additional view 
options. 

      
View 
Options 

Ctrl+Alt+O Turns the options on or off. 

      
View 
Attributes 

Ctrl+Alt+A Turns the attributes on or off in a 
worksheet 

      
View 
worksheet 
Links 

Ctrl+Alt+L Turns the worksheet links on or off in a 
worksheet 

      
View 
Custom 

Ctrl+Alt+S Turns the Standards on or off in a 
worksheet 
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Catalog 
Standards 

      
View 
Outline 
Levels 

Ctrl+Alt+T Turns the outline levels on or off in a 
worksheet 

      
View Price 
Adjustments 

Ctrl+Alt+B Turns the price adjustments on or off in 
a worksheet 

      View 
Subtotals 

Ctrl+Alt+U Turns the subtotals on or off in a 
worksheet 

 

Rows   Opens a drop-down menu that allows 
rows to be turned on and off in a 
worksheet. 

Item 

 

Icon Name Shortcut Function 

 

Insert 
Product 

Ctrl+Shift+P Add a product line to the 
Worksheet.  Click and hold the 
button to open a flyout menu 
which contains all other insert 
options explained below. 
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      Insert Option Ctrl+Shift+O Add an option line to the current 
Worksheet item 

      Insert 
Attribute 

Ctrl+Shift+A Add an attribute to the current 
Worksheet item 

      Insert 
Outline Level 

Ctrl+Shift+T Add an outline level to the 
Worksheet 

      Insert 
Custom 
Catalog 
Standard 

Ctrl+Shift+S Add a Standard to the 
Worksheet 

      Insert 
Custom 
Catalog Panel 
Configuration 

  Insert a panel configuration from 
a custom catalog into the 
worksheet 

      Insert 
Worksheet 
Link 

Ctrl+Shift+L Add a worksheet link to the 
Worksheet 

      Insert 
Adjustment 

Ctrl+Shift+D Add a price adjustment to the 
Worksheet 

      Insert 
Subtotal 

Ctrl+Shift+U Add a subtotal to the Worksheet 

 

Insert   Allows the items from the 
dropdown to be added to the 
Worksheet 
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Delete Ctrl+Shift+Del Delete the current row 

 

Move Up Ctrl+Shift+UpArrow Move the current item up in the 
Worksheet 

 

Move Down Ctrl+Shift+DownArrow Move the current item down in 
the Worksheet 

 

Item 
Properties 

Ctrl+Alt+Enter View all the details of the 
current item 

 

Specify F8 Add finishes in 2020 Options 

 

Explore F9 Open Content tab to the 
location of the current item 

 

Send To   Opens a drop-down menu. 
Sends items to Custom Catalogs, 
Worksheets, and Drawings 

 

Toggle Flag   Turns the Flag column on and 
off.  Click and hold the button to 
open the Flag flyout menu. 

See Flag lines. 

 

Toggle Lock   Turns the Lock column on and 
off.  Click and hold the button to 
open the Lock flyout menu. 

See Lock lines. 
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Worksheet 

 

Icon Name Shortcut Function 

 

Customize 
Columns 

  Opens the Worksheet properties dialog to 
adjust column setting. 

 

Resize 
Columns 

  Resize all columns automatically so all 
contents are displayed. 

 

Multi Sort   Sorts multiple columns. 

 

Sort 
Settings 

  Opens a drop-down menu to access the 
Manage Sort Settings function and all 
available saved Sort Settings that can be 
applied. 

 

Assign   Assigns a value to a column, option or 
attribute. 

 

Block 
Assign 

  Copies the options or attributes from one 
item to others. 

 

Column 
Copy 

  Copies the contents of one column to 
another column. 

 

Select All Ctrl+A Selects all items in the Worksheet. 
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Clear 
Selection 

Esc Deselects all items in the Worksheet. 

 

Consolidate   Merges like items in the Worksheet. 

 

Update 
Against 
Catalog 

Ctrl+U Updates all or selected items against the 
Manufacturer or Custom Catalog. 

 

Update 
Against 
Worksheet 

  Updates items against a selected Worksheet 
by product number or tag. 

 

Update 
Preview 
Images 

  Updates preview images of items in the 
Worksheet. 

 

Apply 
Discount 

Ctrl+D Opens the Discount dialog box. 

 

Show 
Associated 
Drawing 

  If the current worksheet is associated to a 
drawing, opens AutoCAD and loads the 
associated drawing. 
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Report 

 

Icon Name Function 

 

Quick 
Report 

Creates a quick report based on the columns displayed 
in the worksheet. 

 

Edit 
Report 
Design 

Edit the active report in the Report Designer. 

 

Manage 
Reports 

Create, edit, and manage your report designs. 

 

Refresh 
Report 
View 

Refreshes the report view to show any changes in 
design or content of the current worksheet. 

 

Report 
Designs 
Drop 
Down 

Shows the available standard and user reports that can 
be applied. 
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Visualize 

If the current worksheet was created from a CAP Designer drawing, you can open Visual Impression to 

visually specify product and room finishes by clicking the Visualize  button 

If scenes were defined in CAP Designer for the drawing, you can choose among named scenes. 
Otherwise, choose Entire Design. 

 See also Visualize a scene or all products in Visual Impression 

Explorer pane 

The Explorer pane is a powerful navigation utility that lets you browse multiple furniture catalogs at one 
time, as well as find all the files that you will use and create. 
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The Explorer pane consists of four tabs: 

 Content tab: displays manufacturer catalogs. 

 Projects tab: navigates to all project folders containing worksheet files and CAP Designer 
drawings. 

 Search tab: allows you to search for products and displays products found after a search. 

 Bookmarks tab: shows the bookmarks saved on your system. 

See the following topics to move or hide the Explorer bar: 

 Move the Explorer bar 

 Auto-hide feature (Explorer bar) 

 Show or hide Explorer bar tabs 

Move the Explorer pane 

With the flexibility of AutoHide, floating and docking, you can tailor the 2020 Worksheet screen to the 
way you work. 

Explorer is normally docked at left of the worksheet area, but you can undock it and drag it elsewhere. 

1. Click and hold the title bar at the top. 

2. Drag the Explorer pane to the location you prefer.  The window can float above 
the worksheet or you can dock it.  To dock on either side, top, or bottom, move 
the mouse as you are dragging to the control buttons. 
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When Explorer is docked, you can resize the window by dragging on the vertical bar between Explorer 
and the Worksheet area. 
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Auto-hide feature (Explorer pane) 

By putting the Explorer pane on auto-hide you can see more of your worksheet when you are not using 
any of the Explorer tabs. 

1. Click on the push pin icon in the title bar.  
 

 
 
The Explorer bar will collapse and be on the far left side of your screen. 

2. To access any of the Explorer tabs, hover over the desired tab icon and that tab will 
open. 
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Show or hide Explorer pane tabs 

By default, all of the Explorer pane tabs are visible when you open 2020 Worksheet. 

You can close and open each of the different tabs individually by doing any of the following: 

 From the menu bar select View, Explorer Bars. Select the tab you want to show or hide. 

 Right-click on any toolbar or button in 2020 Worksheet then select Explorer Bars. Select the tab 
you want to show or hide. 

 You can turn on/off the Content, Projects tabs and Task pane on and off by using these toolbar 
buttons: 
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Note:  Instead of hiding each Explorer tab individually, a more efficient way to work with the Explorer 
pane is to set it to auto hide.   

Content tab 

Use the Explorer pane Content tab to access the manufacturer catalogs you have installed. 
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From the Content tab you can: 

 Navigate catalogs 

 Use QuickSearch to find products 

 Drag and drop products to a worksheet 

 Bookmark products used often 
 

Note:  To find an item quickly in the Contents tab, right-click on the corresponding graphic and choose 
Explore. 

To customize the appearance of the Content tab: 

1. From the menu select Tools, Preferences to open the Preferences dialog. 

2. Click Content to control the manufacturers and catalogs displayed here. By 
default, all catalogs are loaded and available at the same time. 
 
Click Explorer to show content as a tree instead of as a list. 
 
Click Common to show grid lines between each item in the Content tab. 
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Projects tab 

The Explorer pane Projects tab allows access to your project hierarchy. You can open 2020 Worksheet 
files or AutoCAD drawings. You can quickly copy an item from one worksheet to another worksheet or 
drawing without opening the original worksheet. You can also quickly view the contents of a custom 
catalog, including Standards. 

 
You can view a quick description and details of an item in the Projects tab by using the horizontal scroll 
bar at the bottom or resizing the Projects tab. 

See Projects for more information. 

  



39 

Search tab 

The Explorer pane Search tab allows you to search for products.  Clicking the Search icon . 

Once you have finished searching, this tab shows the products found. This tool is useful when searching 
multiple catalogs for products with a common element (panels, for example). These items are 
consolidated under the Search Results. 

From here you can select products and send them into drawings or worksheets or drag and drop them 
as you would from the Content tab of Explorer. 
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Bookmarks tab 

The Bookmarks tab contains a list of bookmarks that you have added. From here you can organize 
bookmarks or open a bookmark folder to view its list of products. 

To open a bookmark folder: 

1. From the Explorer pane Bookmarks tab, click on   to expand a folder. By default, 
bookmarks are saved under the Content folder. 

2. Continue clicking on the plus sign until you see the list of products in a bookmark. 
 

 
 

Note:  If you don't see the bookmarks you just added, click . 

3. Drag and drop a product to a worksheet or send it to a drawing or worksheet. 
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Preview pane 

To show the Preview pane, click the View menu and Preview Bar. 

As you mouse over selections in the Explorer, the Preview pane displays images. Also, you can preview 
multiple items if you select a standard from a custom catalog (Projects tab). Note that the standard 
must have been created within CAP Designer, not Worksheet. 

For information on what you can do in the Preview pane, see Preview a product. 

 
 

Note:  Just like the Explorer pane, you can auto-hide and move the Preview pane. 
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Worksheet area 

The worksheet area is where you can: add products, discounts and price adjustments; specify finishes; 
customize the worksheet cover page; and produce reports. 

Within the worksheet area there are worksheet tabs so you can work on many worksheets at the same 
time. 

Each worksheet has four tabs: 

 Worksheet 

 Global Options 

 Cover Page 

 Report 

Worksheet tabs 

Worksheet tabs allow you to have many worksheets open at the same time.  

1. To move between worksheets click on the desired tab. 
 

 
2. If the worksheet is not visible, click the drop-down arrow to the right of the tabs 

and select the desired worksheet. 
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Each worksheet has four view tabs: 

 Worksheet 

 Global Options 

 Cover Page 

 Report 

Worksheet tab 

The Worksheet tab is the default Worksheet area view.  From this tab you can enter and edit items in a 
worksheet. 
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To resize the worksheet text size, from the menu select Tools, Preferences, then click Display. 

To show or hide rows, see Show or hide rows. 

See also: 

 Resize columns 

 Display or hide a column 

 Customize columns 

 Description of worksheet columns 

Show or hide rows 

You can choose to view or hide products, options, attributes, standards, outline levels, worksheet links, 
price adjustments, subtotals and the grand total. 

To show or hide rows, from the View menu, select Rows, then select the item type. 

Note:  When you hide an item type, you will not be able to insert an item of that type later on unless 
you show the item type again.    
For example, if you hid Price Adjustments, then go to the Item menu then select Insert, the Price 
Adjustments type will be disabled. 

Resize columns 

To resize a column: 

1. Position the cursor on the edge of the area of column to resize until you see the 
cursor change to a double arrow. 
 

 
2. Click and hold the mouse button, drag to resize, then release when you reach the 

desired dimension. 
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To automatically resize a column: 

1. Place your cursor to the right of a column heading and wait for the double arrows 
to appear. 

2. Now double click and the column size will automatically adjust to the appropriate 
width, based on all line items. 

To resize all columns to view all the information in each column: 

Right-click on any column header and select Resize Columns. You may need to adjust the Part 
Description column after this function.  

Display or hide a column 

1. Right-click on any column header. 

2. Select Columns. 

3. Select the group to which the column belongs. 

4. Click the column you wish to turn on or off. 
 
A check mark beside a column name indicates that the column is displayed in the 
worksheet. 
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Note:  If you want to turn off multiple columns, it is faster to use Customize columns. 
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Customize columns 

Worksheet has over 40 columns of information. Showing all these columns would take up too much 
room on the screen and on a printout. As such, some columns are not displayed by default. Use 
Customize columns to show certain details of items like Tag or discount information, or to hide details 
such as the List Price. 

To customize columns, right-click on any column header then select Customize Columns. 

In the Worksheet Properties dialog, you can view columns using either the Standard or Grouped view. 
In Grouped View, columns are organized by categories. 

To: Do this: 

Display or hide a column 

Check or clear the check boxes next to the column 
names. 

In Grouped View, if you want to check all columns 
under one group, check the group name. 
 
You can also right-click on the column to show or hide. 

Modify a column's position in 
the worksheet (you can do this 
only in Standard view) 

Select the column and drag it up or down. 

Change the column header text 

Change the Text value. 

This field can be used to add your own customized 
columns.  For example, click on one of the Alias 
columns, then change the Text value. 
 
Even if you change the column header text here, its 
field name will not be changed in Report Designer. 
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Resize the column width 
Beside Width, enter the value in pixels. 

For a quicker way, see Resize Columns. 

Define the justification of text 
in the column Change Justify to Left, Center or Right. 

Change the data type accepted 
by the column 

Beside Type, select the data type. You can only 
change the data type of certain columns. 

Disable a column, make it read-
only or set is as readable and 
writable 

Beside Mode, select: 

Disabled - user cannot click on the column 

Read Only - user can click but cannot modify a value 

Read and Write - user can click and modify a value 

 

See also: Description of worksheet columns 

Note:  You can save a column configuration in a worksheet template and apply the template to other 
worksheets so that they will have the same column settings.  See Worksheet templates. 

Description of worksheet columns 

Click on the group name below to see a brief description of each column in the group. 

 Catalog Info columns 

 Counts columns 

 Discounts columns 

 International columns 

 Item Management 

 Miscellaneous columns 
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 Price Zones columns 

 Pricing columns 

 Tagging columns 

 Totals columns 

 Views columns 

Catalog Info columns 

Column Description 

Preview See Preview column 

Mfg Manufacturer code 

Cat Catalog 

Part Number Part Number 

Option Group Option Description 

Part Description Part Description 

Category Furniture type 

Weight Weight 

Volume Volume 

Unit List Option up charges 

Unit Purchase Option up charges 

Catalog Tag 1 For future use 
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Catalog Tag 2 For future use 

Catalog Location Location of item in Catalog hierarchy 

Alt Mfg Alternate Manufacturer. The Mfg code of the archived 
catalog. 

Catalog Order Number representing the order that a product appears in a 
catalog.  The first product encountered is 1, and so on.  You 
can use this field to sort parts in an order similar to paging 
through the printed catalog. 

Catalog Date The date the catalog file was compiled by 2020 and not the 
date the catalog was last updated. 

Counts columns 

Column Description 

non-Plan Ct Used for a worksheet associated to a CAP Designer drawing.  Displays 
the quantity that was added in 2020 Worksheet. 

Plan Ct 
Used for a worksheet linked to a 2020 Office Sales design or a 
worksheet associated to a CAP Designer drawing. Displays the 
quantity that is in the plan or drawing. 

Pkg Type Package Type 

Pkg Ct Package Count 

Count Pkg Count x Quantity 

Qty Quantity 
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Discounts columns 

Column Description 

Sell-% Sell Discount off list 

Sell+% Sell Discount over Purchase 

Purchase% Purchase Discount off list 

Margin% Margin Discount 

DPP% Dealer Purchase Price Discount 

  

International columns 

Column Description 

List Adjust Percentage adjustment applied to List 

Exch Rate  Exchange rate percentage 

Exchg Base Exchange Base amount 

Exch List Exchange List amount 

Exch Purchase Exchange Purchase amount 

Exch Sell Exchange Sell amount 

Exch Margin Exchange Margin amount 
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Item Management 

Worksheet has five columns used for additional control on a line by line basis: 

 Color - Displays a user-specified color, which can be set multiple ways. 

 Complete - indicates if the item is optioned and complete, optioned but needing an update, 
incomplete or unknown 

 Lock - lock items from being updated or edited 

 Flag - flag an item for a specific reason; also set automatically when an item is not found after 
updating against a catalog 

 Annotate - add or edit an item note 

The status of these columns will be saved with the worksheet and remain set even when you close the 
worksheet. 

When the Complete, Flag and Lock columns are turned off, the icons will still be visible in the Item 
column. 

 
Note:  When the Flag and Lock columns are turned off, you cannot change their values unless you turn 
on the column or use the Item Detail view of the Task Pane. 
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When printing a worksheet, you can choose whether or not to print the Flag, Lock and Complete icons 
in the Item column when those columns are not visible. This preference is set by going to Tools, 
Preferences, then selecting General. By default this preference is turned on. 

Miscellaneous columns 

Column Description 

Special Checkbox to indicate if this is a custom item. See Change an 
existing part into a custom item. 

Quote # Field for Design Express users that corresponds to the PRJ# field. 
This identifies a special item. 

Include 1 Checkbox used to include the worksheet item. Defaults to checked. 
This column could be used to include the item when calculating a 
price adjustment or discount. 

Include 2 Checkbox used to include the worksheet item. Defaults to checked. 
This column could be used to include the item when calculating a 
price adjustment or discount. 

Include 3 Checkbox used to include the worksheet item. Defaults to checked. 
This column could be used to include the item when calculating a 
price adjustment or discount. 

Exclude 
1 

Checkbox used to exclude the worksheet item. This column could 
be used to exclude the item when calculating a price adjustment or 
discount. 

Exclude 
2 

Checkbox used to exclude the worksheet item. This column could 
be used to exclude the item when calculating a price adjustment or 
discount. 
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Exclude 
3 

Checkbox used to exclude the worksheet item. This column could 
be used to exclude the item when calculating a price adjustment or 
discount. 

Date Requested date for the item. Double-click to show the current 
date. Click on the day, month or year then type the new value or 
use the Up or Down buttons. Use the rightmost button to select 
the date using a calendar. 
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Price Zones columns 

Column Description 

PZ Prize Zone 

PZ 
Description Price Zone Description 

PZ 
Currency Price Zone Currency 

  

Pricing columns 

Column Description 

List Mfg. published list 

DPP Dealer Purchase Price 

Purchase Purchase amount 

Sell Sell amount 

Margin Margin amount 

User 1 User defined amount 
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User 2 User defined amount 

User 3 User defined amount 

Base Base price of an item, which is the unit list price of the single 
product alone, without any option up-charges added in 

Tagging columns 

Column Description 

Tag Tag 

Generic Various uses 

Alias 1 User defined field 

Alias 2 User defined field 

Alias 3 User defined field 

Building Building 

Floor  Floor  

Department  Department  

Person Person 

Finish Code A tag field used with Panel Builder.  You set this value in Panel 
Builder and use it in Worksheet to select the appropriate 
options. 
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Totals columns 

Column Description 

Ext List Extended List total amount 

Ext DPP Extended Dealer Purchase Price total amount 

Ext Purchase Extended Purchase total amount 

Ext Sell Extended Sell total amount 

Ext Margin Extended Margin total amount 

Ext User 1 Extended User total amount 

Ext User 2 Extended User total amount 

Ext User 3 Extended User total amount 

Ext Weight Extended Weight total 

Ext Volume Extended Volume total 

Ext Base Extended Base total amount 
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Views columns 

Column Description 

Plan 
View 

Legacy field - Cadvance 

Elev 
View 

Legacy field - Cadvance 

3D View Legacy field - Cadvance 

  

Preview column 

 
If an item in a worksheet has a preview image available, the image will be displayed in the Preview 
column. The image is displayed in 64 x 64 pixels. 

A preview image for an item is displayed in the Preview column if the item: 

 was dragged and dropped from the Explorer pane to the worksheet area — the image displayed 
in the Preview column will be the same as the one displayed in the Preview pane 

 was pasted onto the worksheet from another item that contains a preview image already 

 was sent from one worksheet to the current one and the item from the source worksheet 
already contains a preview image 

 comes from merging items that already contain a preview image 
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A Preview is also displayed if Update Preview Image   is clicked. 

The Preview column is empty if: 

 the item was added using the Send To command from CAP Designer, Search or Options 

 the item comes from imported data 

 the item was created from a takeoff (file was created from CAP Designer using the Create 
Worksheet File command) 

 the image does not exist 

Note:  When there is no image is displayed in the Preview column, use the Update preview images 
command to display the image. See the topic Update preview images. 

  



60 

Global Options tab 

Global Options allows you to apply the same finish to more than one line item if the finish is 
available.  This allows for more consistent specifications. See Global Options for more information. 
 

 

  



61 

Cover Page tab 

Cover page is a customizable page that will pull information form the worksheet and Worksheet 
Properties to populate fields of information.  

See Cover page for more information on how to use one of the default cover pages or create your own 
cover page. 
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Report tab 

The Report tab allows you to use one of the default report configurations or create your own report 
configurations for printing worksheet information.  

See Reports. 
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Task pane 

By default, the Task pane is visible when you open 2020 Worksheet. To find out how to hide or display 
the Task pane, see Show or hide the Task pane. 

The Task pane is similar to the Explorer pane. There are 3 views that contain different sets of 
information:  

 Worksheets - provides quick access to commonly used tasks 

 Item Detail - lists all of the available columns of information for a selected or current line item in 
the current worksheet 

 Option Clipboard - stores options that can be applied to other line items within the current 
worksheet or saved as an Option Set for use in other worksheets 

To access a view: 

Click on the drop-down arrow and select the view. 

 
 

Note:  To see more of your screen when you are not using the Task pane, use the Auto-hide feature. You 
can also Move the Task pane. 
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Show or hide the Task pane 

By default, the Task pane is visible when you open 2020 Worksheet.  To show or hide the Task pane, 
select View, Task Pane, Visible from the menu. 

See also: 

 Move the Task pane 

 Auto-hide feature (Task pane) 

Move the Task pane 

The Task Pane can be docked (attached to the side of the Worksheet window) or undocked (unattached 
and floating in the middle of the Worksheet window). 

If you drag the undocked Task Pane by its title bar, docking arrows will appear on the screen. These 
arrows indicate the locations where the Task Pane may be docked. Hover the cursor over one of the 
docking arrows to automatically dock the Task Pane along the edge of the screen. 
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Auto-scroll bars 

If the contents of a Task Pane view is too extensive to be viewed at one time, auto-scroll bars appear at 
the bottom and/or the top of the view. Hover over these auto-scroll bars to automatically scroll the 
view. 
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Auto-hide feature (Task pane) 

By putting the Task pane on auto-hide you can see more of your worksheet screen when you are not 
using any of the Task pane features. 

1. Click the push pin on the Task pane. 
 

 
 
The Task pane will collapse and be on the far right side of your screen. 

2. To access the Task pane, mouse over the Task pane label or icon and it will open 
to the last view you were in. 
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Worksheets view 

The Worksheets view of the Task pane gathers most popular commands for worksheets. 
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In the Worksheets view you can: 

 Open one of the last 5 worksheets you worked on 

 Create a new worksheet quickly, either blank or from a template 

 Manage worksheet templates 

 Manage projects 

 Set worksheet properties 

 Print the worksheet 

 Update items against a catalog 

 Update items against a worksheet 

 Consolidate identical items 

 Apply a discount or discount schedule 
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Item Detail view 

If you have several columns in your worksheet, use the Item Detail view to quickly see all columns of an 
item, instead of scrolling across the worksheet. 
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The Item Detail view provides information about any line item that is marked as current in the active 
worksheet, as well as consolidates commonly performed commands related to line items. 

The item information portion of Item Detail displays every property for the current line item and the 
corresponding value assigned to that property. Property names are displayed as Column headers in the 
worksheet. 

Some of the commands available in Item Detail view are: 

 Preview an item 

 Specify (assign options to) the line item 

 Explore to that item’s location in the catalog content 

 Send an item to a worksheet or a drawing 

 Move a line item up or down in the worksheet 
 

Note:  If you change a value in a column (for example: changing Qty), the Item Detail will be updated 
automatically to display the new value. The reverse is also true. If you change a value in the Item Detail 
view, the line item in the worksheet is automatically updated. 
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Option Clipboard view 

The Option Clipboard view is used for quickly applying options to a worksheet from similar items in the 
same worksheet, a previously opened worksheet, or from a saved Option Set file. 

 
For more information on what you can do in the Option Clipboard, see Option Clipboard. 
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Status bar 

The Status bar contains general information about the current worksheet, such as:  

 the Total List, Purchase and Sell Price for the worksheet 

 whether you are on a Product line, an Option Line or an Attribute line 

 where you are in the current worksheet: the item number, the row and 
column (similar to Microsoft Excel) 

 
Note:  You can hide the Status bar by choosing View, Status Bar. 
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Context menus 

Context menus—right-click menus—display a subset of commands that are specific to the context or 
the element selected. 

To display a context menu, right-click. For example, in the Content tab of the Explorer Pane, mouse over 
the product you want to specify finishes for, right-click and then click Specify. 
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Create a worksheet 
There are several ways you can create a worksheet: 

 create a worksheet from CAP Designer or Giza.  For details on creating a worksheet from any of 
these applications, consult the application's help file. 

 create a new blank worksheet 

 create a new worksheet using the Wizard 

New blank worksheet 

1. Click  on the Standard toolbar. 

2. Click Blank.  You now have a blank worksheet where you can start placing products. 
 
Note:  In the Startup Wizard you can check Don't show this dialog (default to a 
blank worksheet) so that the next time you click the New icon, a blank worksheet is 
created automatically. This setting will be saved in your preferences. 
 
Note:  If you click Wizard, you can use the Wizard to configure your projects and 
create a new worksheet. 

See also: 

 New worksheet using the Wizard 

 Save a worksheet 

 Close a worksheet 

 Add products using drag and drop 

 Add products using Insert 
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New worksheet using the Wizard 

When you create a worksheet using the New Worksheet Wizard, the selected project's template is 
applied to the worksheet.  The worksheet is also automatically saved in the appropriate project folder. 

1. From File menu select New Worksheet Wizard. 

2. Select the Projects folder where you want to save the new worksheet. 
 
Note:  To create a new project folder, click on All Projects or a project folder then 
click New. Type in a name for the new folder. See Manage projects for other project 
folder commands. 

3. Click Next. 

4. Modify the project's properties (Template info).  Click Next. 
 
Note:   To change which options are checked whenever this dialog box appears, 
from the menu, select Tools, Preferences then select Common preferences. 

5. Enter the name of the worksheet and then click Finish. 

See also: 

 New blank worksheet 

 Save a worksheet 

 Close a worksheet 

 Add products using drag and drop 

 Add products using Insert 

  



77 

Open, save and close a worksheet 
Refer to the following topics: 

 Open a worksheet 

 Save a worksheet 

 Close a worksheet 

Open a worksheet 

1. Click  on the Standard toolbar. 
  

2. If you want to apply the current project's template when opening the worksheet, 
check the box under Project Support. 

3. In the Look in field, choose the disk/folder where the required design is located. 

4. In the List of files and folders area, select the file then click Open. 

Note:  To open a file you recently worked on, select File, Open Recent Worksheet.  Select the file from 
the list. Worksheet lists the 10 last files you worked on. 

Save a worksheet 

To save the current worksheet: 

1. Click  on the Standard toolbar. 

2. If this is the first time you are saving the worksheet, you will see the Save As dialog. 
 
In the Save in field, choose the disk/folder where you want to save the worksheet. 
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In the File name field, type in the name of the file and press ENTER. 

To save the current worksheet under a different name, click  in the Standard toolbar. Do the same 
actions as in step 2 above. 

If the current worksheet is an associated worksheet (associated.visual.sp4) and you want to save it as a 
visual-only worksheet (visual.sp4), use Save As Visual Worksheet. 

If the current worksheet is a visual (visual.sp4) worksheet and you want to save it as a classic .sp4 file, 
use Save As Classic Worksheet. 

To save all modified worksheets, click   in the Standard toolbar. Do the same actions as in step 2 
above. 

See also: 

 Save as single level worksheet 

 Associated-visual and visual-only worksheets 

Close a worksheet 

To close a worksheet, click the Close button in the worksheet tab. 
 

 
To close all open worksheets, select File, Close All. 
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Import, export and convert data 
2020 Worksheet gives you the flexibility to work with other applications and file formats. You can: 

 Import data 

 Export data 

 Convert data 

Import data 

You can create worksheets quickly by importing data from other applications. 

1. Make sure to have a blank worksheet open.  The import function will add the 
imported products to your current worksheet. 

2. From the File menu, select Import Center.  

3. In the Import Center dialog, select the format of the file you want to import.  When 
you select a format, its description is displayed on the right side. 
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Note:  If you want to remove some formats from the list, click Select Formats. In the 
Select Formats for Import dialog clear the checkboxes of the formats you want to 
hide then click OK. 

4. Click Import to choose the file. 

5. From the Choose a file to import from dialog box select the file to be imported then 
click Open. 

6. Once the import is done, you may see an Import Log reporting all the products 
imported.  Click the Items with Warnings or Errors tab to see if any items had error 
messages. You may save the log if you want. 

7. After the import is complete you may be prompted to consolidate identical items in 
the worksheet and update your worksheet against the catalogs. Click Yes. 

Note:  Worksheet remembers the last used format so the next time you open the Import Center, the 
last used format is automatically selected. The Steelcase SpecSIF option is for files with .ssf extensions. 
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This is used to SIF from Hedberg. The Steelcase Partial SpecSIF is for files with .psf extensions. This is 
also used to SIF from Hedberg. 

Export data 

This feature lets you export 2020 Worksheet files to a variety of formats. 

1. From the File menu, select Export Center. 

2. Select the format of the file. When you highlight a format its description is displayed 
to the right. 
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Note:  If you want to remove some formats from the list, click Select Formats. In the 
Select Formats for Export dialog clear the check boxes of the formats you want to 
hide then click OK. 

3. If you want standards and outline levels flattened, and identical items consolidated 
in the new file, check Export from a flattened and consolidated view of the 
worksheet. 

4. Click Export. 

5. In the Choose a file to export to dialog select the folder, type the file name then 
click Save. 

Notes: 

 Worksheet remembers the last used format so the next time you open the Export Center, the 
last used format is automatically selected. 

 CAP Studio SIF has all the new 32-bit SIF codes applied to it and can be read by other software 
applications like EDI (electronic ordering) systems 

 Legacy CAPSIF  is a classic CAPSIF file that CAPSpex created using old 8-bit code 

 Steelcase SpecSIF (.SSF) option is used to SIF to Hedberg 

 Steelcase Partial SpecSIF (.PSF) is also used to SIF to Hedberg 

 Teknion SIF includes panel configurations created from Worksheet 

 Before exporting to a Global Order Entry XML or a Global Contract SIF, you must set certain 
fields in the Worksheet Properties. See Global Order Entry in the 2020 Worksheet 
Manufacturer-Specific Information Help. 
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Convert data 

From the Convert sub-menu you can: 

 Export multiple files at one time. You can convert multiple worksheets to OFDA XML or to 
CAPSIF for Order Entry type files. This is a great time-saver if you have multiple worksheet files 
that need to be converted. 

 Convert a Giza User Library to a Custom Catalog that can be used in 2020 Worksheet. 

 Convert a Design Express project and its spec groups into worksheets 

Export several files 

To export several files to an OFDA XML file or CAPSIF for Order Entry: 

1. From the File menu, select Convert. 

2. Select Worksheet to OFDA XML or Worksheet to CAPSIF for Order Entry. 

3. Select your files. Use the SHIFT key to pick a range of files or the CTRL key to select 
non-adjacent files. 

4. Click Open. 

5. In the Browse for Folder dialog, select the destination folder of the converted files. 

6. If you are converting to OFDA XML, select the OFDA XML version then click OK. 

7. Click OK when the Conversion Complete message appears. 
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Convert a Giza Specifier User Library 

You can convert User libraries created in Giza Specifer to 2020 Worksheet custom catalogs.  All of the 
information that was stored in the library, including pricing, will be available.  

You will find custom catalogs in the Projects tab of the Explorer bar.  You can add new items to the 
converted custom catalog. 

To convert a Giza Specifier User Library: 

1. From the File menu, select Convert. 

2. Select Giza User Library to Custom Catalog. The Add to Custom Catalog Wizard 
dialog will open. 

3. Select an existing Custom Catalog to send the converted items to or create a new 
one. 

4. Click Finish. 

5. Click OK when the Conversion Complete message appears. 

Convert a Design Express project 

To convert a Design Express project and its spec groups into worksheets: 

1. From the File menu, select Convert. 

2. Select Design Express Project. 

3. Click  to select the folder which contains the Design Express project. 

4. In the Browse for Folder dialog, select the project folder then click OK. 

5. Leave Update Converted Worksheets checked if you want to update converted 
items against manufacturer catalogs. 
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6. Leave Open Converted Worksheets checked if you want to open each converted 
worksheet. 

7. Click Convert. 

8. Under Conversion results, you will see the status of the project you are converting. 
The status is updated as the conversion progresses. 
 
This may take a few minutes, please wait. 

9. Once you see the status of the project and the created worksheets as finished, click 
Close. 
 
 
Note:   You will find the worksheets in a new project folder under Local Projects. 
This folder will have the same name as the Design Express project. During the 
conversion, the program creates a worksheet template based on properties 
common to all spec groups. After the conversion, Alias 1, Alias 2 and Alias 3 
columns are renamed Tag 1, Tag 2 and Tag 3. 

Merge and purge worksheets 
Refer to the following topics: 

 Merge worksheets 

 Purge a worksheet 
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Merge worksheets 

The Merge feature allows you to combine 2 or more worksheets at a time. This is a very useful tool if 
you want to quickly create one large worksheet from many. 

1. Make sure that you have one worksheet open. 

2. From the File menu, select Merge. 

3. Select one worksheet or as many others you would like to merge into your current 
worksheet by using the SHIFT and CTRL keys. 

4. Click Open. 
 
Items from the selected worksheets will be added automatically to the current 
worksheet. Merge will automatically consolidate your worksheet for you. 

Purge a worksheet 

When a worksheet is saved over and over, it grows in size.  You can use the Purge command periodically 
to control a file's size.  This command mimics the purge command available in AutoCAD. 

Note:   This operation cannot be undone. However, a backup file will be created in the same folder as 
the original file. 

1. From the File menu, select Purge. 

2. When you see the confirmation message, click Yes. 
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Print and e-mail a worksheet 
Refer to the following topics: 

 Print a worksheet 

 E-mail a worksheet 

E-mail a worksheet 

From the File menu select Send. 
 
A new mail message appears, with the current worksheet set as attachment. 

This feature works with any Messaging Application Programming Interface (MAPI) compatible program, 
such as Microsoft Outlook. 

Print a worksheet 

All visible columns of the worksheet will be printed. We recommend that you do a print preview before 
printing. 

Note:  The page will be horizontally scaled to fit all the visible columns on one page. Therefore the total 
width of your columns will affect the size of the font printed — the wider the columns and the more 
columns you are viewing, the smaller the font. 

1. From File menu click Print. 

2. In the Print dialog select the Printer, the Print range, the number of copies. 

3. Click Properties to change the selected printer's properties such as the page 
orientation (portrait or landscape) and paper source.   

4. Click OK. 
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See also: 

 Preview before printing 

 Example - Print panels only 

 Page Setup 

 Set the default printer 

 Print multiple levels 

 Header / Footer 

Preview before printing 

1. Click  in the Standard toolbar. 

2. Using the buttons at the top left of the preview tab, you can print, go to the next or 
previous page, view two pages at a time, zoom in and out, and close the print 
preview. 

3. If the print preview looks correct, click Print.   
 
If you need to modify the worksheet before printing, click Close then make the 
changes. 

Example - Print panels only 

In this example, instead of printing a list of all the items in the worksheet you will print a list of panels. 

1. Sort your worksheet by Part Description, Part Number and Catalog code. 

2. Select all the panels on your worksheet. 
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3. From the File menu select Print Preview. 
 
Notice that only the panels are shown. If you have any items selected, 
worksheet will assume that you will be printing selected items only and will 
automatically insert a subtotal of the selected items in the printout. 
 

 
4. From the File menu select Print. 

5. In the Print dialog box, verify that Selection is checked in Print Range. 

6. Click OK. 

Note:  Use the Advanced Find Feature to select a number of similar items on your worksheet without 
sorting your worksheet. 



90 

Page Setup 

Page setup controls the way the worksheet prints. Once you change it for your worksheet it will stay 
that way. This information is linked to a specific worksheet, not to the computer. 

1. From the File menu, select Page Setup. 

2. Change any of the following settings: Margin, Distance To Frame, Appearance, 
Orientation and Centering. 

3. Under Miscellaneous you can choose to insert a page break after each subtotal. 

4. Click Print Preview to preview your page setup. 

5. Click OK to save the page setup or Print to send the worksheet to the printer. 
 

Note:  Even if you are printing to a black and white printer, check Print in Color to see subtotals better 
on your printout. 

Set the default printer 

To set the default printer, paper size and orientation for all open worksheets: 

1. From the File menu, select Print Setup. 

2. Select the printer, paper size and orientation. 

3. Click OK. 

Note:  This information is linked to the computer, not to a specific worksheet. 
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Print multiple levels 

A quick way to print all the levels (Standards or Outline) in a worksheet is to use the Print Levels tool. 
Before you print you will need to set the default printer using the Print Setup dialog. 

1. From the menu select File, Print Levels. 

2. In the Print Levels dialog box, select which worksheets you wish to print.  For 
each line checked you will have one printout. 

3. Check whether you also want to print the cover page and/or the report. 

4. Click Print. 
 

 Note:  The title on each sheet will be the name of the Standard or the Outline level. 

Header / Footer 

Select File, Page Header/Footer to customize the header and footer when printing a worksheet. 

This command opens the Worksheet Properties dialog, with the Header/Footer tab active. 

Notice the $ codes in the Header/Footer tab. This is a simple computer code instructing the program to 
pull the data from the worksheet. These codes are used because the information may change but the 
placement and format will remain the same. 

In addition to using the $ codes, you may also type in any information you would like to appear in the 
header or footer. Click in the proper area (Header or Footer tab; Left Aligned, Centered or Right 
Aligned) and type the text. 

Note:   When modifying the Header/Footer, insert the code first before typing in text.  Otherwise, the 
text you entered will be overwritten by the code. 
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To Do this 

Modify the header Click the Header tab. 

Modify the footer Click the Footer tab. 

Access the list of codes 
and view their current 
values 

Click the Legend button. 

Adjust the space given 
to the header and 
footer  

Click Page Setup. 

Change the font type 
and size 

Click Font. 

 
See Example: customize the header for a step-by-step example of adding a line to the header. 
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Header tab 

Use the Header tab to place information at the top of the worksheet. 
 

 
$R is a default symbol for the Title of the worksheet. The Worksheet Title is set in the General tab of the 
Worksheet Properties dialog box. By default, the title appears in the upper left corner of the worksheet . 

$P is a default symbol for current page number and $N is the default symbol for number of pages. By 
default, the page number appears in the upper right corner of the worksheet. 

Note:  Click the Legend button for all legend codes and descriptions. 

See also: 

 Header / Footer 

 Footer tab 

 Example: customize the header 
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Footer tab 

Use the Footer tab to place information at the bottom of the worksheet. 

 
$L is the default symbol for the path and filename of the worksheet. By default, this appears in the 
lower left corner of the worksheet. 

$D is the default symbol for the Date/Time stamp. By default, this appears in the lower right corner of 
the worksheet. 

Note:  Click the Legend button for all legend codes and descriptions. 

See also: 

 Header / Footer 

 Header tab 

 Example: customize the header 
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Example: customize the header 

In this example you will add a line to the header. 

1. In the Header tab, click the second cell under the column Left Aligned. 
 

 
2. Click the Legend button to access the list of codes. 

3. In the Header/Footer Legend dialog, select the code $C - Prepared by Company 
Name then click Insert Code. 
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4. Type Designed by:in the box, before $C. 
 

 
5. Click Font. Select Font = Arial, Font Style = Regular and Size = 12.  Click OK. 

6. Click Page Setup to open the Page Setup dialog. 

7. Click Print Preview in the Page Setup dialog. Notice the header that you just 
entered. 
 

 
  

8. Click Close. 
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Worksheet properties 
You can customize each worksheet with the Worksheet Properties icon in the Standard toolbar.  

 
The information you enter in the Worksheet Properties dialog box is saved with the specific worksheet. 
To apply this setting to other worksheets use Worksheet templates. 

There are six panes available in the Worksheet Properties dialog box: 

 General - to enter the worksheet title (for reports and other outputs as opposed to worksheet 
file name) and worksheet contact information. 

 Order - to enter order information. 

 Columns - to customize the columns displayed and their order in the worksheet. 

 Header/Footer - to customize the header and footer when printing the worksheet. 

 Adjustments- to add price adjustments such as taxes, installation fees and shipping charges. 

 International - to specify the currency used for the worksheet and any other currency to convert 
prices to. Get coaching on this. 
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General 

Use the General properties to define the worksheet title and the contact information about a job or 
installation. 

The worksheet title appears on top of the worksheet. Do not confuse worksheet file name with 
worksheet title. 
 

 
The information you enter here will be used in both the worksheet cover page and the reports. 

1. Click   on the Standard toolbar. 
 
The General information will appear by default. 

2. Enter the worksheet title. 

3. Click the button beside one of the contact fields, such as Prepared For: 
 

 
4. In the 2020 Contacts Manager dialog box, select the contact that will go in the 

contact field then click OK. 
 
You can create a new contact here if necessary. 
The contact name is displayed on the dialog. If you want to remove this contact, just 

click the   button. 
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5. Under Miscellaneous Text, there are three text fields. 
 
Check the appropriate box to activate the Edit button. Click Edit to open the Misc. 
Text dialog. Enter text then click OK. 

6. Click OK to save and close or Apply to save and keep the Worksheet Properties 
dialog open. 

See also: Edit contact information for the current worksheet only 

Note:  Checking the Security box then entering a password will protect your worksheets. 

Order 

Use the Order information to define the P.O. Number, Quote Number, Invoice Number, etc. In here, you 
can also enter the required deposit value and the Valid Through date; the date after which the quoted 
price will no longer be valid. All this information will be used in reports. 

1. Click  on the Standard toolbar. 
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2. Click Order. 
 

 
3. Enter the order information and then click OK. 
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Columns 

Use the Columns information to define which columns will be displayed in the worksheet. From here, 
you can also change the column header text and the column order. 

1. Click   on the Standard toolbar. 
  

2. Click Columns. 
 
Note:   Click Grouped View if you want to view columns by category. 

3. Customize the columns then click OK. 

Header/Footer 

Use the Header/Footer pane to customize the header and footer when printing a worksheet. 

1. Click  on the Standard toolbar. 

2. Click Header/Footer. 

3. See Header / Footer for the rest of the steps. 
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Adjustments 

Use the Adjustments information to insert price adjustments to your worksheet, such as tax, bottom 
line discounts, shipping charges, etc. 

1. Click  on the Standard toolbar. 

2. Click Adjustments. 

3. Click Add. 

4. See Price Adjustments for details on adding a price adjustment. 

International 

Use the International pane to specify a quotation currency and other currencies to convert prices to. 

Currency and exchange rate should not be changed unless your business received coaching. 

WARNING:   You may damage your worksheet pricing information. 
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Worksheet templates 
Once you have the worksheet properties set up the way you like, you can save the settings to a 
template. The template can then be applied to any worksheet. 

Within a template you can save: customer contact information, order information, column settings, 
header and footer settings, and price adjustments. 

You can save templates on a network directory so all CAP users can have access to them.  This is a great 
way to standardize the look of worksheets being printed from your firm. 

See also: 

 Create a new template 

 Create a template from current worksheet settings 

 Select a default worksheet template 

 Apply a template to a worksheet 

Create a new template 

1. From the View menu, select Templates, Manage Templates. 

2. Click New in the Manage Worksheet Templates dialog. 

3. Enter the template name and then click OK. 

4. In the Template Properties dialog, select any of the following tabs: 
 
General - to enter the worksheet title and worksheet contact information 
Order - to enter order information 
Columns - to customize the columns displayed and their order in the worksheet 
Header/Footer - to define the header and footer when printing the worksheet 
Adjustments- to add price adjustments such as taxes, installation fees and shipping 
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charges 
International - reserved for international businesses 

5. Click OK. 

6. To apply this template to the current worksheet, click Apply. 

Create a template from current worksheet settings 

Before using the current worksheet setting to create a template, you must save the worksheet first. 

1. From the View menu, select Templates, Manage Templates. 

2. In the Manage Worksheet Templates dialog, click Capture. 

3. Enter the template name then click OK. 

Now that template is saved, it can be applied to any other worksheet. If you need to make changes to it, 
you can edit, rename or delete it. 
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Select a default worksheet template 

1. From the View menu, select Templates, Manage Templates. 

2. Select the template in the Manage Templates dialog box. 
 

 
3. Click Set Default.  Notice that the template name is now in bold. 

4. Click Close. 

Note:  If you wish to use the standard project template again later on, click Clear Default. 
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Apply a template to a worksheet 

1. From the View menu, select Templates, Manage Templates. 

2. In the Manage Templates dialog, select the template in the list then click Apply. 

3. In the Apply Template dialog, specify whether the contact information, column 
arrangement, page setup and header/footer and price adjustments will be taken 
from the template, from the current worksheet, or from both (applicable to price 
adjustments only). You can choose to keep the default settings. 
 
Note: To change which options are automatically checked whenever this dialog 
appears, from the menu choose Tools, Preferences then select Common 
preferences. 

4. Click OK. 

Note:  A quicker way to apply templates is to use the template pulldown from the Template toolbar. 
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Projects 
Project folders help you organize your drawings and worksheets.  For example, if you are working on the 
Head office project for client ABC, you can create a project folder called ABC Head office and store all 
worksheets and drawings in that folder. You can also create sub-folders within a project folder. 

The Projects tab of the Explorer pane provides the fastest way to access your project hierarchy. 

See: 

 Create a project folder 

 Manage projects 

 Project templates 

 Apply a project template to a worksheet 

 Open a worksheet from the Projects tab 

 Copy products from other worksheets 

 New worksheet using the Wizard 

Create a project folder 

To better organize your worksheets so that you can save them in separate projects, create project 
folders. 

1. Click the Projects tab of the Explorer bar. 

2. Right-click on Local Projects or a project folder. 

3. Select New, Project. 
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4. A folder called New Project Folder is created. Rename the project folder. 
 
You will now be able to save worksheets and drawings in this project folder. 

Note:  You can also create a project folder using the Project Management Wizard. 

Manage projects 

You can create, rename or delete projects by using the Project Management Wizard. You can also use 
the Wizard to add notes to the project or create a project template. 

1. From the File menu, select Project Management. 

2. In the Project Management Wizard, double-click on All Projects. 

3. Do any of the following and then click Close: 

To: Do this: 

Create a new 
project folder 

1. Click on All Projects or a project folder then 
click New. 

2. Type in a name for the new folder. 

Delete a project 
folder 

Note:   This will delete all the contents in the folder. 

1. Make sure that none of the files in this 
folder are opened. 

2. Click on the folder then click Remove. 

Rename a 
project folder 

1. Click on the folder then click Rename. 

2. Type in a new name. 
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Add this project 
to My Projects 

1. Click on the folder then click Add. 

2. Type in the name of the project if 
necessary. 

Note:  This will simply create a link to the project. You can keep 
track of projects you work on frequently in the My Projects folder. 

Change the 
project's 
template or 
enter notes for 
the project 

1. Click on the folder then click Next. 

2. Type in any notes for the project. 

3. Click Edit to change the project's template. 

4. Click Finish. 

 
Note:  You can access the same commands listed above by right-clicking on a project folder. These 
commands are also accessible by right-clicking in the Projects tab of the Explorer pane. 

Project templates 

You can edit project templates by using the Project Management Wizard. Project templates work the 
same way as worksheet templates, that is, you can apply a project template to a worksheet. 

1. From the File menu, select Project Management. 

2. In the Project Management Wizard, double-click on All Projects or click the + sign 
to view all the project folders. 

3. Click on the folder then click Next. 

4. Click Edit to change the project's template. 
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5. In the Template Properties dialog, select any of the following tabs: 
 
General - to enter the worksheet title and worksheet contact information 
Order - to enter order information 
Columns - to customize the columns displayed and their order in the worksheet 
Header/Footer - to define the header and footer when printing the worksheet 
Adjustments- to add price adjustments such as taxes, installation fees and shipping 
charges 

6. Click Finish. 

Apply a project template to a worksheet 

Just as you can apply a worksheet template to a worksheet, you can apply a project template to a 
worksheet. 

1. Click the Projects tab of the Explorer bar. 

2. Right-click on Local Projects or a project folder then select Properties. 
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3. In the Project Properties dialog, click Apply to apply the project's template to 
the current worksheet. 
 

 
4. In the Apply Template dialog, specify whether the contact information, column 

arrangement, page setup and header/footer and price adjustments will be 
taken from the project template, from the current worksheet, or from both 
(applicable to price adjustments only). You can choose to keep the default 
settings. 
 
Note:   To change which options are checked whenever this dialog appears, 
from the menu choose Tools, Preferences then select Common preferences. 
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5. Click OK in the Apply Template dialog. 

6. Click Finish. 

Note:   You can capture the current worksheet's properties and apply it to the project's template by 
clicking Capture in the Project Properties dialog. You can edit the project's template by clicking Edit in 
the Project Properties dialog. 

Open a worksheet or drawing from the Projects tab 

If you saved a worksheet or drawing in your projects folder, you can open it from the Projects tab. 

1. Click the Projects tab of the Explorer pane. 

2. Open the folders by double-clicking on them or clicking on the +. 

3. If you double-click on a worksheet file name, Worksheet will automatically open the 
file. 
 
If you double-click on a drawing, AutoCAD will launch and automatically open the 
drawing. 

Copy products from other worksheets 

1. Click the Projects tab of the Explorer pane. 

2. Open the folders by clicking on the +. 

3. Use the + to see the product in a previously created worksheet. 
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4. Click on an item in the worksheet and drag and drop it to the current 
worksheet. 
 

 
 
Notice the line is copied completely, including options, attributes and 
discounting.  The original file is not modified in any way. 

You can also use the Projects tab to copy items from custom catalogs to worksheets.  See Reuse and 
update items from a custom catalog. 
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Preferences 
Worksheet preferences allow you to control specific characteristics of the program such as which 
catalogs are listed, Explorer bar appearance and default folders. 

You can modify the following preferences: 

 General - set printing, column sorting and file auto-save defaults 

 Display - change font styles and sizes 

 Common - modify Apply Template, Update Against Catalog and Consolidate criteria default 
settings 

 Explorer - customize the Explorer bar 

 QuickSearch - change how QuickSearch works 

 Specification - modify 2020 Options, Global Options and Option Clipboard settings 

 Visualization - set the search order that 2020 Worksheet will use when looking for a product's 
preview image 

 Content - select the manufacturers and catalogs you would like to access 

 Folders and files - select folders where documents are stored 

 User - assign the current user and logo 

International - please contact Customer Support if you need to set a currency other than USD 
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General preferences 

1. From the Tools menu select Preferences. 
 
By default, the General preferences are displayed. 
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2. Modify any of the general preferences, click OK to save and close, or click Apply to 
save and keep the Preferences dialog box open. 
Those that are self-explanatory are shortly described below or linked to the 
corresponding topic: 

Category Settings 

Project Support Show startup wizard screen when creating new worksheets 

Validation Show tips related to Visualization and Show tips related to 
Associated Worksheets to display tips on how the current 
worksheet will interact with Visual Impression and any associated 
worksheet. 

Printing Horizontally scale the printing to fit all columns on a single page 
(requires a restart of the application) 

Sorting Ask for confirmation before sorting worksheet columns 

AutoSave  Check AutoSave to enable the 
automatic save of worksheets. 

 Click the scroll button to change the 
Auto-Save interval. 

 Check When auto-saving, create a 
backup copy of the file (..). to create a 
file with a  '.backup' extension 

 Note that 'Untitled' worksheets will not 
be auto-saved or backed up. 
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Display preferences 

Use Display preferences to set worksheet font styles and sizes. By default, Worksheet displays each row 
type in a different color.  For example, options are displayed in a light blue background and attributes 
are displayed in a light yellow background. 

You can change color selections for your background and text as well as set the height of certain rows, 
such as product or grand total. 

1. From the Tools menu select Preferences. 

2. Click Display. 
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3. Modify any of the following settings: 
 
Font face (style) and size of text in the worksheet 
Background or text color of each row type. Select Defaults to reset the background 
or text color to the standard default setting. 
Height of Product, Worksheet Link, Standard, Outline Level, Price Adjustment, 
Grand Total and Subtotal rows. 
Display Product, Worksheet Link, Standard, Panel Configuration, Outline Level, 
Custom Catalog Item, Price Adjustment, Grand Total and Subtotal rows in bold. 

4. Click OK to save and close. 
 
Or, click Apply to save and keep the Preferences dialog box open. 

Note:   The Defaults button will reset all the colors, sizes and fonts back to the standard default settings. 
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Common preferences 

1. From the Tools menu select Preferences. 

2. Click Common. 

 
3. Modify any of the following settings and then click OK to save and close. Or, click 

Apply to save and keep the Preferences dialog open. 
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Category Settings 

Send to Change the behavior when sending items to a worksheet: 

• Insert items by appending at bottom of worksheet 

• Insert items above current item 

List Views Change the settings for the Content tab of the Explorer bar if the 
Content tab is displayed in list view. 

• Use extended List View features (hover select, single click, 
underlining) 

• Check Show grid lines between rows and columns to 
display grid lines to separate items. 

Apply template Change default settings when applying a worksheet template. 

Check whether or not you want to see these choices each time a 
template is applied. 

Export Change the default SIF coding from ANSI to Unicode when 
exporting data. 

Defaults Click Update Against Catalog to set the default update values and 
default price zones selected when doing an update against a 
catalog. 

Click Consolidate Criteria to select the default columns used 
when performing a consolidate. 

Click Update Against Worksheet to set the default update values 
selected when doing an update against a worksheet. 
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Explorer preferences 

Use Explorer preferences to set the Explorer pane's behavior and appearance. 

1. From the Tools menu select Preferences. 

2. Click Explorer. 
 

 
3. Change any of the following settings: 

 
Show Content tab as a list instead of a tree 
Show Price Zone bar on the Content tab 
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Show Status Bar on all Explorer tabs 
Select to always display the Search, Bookmarks tabs in Explorer. Note that the 
Contents and Projects tabs must always be displayed. 
Simplify hierarchies by skipping the root item if it is an "only child" - when there is 
only one choice in a catalog, automatically select that item 
Watch for changes to custom catalogs and worksheets and refresh changed items 
automatically 

4. Click OK to save and close. 
 
Or, click Apply to save and keep the Preferences dialog open. 

Note:   You can also access Explorer preferences from the View menu, Explorer Bars, Preferences. 
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QuickSearch preferences 

Use the QuickSearch preferences to set the QuickSearch behavior. 

1. From the Tools menu select Preferences. 

2. Click QuickSearch. 
 

 
3. Change any of the following settings and then click OK to save and close. Or, click 

Apply to save and keep the Preferences dialog open. 
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Category Setting 

Enable 
QuickSearch 

If this check is cleared, QuickSearch will be deactivated both in CAP 
Designer and 2020 Worksheet. 

Note:  Clearing this checkbox will deactivate other QuickSearch 
settings in this dialog. If you choose to enable QuickSearch again later 
on, make sure to check the appropriate settings below. 

Common 
Settings 

• Enter the maximum number of matching part numbers to 
display in the list 

• Don't display the suggestion list if there are more matches 
than this maximum 

• Exclude disabled catalogs from the suggestion list 

• Check if the index needs to be updated every time 
QuickSearch is started 

Worksheet 
• Display the suggestion list when typing in the worksheet's Part 

Number field 

• Update the item before it is inserted into the worksheet 

Explorer 

  
Show or hide the QuickSearch field in the Explorer Pane. 
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Note:  A large index file (IDX) is included with every CAP Studio installation. The Rebuild Index button 
rebuilds this entire file from scratch. Use the Rebuild Index button only when there seems to be 
corruption in the IDX file, as it takes a few minutes to finish. 
 
2020 Worksheet automatically updates the IDX file whenever there is a change to content, for example, 
if you manually add or delete catalogs. Use the Update Index button to force an update, if it seems as 
though QuickSearch is not displaying all the part numbers. Since this is an incremental update it takes 
less time than rebuilding the index. 
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Specification preferences 

Use Specification preferences to set 2020 Options, Option Clipboard, and Global Options settings. 

1. From the Tools menu select Preferences. 

2. Click Specification. 
 

 
3. Change any of the following settings and then click OK to save and close. Or, click 

Apply to save and keep the Preferences dialog box open. 
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Category Settings 

2020 Options 

  

  

   

Use Default Options - use the default options set by the manufacturer 

Enter the Number of option trails to remember for Default Options 

Automatically select "only child" options - when there is only one option 
available, automatically select it 

Automatically show option notes - display all notes on options 

Option 
Clipboard 

Show tooltips in the Option Trail list - Show the Option Trail properties dialog 
when the cursor hovers over an option trail in the clipboard. 

Global 
Options 

  

Use Quick Options to intelligently select related options in similar option 
groups 

Choose to prompt before, always or never refresh the Global Options list when 
switching to the Global Options view. 

Choose to prompt before, always or never apply changes made in the Global 
Options list when switching away from the Global Options view. 

Click Group By Defaults to set the default columns used to group global 
options 
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Visualization preferences 

Use the Visualization preferences to set the search order that 2020 Worksheet will use when looking 
for a Product Preview. 

1. From the Tools menu select Preferences. 

2. Click Visualization. 
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3. Use the Up or Down arrow to change the order. 
 
When displaying a preview image, 2020 Worksheet will go through this list and look 
for the image corresponding to the first image type.  If an image is not available, the 
program will go down the list until it finds an image. 

4. Add a check mark if you want to Disable presentation finish materials in the 
product preview. 

Content preferences 

Use Content preferences to change the settings for the Content tab in the Explorer pane. 

You can select the manufacturers and catalogs you want to have access to. Also, you can change the 
default price zones for each catalog, and uninstall unwanted catalogs. 

1. From the Tools menu select Preferences. 



131 

2. Click Content. 
 

 
3. Change any of the following settings and then click OK to save and close. Or, 

click Apply to save and keep the Preferences dialog box open. 
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To Do this 

Enable or 
disable a 
manufacturer in 
the Content tab 

Check or uncheck a manufacturer in the list. 

When you disable a manufacturer it will be “grayed” out in the 
Content tab. Disabling a manufacturer is not the same as 
uninstalling it. 

If you want to hide a disabled manufacturer, check Hide disabled 
Manufactures and content in listings located at the bottom of the 
dialog box. 

Enable or 
disable a catalog 
in the Content 
tab 

1. Select a manufacturer in the list. 

2. Check or uncheck a catalog. 

When you disable a catalog it will be “grayed” out in the Content 
tab. Disabling a catalog is not the same as uninstalling it. 

If you want to hide a disabled catalog, check Hide disabled 
Manufactures and content in listings located at the bottom of the 
dialog box. 

Move a 
manufacturer or 
catalog up or 
down in the list 

Select the catalog or manufacturer, then click   or . 

Note:  If you use a particular manufacturer or catalog often, you 
can move it to the top of the list. 

Add a 
manufacturer 1. Click . 

2. Enter a unique 3-character code for the 
manufacturer. 
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3. Enter the manufacturer name. 

4. Select the folder where the content for the 
new manufacturer will be located.  Make a 
new folder if necessary. 

Add a catalog 1. Select the manufacturer. 

2. Click then navigate to the catalog. 
 
Once it has been added, you will be able to 
access the products and pricing contained 
in that catalog. 

Use this to install a catalog such as one with an old price list or to 
install a discontinued manufacturer. 

Delete a 
manufacturer or 
catalog 

Note:   The following steps will uninstall the selected item. 

1. Select the manufacturer or catalog. 

2. Click to remove the selected 
manufacturer or catalog. 

Change the 
location of a 
catalog, its 
symbol library or 
its database 

1. Select the manufacturer and catalog. 

2. Under Content Properties click the Browse 
icon beside Catalog, Graphics or Database. 

Change the 
default price 
zones 

1. Select the manufacturer and the catalog. 

2. Select the default prize zone. 
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Note:  Steelcase and Kimball users can select specific price zones for 
old price lists. 

Hide disabled 
manufacturers 
and catalogs 

Check Hide disabled manufacturers and catalog in listings. When 
you restart 2020 Worksheet, the catalogs and manufacturers you 
disabled will not be listed in the Content tab. 

Folders and files preferences 

Use Folders and Files preferences to select the folders where documents are stored. In most cases you 
will not need to edit these locations because defaults are set during installation. 

1. From the Tools menu select Preferences. 
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2. Click Folders + Files. 
 

 

3. Change any of the following settings by clicking the Browse   button beside it. 
Then, click OK to save and close. Or, click Apply to save and keep the Preferences 
dialog box open. 
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Setting Description 

Local Projects These are folders that appear in the Projects tab of the 
Explorer pane. This is the primary search folder for opening 
and saving worksheets. 

Select the folder where projects will be stored on the local 
PC. 

Network 
Projects 

These are folders that appear in the Explorer bar's Projects 
tab. 

Select the folder where projects will be stored on the 
network. 

Export files Select the folder where export files will be stored. Can be 
on the local PC or on the network. 

Worksheet 
templates 

Select the folder where worksheet templates will be stored. 
Can be on the local PC or on the network. 

Sort Settings Select the folder where Sort Settings will be stored. The 
folder can be on the local machine or on the network. 

CoverPage 
layouts 

Select the folder where cover page templates will be 
stored. Can be on the local PC or on the network. 

Report designs Select the folder where report designs will be stored. Can 
be on the local PC or on the network. 

Explorer 
bookmarks 

Select the folder where bookmarks will be saved.  This 
folder should be on the local PC. 
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QuickSearch 
index 

Select the location of the index accessed by QuickSearch in 
Explorer and Worksheet. 

Search 
keyword index 

Select the location of the index accessed by Search in 
Explorer and Worksheet. 

Contacts 
database 

Select the location of the Contacts database. 

Default 
Options file 

Select the location of the default options file. 

User preferences 

Set the User preferences to choose the current user and logo. 

1. From the Tools menu select Preferences. 
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2. Click User. 
 

 
3. Click the button under Current User. 

 
This is a shortcut to the Prepared By field in the Worksheet Properties General tab. 
 
Change your information in Contacts, then click Set Default. The record you set as 
default appears as the Current User.  This information can be used on a cover page, 
report or printed worksheet's header/footer. 
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1. Click Browse... to select the default image to represent the Current User. This 
logo can be used on a cover page or report. 
 

 
2. Click OK to save and close. 

 
Or, click Apply to save and keep the Preferences dialog box open. 

  



140 

Manufacturer catalogs 
Manufacturer catalogs are installed with the 2020 Worksheet application. 

For information about custom catalogs, see the Custom catalogs section. 

See: 

 Navigate catalogs 

 Catalog Properties 

Navigate catalogs 

1. From the Content tab or the Explorer pane, select a manufacturer. 

2. Click on the catalog you want to view. 

3. Click on a section. Continue selecting sections until you get to the desired product 
number. 

To drag and drop products from the Explorer bar to the worksheet, see Add products using drag and 
drop. 

To move around in Explorer use the three navigational features: up one level, Home, and the drop down 
arrow.  These help you move quickly to a section within the Content tab. 
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Notes:  To save time, you can bookmark manufacturers, catalogs, sections or products you use 
frequently. You can display the Content in tree view instead of list view if you prefer.  See Explorer 
preferences for details. 
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Catalog Properties 

Right-click on a section or product of a manufacturer catalog in the Content tab of the Explorer pane 
and select Properties. 

 
If you navigated down to a product, a preview of the product may be available when you click on the 
Visualization tab. 
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From the Catalog Properties window (Catalog tab) you can: 

 Preview a product 

 Send an item to a drawing 

 Send an item to a worksheet 

 Add an item to a custom catalog 

 Specify an item using 2020 Options 
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Use multiple versions of the same catalog 

CAP Designer and 2020 Worksheet allow you to use multiple versions of the same catalog.  This allows 
you to create worksheets using the current catalog and others using older catalogs. You can even put 
products from different versions of the catalog in one worksheet. 

1. Before installing updated catalogs, copy the MFG folder that is to be archived, 
giving it a unique name at the same time.   

2. From the Tools menu select Preferences. 

3. Click Content. 

4. Beside Select which manufacturers will be available, click . 

5. Enter a unique 3-character code for the manufacturer. 
 

 
6. Enter the manufacturer name. 

 
The name will default to the MFG code that was just entered.  You can leave this 
name or type a more detailed name.  The value entered in this field will be 
displayed in the worksheet to indicate if an item is from an archived catalog or from 
a standard, up-to-date catalog, so be sure to provide a name that will be 
understood and consistent. 
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7. Now you have to associate a specific folder with the "new manufacturer". Select the 

folder you created in step 1. 
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In the image above, the copied folder is located next to the other data, in the local 
Content folder.  This is not a requirement.  The archived data can be stored at any 
location accessible to the computer (other local folder, network, etc.). 

8. With the newly added manufacturer folder selected in the upper section, under 

Select which content will be available, click . 

9. Select one or more catalogs (files with .CAT extension) then click Open. 

10. Click OK to apply the changes and close the Preferences dialog. 

11. Click OK when the two information boxes appear. 
 
Note that adding catalogs triggers a rebuild of the QuickSearch index. 

12. For the changes to take effect, exit then reopen 2020 Worksheet. 
 
Notice that the manufacturer you just added is now visible in the Explorer bar.  It 
will be located at the bottom of the list. 
 

You can move it up by going into Preferences, Content then using the button. 

Note:  See Add products from an archived catalog to insert products from this archived catalog to the 
worksheet. 
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Bookmarks 
Bookmarks are a convenient way of returning to selected manufacturers, catalogs, sections, or products 
that you use frequently.  You can also create bookmarks for worksheets or drawings you use often. 

You can access bookmarks from 2020 Worksheet and CAP Designer. 

1. In the Content tab of Explorer, right-click the manufacturer, catalog, section or 
product number that you want to bookmark. 
 
Note that you can also use the Projects, Search or Bookmarks tab to create a 
bookmark. 

2. Click the Add Bookmark icon beside the Home icon. 
 

 
3. The bookmark name defaults to the name of the manufacturer, catalog, section or 

part number you have selected. You can change this to another name. 
 
Note: The name you use cannot consist of any of the following characters: ", ', /, \, 
|, ?, *, :, <, or >. 

4. Click OK to save the name. 
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5. To use the bookmark, click and hold the Bookmark icon and select the bookmark. 
 

 
By default, content (manufacturers, catalogs, sections, or products) bookmarks are saved under the 
Content folder. Drawing bookmarks are saved under the Projects folder. Worksheet bookmarks are 
saved under the Worksheets folder. 

See Organize bookmarks to organize bookmark folders and contents. 

Note:   You can also access and organize bookmarks from the Bookmarks, Projects or Search tab. 
 
If you bookmark a product or level (section) and that product or level has changed position after a 
catalog update, the bookmark will no longer work. 

Organize bookmarks 

Organizing bookmarks is similar to keeping a "Favorites" folder of frequently visited sites in a web 
browser. Bookmarks are saved on your computer. To see where they are stored on your computer, see 
Folders and files preferences. 

By default, content (manufacturers, catalogs, sections, or products) bookmarks are saved under the 
Content folder. Drawing bookmarks are saved in the Projects folder. Worksheet bookmarks are saved 
under the Worksheets folder. 

You can create and rename folders so you organize bookmarks by project or location. 

1. In the Content tab of Explorer, right-click the manufacturer, catalog, section or 
product number that you want to bookmark. 
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Note that you can also use the Projects, Search or Bookmarks tab to create a 
bookmark. 

2. Click and hold the arrow beside the Add Bookmark icon  then select Organize 
Bookmarks. 
 

 
3. In the Organize Favorites dialog box, click on a folder and you will see a list of 

the bookmarks it contains. 
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4. Do any of the following to organize bookmarks: 

 Click New Folder to create a new Bookmarks folder. 

 Drag and drop bookmarks into a folder, or from one folder to another. 

 Rename or Delete a bookmarks folder. 

 Highlight an item, then click Move. In the Browse For Folder dialog box, navigate to a folder to 
hold the bookmark. 

Enter and edit items in a worksheet 
This section explains how to enter and edit items in a worksheet. This includes adding products from 
manufacturer catalogs, searching for products, selecting items, etc. 

Refer to the following topics: 

 Add products using drag and drop 

 Add products using Insert 

 Add products from an archived catalog 

 Add service parts 

 Select or make an item current 

 Edit commands 

 Go to a specific line and column 

 Go to an item's location in Explorer 

 Add or edit an annotation for an item 

 Sort records by column 

 Attributes 

 Custom items (Specials) 
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 Item properties 

 Copy values from one column to another 

 Quickly fill in cell values (Assign) 

 Copy options and attributes (Block Assign) 

 Consolidate identical items 

 Split an item 

 Update items 

 Flag and lock lines 

 Color lines 

 Send an item 

Add products using drag and drop 

From any tab of the Explorer bar, you can drag and drop products to your worksheet. 

To drag and drop products from the Content tab: 

1. Navigate your way down to a part number used in a specification. 
 
Or, use QuickSearch or Search to find a product. 

2. Once you have navigated to an item you wish to specify, select the part number 
by holding down the left mouse button. 
 
If available, a preview image is displayed in the Preview bar. Use any of the 
Preview toolbar buttons to zoom, rotate or change the image type.   

  



152 

3. While holding down the left mouse button, drag that item over to the right and 
release the button when you are over your worksheet. 
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See also: 

 Add products using Insert 

 Bookmarks 

Note:   If you click on a product instead of dragging and dropping it, you will see the 2020 Options 
dialog. 
 
If you see product with a note icon , you can view the note by clicking on the name.  The Note is in 
the bottom part of the 2020 Options dialog. Click Cancel after reading the note. 
 
If you see a product with a service parts icon , you can add service parts to the worksheet.  See Add 
service parts. 

Add products using Insert 

If you have a product list, it may be faster to use the Insert Product command instead of dragging and 
dropping products from the Explorer bar. 

1. Click   on the Item toolbar then select Product. 

2. Insert as many blank items as needed. 
 
Note:  You can press CTRL+SHIFT+P on your keyboard to quickly insert a product 
line. 

3. Click in the Part Number column for item #1 and begin to enter the Part Number.  
 
Quick Search will provide a list of possible part numbers in all available catalogs 
when the number of matches are under 50 (by default). 

4. Double-click on the desired part number to fill in the information. 
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See also Bookmarks 

Note:  If you want to see preview images for items, run the Update Preview Images command. 

Add products from an archived catalog 

The steps for adding products from an archived catalog are the same as adding from the current 
catalog. See Use multiple versions of the same catalog for instructions on archiving a catalog. 

1. Add the product from the archived catalog. You can drag and drop from the 
Explorer bar or use Insert. 

2. Display the Alt MFG column. 
 
Notice that the MFG code appears as though the item came from the actual 
manufacturer.  In the example shown below, an item brought in has the original 
MFG code of AIS. The MFG code of the archived catalog is displayed in the Alt MFG 
column. This is how you can differentiate the archived catalog from the current one. 
 

 
 
The Alt MFG value is important because it is used when doing an Update against 
catalog.  Worksheet will check this field first.  If there is no value, it will check MFG, 
then CAT. 
 
You can change the Alt MFG value of items that are already in the worksheet by 
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manually typing in the Alt MFG value, using Assign, or Block Assign. For example, if 
you inserted an item from the current catalog but you want an archived catalog’s 
pricing, simply change the Alt MFG of this item to the archived catalog's MFG code. 
Then do an Update against catalog. 
 
As another example, if you inserted an item from the archived catalog but want to 
get pricing from the current catalog, simply delete the value in the Alt MFG column 
then do an Update against catalog. 
 
Note:   If you set the Alt MFG to an invalid one, the item gets flagged and a question 
mark is displayed in the Complete column. 

Add service parts 

You can add service parts from Kimball or National through the Worksheet area or from the Content 
tab of Explorer bar. 

From the Content tab: 

1. Navigate your way down to a part number used in a specification. Or, use 
QuickSearch or Search to find a product. 
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2. Click the Service Parts icon next to the product name. 
 

 
3. Resize the 2020 Service Parts dialog to better view its contents. 

 
The service part numbers are listed on the left side, while an illustration on the right 
side shows where the service parts are located. 
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4. Click on a service part number to add it to the Selected Service Parts list. 

 

If you see a Note icon next to the part number, you can click on it to read any 
notes about that part. 
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5. Add other parts if necessary. If you want to remove a selected service part, select it 
then click Remove. 
 
To clear the list, click Clear List. 
 

 
6. By default, items sent to worksheets will be flagged. If you do not want them to be 

flagged clear the checkmark beside Flag items sent to worksheets. 

7. When done, click Send To, Worksheets, then select the worksheet. 
 
The service parts are added to the worksheet. 
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These items are automatically price locked (notice the Price Lock icon  under the 
Lock column) to prevent changes to the price. For no charge items, use the Item 
menu to delete pricing. 

From the Worksheet area: 

1. Select or make the line item current. 

2. From the Item menu, choose Select Service Parts. 

3. Follow steps 3 to 6 above. 
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Select or make an item current 

On a worksheet you will have a number of items. You can edit these items, add finishes and discounts to 
them, cut, copy, paste, and send them to another worksheet, etc. 

How does the program know when performing functions such as paste, where to paste the item on the 
worksheet? Here we will discuss the difference between items that are current and items that are 
selected. 

When performing edit commands, if there are no selected items, Worksheet will perform the function 
on the current item. If there is both a current item and a selected item, the selected item will always 
take precedence over a current item. For example with one item current and one selected, the cut 
command will cut the selected line item. 

 
See also Special selection tools 
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Current item 

It is necessary to have a current item for a number of reasons. The current item is the priority item on 
the worksheet. When specifying options from a worksheet the current item is the starting point. 

Note:  When you insert or paste items, these items will be inserted above your current item. If there is 
no current item, the Insert or Paste command will insert an item at the end of the worksheet. 

To make an item current: 

Click in any cell except the Item column.  You will see brackets around the item number. You can only 
have one current item at a time. 
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To clear the current item: 

Click on the Item column heading. 

 
See also: 

 Select items 

 Special selection tools 
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Select items 

Selecting items is a way to make a subset of your worksheet. You can cut, copy, paste, update against 
catalog, apply a discount, send to, and use the find and replace features on your selected set of items. 
Selected items are highlighted across the entire row. 

To select an item: 

Click on the Item number. In the example below, the item was selected by clicking on the number 1 in 
the Item column. 
 

 
You may select more than one item by holding down the SHIFT (to select adjacent items) or CTRL (to 
select non-adjacent items) key on your keyboard while clicking the item numbers. 
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To select all the items in your worksheet, from the Edit menu, choose Select All. 

To clear selected items, press the ESC key. 

To select items that were not selected AND clear selected items, from the Edit menu, choose Invert 
Selection. 

See also: 

 Current item 

 Special selection tools 

Special selection tools 

There are other ways to select items besides clicking the Item column.  

You can also: 

 Select flagged, locked, complete or incomplete items 

 Select by criteria 

These tools are very helpful when working on large files or worksheets with Alias values assigned. 

Select flagged, locked, complete or incomplete items 

Example - select flagged items: 

1. Flag all the panels in the worksheet. 

2. To quickly select all flagged items, from the menu choose Edit, Select, Flagged. 
 
The flagged items are now selected. 

The same procedure can be done for Locked or Complete/Incomplete items. 
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See also: 

 Select items 

 Select by criteria 

Select by Criteria 

For large files it may be faster to use Select by Criteria to make a selection set. 

Example - select items by catalog code: 

1. From the Edit menu choose Select by Criteria. 

2. In the Select by Criteria dialog, check the Cat column, leave the Operator as 
equals and type in the catalog code of products you want selected. 

3. Click OK. All the line items from that Catalog will be selected. 

Use Select by Criteria using columns like Alias, Department, Floor or Tag for optioning, printing or 
sending to another worksheet. 

For example, to print only items from the Sales Department, check Department, set Operator to equals 
then type in Sales under Value, then print only selected items. 

Note:   You can specify more than one criteria. By default, only items that match all the specified criteria 
will be selected. If you want to select items that match any of the specified criteria, check the option 
under Match Options. 
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Edit commands 

This section explains the various tasks you can perform to alter you worksheet. These include copying 
and pasting items, deleting items, undoing an action, etc. 

See: 

 Cut, copy and paste an item 

 Delete an item 

 Move an item 

 Undo an action 

 Redo an action 

Cut, copy and paste an item 

To cut or copy an item: 

1. Select an item or make an item current. 
 
If there is both a current item and a selected item in the worksheet, the selected 
item will be cut/copied to the clipboard. 

2. Right-click and select Cut Item(s) or Copy Item(s). 

To paste an item: 

1. Make a line current so that the item will be pasted on this line. 
 
If you want the item to be pasted at the end of the worksheet, clear the current 
item by pressing ESC. 

2. Right-click and select Paste Item(s). 



167 

Delete an item 

In Worksheet you can delete the current or selected item. This item could be a product, option, 
attribute, worksheet link, standard, outline level, subtotal, or price adjustment. 

In addition, you can also delete: 

 both the options and attribute lines in the current item 

 the pricing information in the current item 

 all subtotal lines in the worksheet 

To delete an item: 

1. Select an item or make an item current. 
 
If there is both a current item and a selected item in the worksheet, the selected 
item will be deleted. 

2. Right-click and select Delete. 

3. Choose any of the following: 

Command To 

Current Item (or 
Selected Item) Delete the current or selected item(s). 

Options + 
Attributes 

Delete option and attribute lines from the current or 
selected item(s) 

Pricing 
Worksheet does not show a confirmation message 

before deleting pricing information. 

This deletes prices from the current or selected item(s). 
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All Subtotals 
Worksheet does not show a confirmation message 

before deleting all subtotals. 

This deletes all subtotal lines in the worksheet. 

4. Click Yes if you see a Confirmation message. 

Note:  A quick way to delete the item is to press CTRL+SHIFT+DELETE. 

Move an item 

You can move the current item up, down, to the top or to the bottom of the worksheet. 

From the Item menu, select Move, then choose the appropriate action. 

Undo an action 

To undo the last action: 

Click   on the Standard toolbar. 

To undo more than one action: 

1. Click the arrow next to the Undo icon in the Standard toolbar to see a list of the 
most recent actions you can undo. 
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2. Click the action you want to undo. If you don't see the action, scroll through the list. 
 
When you undo an action, you also undo all actions above it in the list. Also, if you 

later decide you didn't want to undo an action, click . 

Redo an action 

To redo the last action: 

Click   on the Standard toolbar. 

To redo more than one action: 

1. Click the arrow next to the Redo icon in the Standard toolbar to see a list of the 
most recent actions you can redo. 
 

 
2. Click the action you want to redo. If you don't see the action, scroll through the list. 

 
When you redo an action, you also redo all actions above it in the list. Also, if you 

later decide you didn't want to redo an action, click . 
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Go to a specific line and column 

If you have several lines in your worksheet and want to go to a specific line and column, use the Go To 
command. 

1. From the Edit menu, select Go To. 

2. Under Item Number, enter the line number you want to go to. 

3. Under Select Column, select the column you want to go to. 

4. Click OK. 

Go to an item's location in Explorer 

1. Make the item current in the worksheet. 

2. Right-click and select Explore to go to the product's location in the Content tab. 
 
The item is then highlighted in the Content tab of Explorer. 

Add or edit an annotation for an item 

To enter or edit a note on an item, click in the Annotation column and then write or edit a note. 
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Sort records by column 

Lines on your worksheet can be sorted by one column or by multiple columns. 

To sort by one column: 

1. Click the column heading, for example, Part Number. 

2. You will be prompted to confirm the sort so you don't sort your worksheet 
accidentally, since sorting will remove any subtotals in the worksheet.  Click Yes. 
 
This will sort your worksheet by number (1-9) then letter (A-Z). 
 
A second click will reverse the sort by letter (Z-A) then by number (9-1).  You will 
notice an arrow next to the column heading, indicating that records are sorted by 
this column. 



172 

 

 
See also: 

 Sort by multiple columns 

 Save Sort Settings 
 

Note:   You can also sort your worksheet by right-clicking any column header, selecting Sort then the 
column name. 

Sort by multiple columns 

1. Click  on the Worksheet toolbar. 

2. In the Multiple Column Sort dialog, select the checkboxes beside the columns you 
want to sort by. You can also Select All or Clear All of the columns. Only columns 
that are displayed in the worksheet are available. 
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3. By highlighting a column name (such as Part Number) and using the Move Up, 
Move Down, Top or Bottom arrows, move the column up or down in the sorting 
order. 
 
This will adjust the rank or order of your sort.  The first column checked will be used 
as the primary sort field. 

4. Choose either sort order:  
 
Ascending - sorting from 0 to 9, then A to Z  
 
Descending - sorting from Z to A, 9 to 0 

5. If you want to Insert subtotals after each unique value of the primary sort field, 
check the box. 

6. Click OK to execute the sort. 

Attributes 

You can add Attribute lines to line items and use them as a tag field or a place to enter specific 
information about that item. Attribute information is generally used for notes or information that is not 
in the catalog. Text entered in the Attribute field is not affected by Update Against Catalog. Attribute 
lines can also be displayed or hidden in a worksheet. 

1. Make a product line current in a worksheet. 

2. Click   on the Item toolbar then select Attribute. 

3. A yellow line will appear below the options. 
 
Type in information such as a specific note about that item.  
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To display or hide Attribute lines, click the Rows dropdown in the View toolbar and select Attributes. 

 
See also: 

 Search for an attribute line 

 Delete an item 

 Show or hide rows 

 Copy options and attributes (Block Assign) 
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Note:   Steelcase uses the Attribute field for specific tagging. See Manufacturer-specific information 

Search for an attribute line 

1. Click  on the Standard toolbar. 

2. Check Advanced. 

3. Under Item Detail Search Criteria, click under Type then select Attribute. 

4. Type in the number and/or description. 
 

 
5. Click Find Next. 
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Custom items (Specials) 

You can create custom items if a product is not found in a catalog, or if a standard product needs to be 
adjusted in some way.  

See: 

 Change an existing part into a custom item 

 Add an item that is not found in a catalog 

 For Steelcase users, see Convert to Steelcase Special in the 2020 Worksheet Manufacturer 
Specific Information help. 

 For Haworth users, see Haworth Specials in the 2020 Worksheet Manufacturer Specific 
Information help. 

Change an existing part into a custom item 

1. Customize your columns in order to display the Special column. It is recommended 
to move it next to the Cat column. 
 

 
2. Make an item current. 

3. Change the product number, description and list price as needed. 
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4. Change the options — once the item is defined as a special you won't be able to 
specify options. 

5. Check the box under Special. This adds an asterisk to the CAT code. 
 

 
 
 
Note:   This also works the other way — if you add an asterisk to the CAT code the 
Special box will be checked. 

6. Once all changes are made, it is a good idea to lock the line item to protect it from 
any mistaken changes. 

Because the CAT code has been changed, if you do an Update Against Catalog this line item will be 
ignored. Also, you cannot specify options for this custom item. 

If you want to update this item against the catalog or specify it, you need to clear the Special box or 
remove the CAT code asterisk. 
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Add an item that is not found in a catalog 

Another method for creating a custom item is to add a blank line to the worksheet and type in the 
information you need: 

1. Click   on the Item toolbar then select Product. 

2. Type the information about the special in the blank line. 
 

 
3. Once all changes are made, it is a good idea to lock the line item to protect it from 

any mistaken changes. 

See also: Insert blank options and attributes. 
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Note:   The icon in the line item's Complete column will indicate that it needs to be updated against the 
catalog.  You will not want to do this because Worksheet will flag this item as unknown and you may no 
longer be able to find the item in the worksheet. 

Insert blank options and attributes 

You can add a blank option or attribute to a line item. The Option line is used for information from the 
manufacturer's catalog or information about finishes. The Attribute line is for additional information 
such as special installation instructions or notes. 

To insert a blank attribute line, see Attributes. 

To insert a blank option line: 

1. Make the item current. 

2. Click   on the Item toolbar then select Option. 

To delete option and/or attribute lines, see Delete an item. 

Item properties 

Once you have added options or discounted your worksheet you can display columns with the pricing 
information or you can use the Item Properties of each individual line item. 

To view an item's properties: 

1. Right-click on an item then select Properties. 

2. Click on any of the Item Properties tabs: 
 
Pricing: view prices and quantities. 
Discounts: view discounts associated with an item.  Click Edit All to edit discounts 
or Remove All to remove all discounts. 
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Details: to see options applied to that line. Click Specify to change the options. Click 
Step In to step in the level, if the current item is a Standard or an Outline level. 
Visualization: change the image displayed in the Preview column. Change the 
preview image (see Preview a product) then click Use this image for item preview. 

3. Click Previous or Next to view the properties of the previous or next item in the 
worksheet. 

4. Click Goto Item to close the Item Properties dialog and make the item that was 
opened in Item Properties current. 

See also Item Detail view 

Copy values from one column to another 

Worksheet columns have certain information in them when you do a take off (create a worksheet) from 
a drawing.  For example, the Tag column will have the symbol tags listed and you may have assigned an 
Alias value in the drawing. You may want to have the information that is in the Alias column in the Tag 
column. 

Example - copy values from the Alias 1 column to the Tag column: 

1. Make sure that the Alias 1 and Tag columns are visible on the worksheet. 

2. Click  in the Worksheet toolbar. 

3. In the Column to Copy From box select Alias 1. 

4. In the Column to Copy To box select Tag. 

5. If you want to keep the information in the Tag column and simply add the 
information from the Alias 1 column then check Append copied text to the current 
value. 

6. If you want to apply only to selected items check the option. 
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7. If you want to apply within all levels (standard and outline levels) check the option. 

8. Click OK. 

Quickly fill in cell values (Assign) 

When the information of a column is the same for many line items, use the Assign feature to quickly fill 
in all the cells. 

Example - assign values to the Alias 1 column: 

1. Turn on the Alias 1 column. 

2. Click the Assign icon  in the Worksheet toolbar. 

3. Check Alias 1 and type Area A in the Assign Value column. 
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4. If you want to Assign only to selected items check the option. 

5. If you want to Assign within all levels (standards or outline levels) check the option. 

6. Click OK. 

Note:   If you want to assign an Attribute or Option to lines click the Option drop-down. 
 

 

Copy options and attributes (Block Assign) 

Block Assign will copy the options and/or attributes of one item to other items on your worksheet. It 
can be a great time saver if you have several similar items that all require the same finishes/attributes. 

To add a block of options from one item to similar items on a worksheet. 

1. Select (make current) the first item that you want to copy the finishes from. 

2. Select the items you want to copy finishes to. 

3. Click   on the Worksheet toolbar. 

4. Under Assign, leave both Options and Attributes checked. This will copy both the 
options and attributes. 
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5. The From Item field should default to the current item number (the item that has 

the finishes you wish to copy). 

6. Under To Item, click Selected. 

7. Click OK. 
 
The From Item's options will overwrite the existing options on all the selected 
items. Be aware that you may accidentally apply options from a panel to a pedestal. 
The Attributes will be added to any other Attributes the items already have. 

8. Now that the options have been assigned, do an update against catalog. 
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Note:  Updating against the catalog is vital if you assign finishes from one item to another because these 
finishes may include a price up-charge that needs to be reflected in the total pricing. You should always 
update against the catalog after using Block Assign. 

Consolidate identical items 

Consolidate combines identical line items into one line item and updates the quantity. 

1. Click  on the Worksheet toolbar. 

2. In the Consolidate dialog, select or clear the criteria will be used for the 
consolidation. For example, if you have different tags or discounts in the file clear 
those columns. The resulting value in the column will be the first value encountered 
in the worksheet. 
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3. Click Consolidate. 

See also: Split an item 

Note:   Any items that are optioned or discounted differently will not consolidate unless the option or 
discount boxes are cleared. 
 
Click Edit Defaults to change the default consolidate criteria. This is the same as clicking Default 
Consolidate Criteria in Tools, Preferences, Common. 
 
Click Set Defaults to reapply the default criteria on the dialog box. 

Split an item 

Split separates one line item into two identical items and updates the quantity. Instead of copying and 
pasting a line then changing the Qty, Split is a quicker way of accomplishing the same task. 

1. Make the item current. 
 
Before splitting an item, make sure its Qty is greater than 1. 
 

 
2. From the Item menu, click Split. 

3. Type the quantity for the new or existing line.  The other quantity will be 
automatically updated.  You can also use the buttons to change quantities. 
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4. Click OK. 

 

 
See also Consolidate identical items 
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Update items 

Use: 

 Update against a catalog to apply information such as pricing from the manufacturer catalog to 
your worksheet. 

 Update against a worksheet to update finishes, tags and discount information using an existing 
worksheet. 

 Update preview images to retrieve, change or reset the preview images of items in your worksheet 

Update against a catalog 

Updating against a catalog applies information from the manufacturer catalog to your worksheet. 
Catalog information includes data such as part numbers, part descriptions, list prices, weights and 
volumes. The Update Against Catalog will also allow you to update against different price zones. 

Note:  Whenever you see this icon  in any of the cells under the Complete column, you will need to 
do an update against catalog. 

1. If you want to update only certain items, select them first in the worksheet. 

2. Click   in the Worksheet toolbar. 

3. Under Update Settings change any of the following: 
 
- price zone 
- update items within all levels (Standard or Outline) 
- update selected items only 
- flag items not found in catalogs 

4. Click Update. 
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5. Once the process if finished, read the dialog box to see how many items were 
updated, then click OK. 

Note:   If you checked Flag items not found in catalogs, you can easily find items in your worksheet that 
were not found by the update. Check for typing errors and update again. 

Update against a worksheet 

Updating against a worksheet can save several steps. Where updating against the electronic catalog will 
bring in correct description and most recent pricing, updating against a worksheet will update finishes, 
tags and discounting from a pre-made worksheet. For projects that use the same furniture with the 
same finishes, it is a great time saver.  

In the example below, you will update a new worksheet against another one to bring in options. 

1. First, make sure to have a saved worksheet with products already optioned. This 
will be the "Master" worksheet. You will update another worksheet against this 
one. 

2. Create a new worksheet. 

3. Enter some part numbers that are also in the Master worksheet. 

4. Click   on the Worksheet toolbar. 

5. Under Worksheet to Update Against, type the path and file name of the Master 

worksheet or click  to locate it. 

6. Under Update By, leave the default setting (Product Number). 
 
This will search for exact product numbers in the worksheet that you are updating 
against, and bring the remaining information for that particular item to your current 
worksheet. 
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7. Accept the defaults in the Columns to Update section. This will include all the 
information that we want brought into our current worksheet. 

8. Under Update Criteria, leave the Update options checked so that the options will 
be updated. 

9. Click OK. 

10. Read the Results dialog box for information on updated items then click OK. 

11. Do an Update Against Catalog to validate option selections and get current pricing. 

Note:  You can also use the Option Clipboard to copy options from an existing worksheet. 

Update preview images 

Use the Update Preview Images command to: 

 Change the preview image of items on the worksheet 

 Retrieve the preview image of items that have an empty Preview column — this is the case 
when items were added to the worksheet from a takeoff from CAP Designer or by using the 
Merge, Import and Send To commands. 

 Reset the preview image of items on the worksheet back to the default image, zoom 
magnification and rotation. 

Note:  If an item is locked, its preview image will not be updated. 

If you have a standard or outline level in your worksheet, you need to use the Step In command to view 
its contents, then use the Update Preview Images command. 

1. Click  on the Worksheet toolbar. 

2. Do any of the following in the Refresh Preview Images dialog: 
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To: Do this: 

Change the preview 
image of the displayed 
item 

1. If necessary, make changes to the preview 
image. 
 
See Preview a product for details on what 
you can do with preview images. 

2. Click Update This Image For Item Preview 
to change the preview image of the 
current item displayed. 

3. Click Next Item to go to the next item. 

4. Click Close. 

Retrieve the preview 
image of items that 
have an empty 
Preview column 

1. If you want to replace existing images with 
their default image, rotation and zoom 
magnification, check Replace existing 
images. 

2. Click Update All to retrieve the preview 
image of items that do not have an image. 
 
This button changes to a Stop button 
during the update.  Click Stop if you want 
to discontinue updating. 

3. Click Close. 

  



192 

Reset the preview 
image of items on the 
worksheet back to the 
default image, zoom 
magnification and 
rotation 

1. Check Replace existing images. 

2. Click Update All. 
 
This button changes to a Stop button 
during the update.  Click Stop if you want 
to discontinue updating. 

3. Click Close. 

Flag and lock lines 

You can lock lines so that they cannot be updated automatically (by functions such as Global Options) or 
manually. 

You can also flag lines to mark them for a specific reason. 

See: 

 Flag lines 

 Flag by criteria 

 Lock lines 

 Lock by criteria 

Flag lines 

A line can be flagged automatically after updating against a catalog or adding a service part.  You can 
also flag a line manually. 

To flag one item: 

Click in the Flag column. 



193 

 
To flag several items: 

Select the items then click  in the Item toolbar. 

The Toggle Flag button will switch the flag status of either the current item or selected items.  The fly 
out includes Toggle Flag, Set Flag and Clear Flag buttons. 

  

The Flag status can also be controlled from the Item menu. From here you can also go to the previous or 
next flagged item, clear all flags or flag by criteria. 

Flag by criteria 

If you have a large worksheet, instead of selecting items then flagging them, multiple items can be 
flagged by criteria. 

In the example below we will flag items from a specific catalog: 

1. From the Item menu select Flags, By Criteria. 

2. Check the Cat column and set the value to equal a catalog code in your worksheet. 
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All the items from that catalog will be flagged. You can select these flagged items 
using the Edit menu. 
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Lock lines 

A locked item is not affected by most commands and cannot be edited.  Many toolbar buttons will be 
grayed out if the current item is locked. 

If you lock a line then export the worksheet to SIF, the line is not included in the order. Also, a locked 
line is not optioned by Global Options or updated by an Update against catalog. 

To lock one item: 

Click in the Lock column. 
 

 
To lock several items: 

1. Select a few items in the worksheet. 

2. Click  on the Item toolbar. This will switch the lock status of either the current 
item or selected items.  

The Toggle Lock button will switch the lock status of either the current item or selected items.  The 
flyout includes Toggle Flag, Lock and Unlock buttons. 
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The Lock status can also be controlled from the Item menu. From here you can also go to the previous 
or next locked item, unlock all items or lock by criteria. 

Note:  A locked line is not the same as an item with a price lock . Items with price locks have the 
price columns locked, but you can still modify the other columns. See Add service parts for an example. 

Lock by criteria 

If you have a large worksheet, instead of selecting items then locking them, multiple items can be 
locked by criteria. 

Example: lock all complete (all options have been specified) items. 

1. From the Item menu select Lock, By Criteria. 
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2. Check the Complete column and set the value to equal Complete. 
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Send an item 

You can send a worksheet item to: 

 another worksheet 

 a drawing 

 a custom catalog 

Send to a worksheet 

You can copy items from one worksheet and send them to another worksheet. 

1. Select an item or make an item current in your worksheet. 

2. Right-click on the item then select Send To, Worksheets. 

3. Select: 
 
New - to send the item to a new Untitled worksheet 
Existing - to send the item to an existing worksheet that is not currently open 
<Worksheet name> - to send the item to an open worksheet 

See also Send to a drawing 

Note:   If you right-click on a product in the Explorer bar, you can also access the Send To menu. For 
example, you can send items from your Custom Catalog.  
 
You can also send items from the 2020 Options dialog. 
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Send to a drawing 

You can send an item from a worksheet to an AutoCAD drawing. You can only send one item at a time 
to the drawing because you will be placing the symbol of that item. 

1. Open the AutoCAD drawing. Make sure that CAP Designer has been loaded. 

2. Select an item or make an item current in your worksheet. 

3. Right-click on the item then select Send To, Drawing. 

4. Go to the AutoCAD drawing. 
 
Notice that the symbol is ready to be placed. 
 
If there is no symbol referenced to the part, you will not be able to send it to a 
drawing. 

5. Place the symbol in your drawing. 
 
If the item is optioned it will be sent to the drawing with these options. 
 

Note:  If you right-click on a product in the Explorer bar, you can also access the Send To menu. For 
example, you can send items from your Custom Catalog.   
 
You can also send items from the 2020 Options dialog. 
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Search for text or products 
The following topics show you the various ways you can search for text or products in 2020 Worksheet. 

 Find text in a worksheet 

 QuickSearch 

 Search for products 

Find text in a worksheet 

To find cells containing a search string: 

1. Click  on the Standard toolbar. 

2. Beside Find What, type the text you want to search for. 
 
Note: If there is an item selected in the worksheet, the Search Selected Cells will be 
checked by default. 

3. Select the Direction of the search: up or down. 

4. Click Find Next. 
 
Worksheet puts the cursor on the cell containing the text you entered. 

5. To search for the same text again using the same search direction, press F3. 

See also: 

 Use Advanced Find to Select Items 

 Find and replace an item 
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Note: To reuse a previous search string, use Quick Find on the Standard toolbar 

.  You can also search for a string by entering a value here. 

Use Advanced Find to select items 

When your worksheet is small it is easy to select the items you need for editing or updating.  How can 
you quickly select a group of items if you have 70 line items on your worksheet? 

Example: select panels in the worksheet 

1. Make sure that you have at least one panel in your worksheet. 

2. Click  on the Standard toolbar. 

3. Check Advanced. 

4. Check Part Description. 
 
Note: If there is an item selected in the worksheet, the Search Selected Items will 
be checked by default. Make sure to clear this and any other check boxes from 
previous searches. 

5. In the Operator column, change "equals" to "contains" by selecting it from the drop 
down. 
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6. In the Value column type Panel. 
 

 
7. If there is anything else that all panels have in common select another search 

criteria. 
 
For instance, if you want to select all panels with product numbers containing 
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“ABC…”, check Part Number, change the Operator to "contains" and type ABC 
under Value. 

8. Click Select All. 

Note: You can also do the same thing using Select by Criteria. 

Find and replace an item 

Find and Replace will find a certain set of characters in a worksheet and replace it with another. This 
feature is useful if your customer wants to change one finish to another globally. 

For instance, if the customer has decided to change all black trim to gray. 

1. Click on the Standard toolbar. 

2. In the Find What field, type the information that you want to replace. 

3. In the Replace With field, type the information that will replace the Find What 
information. 

4. In Replace In Column, select the column where values will be replaced. 

5. In Replace In Row, change the value to the specific rows you are changing (for 
example, Options). 
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6. Under Replace In, select All Items or Current Selection (selected by default if there 

are selected items in the worksheet). 

7. Click Replace to replace one occurrence or Replace All to replace all occurrences. 

Remember: you must do an Update Against a Catalog to have the description and / or prices change. 

Note: Highlight the information you want to replace before doing a Find and Replace so that the text is 
automatically entered in the Find What field.  The correct column will also be set in the Replace in 
Column. 
 
To run Find and Replace again, press F3. 
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QuickSearch 

The QuickSearch feature displays a list of possible matches as you type in a part number.  This feature is 
available from the Content tab of the Explorer pane and from the Part Number field in the worksheet 
area. 

See: 

 Use QuickSearch from the Content tab 

 Use QuickSearch from the Part Number field 

 Filter QuickSearch 

To change QuickSearch behavior, go to the Tools menu, select Preferences, and then click QuickSearch. 
For more information see QuickSearch preferences. 

Use QuickSearch from the Content tab 

1. In the Content tab of the Explorer pane, start typing a part number in the 
QuickSearch field. 
 
The program displays a list of possible matches, up to a maximum of 50.  This list 
contracts as you type in more of the part number. 
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By default, the QuickSearch filter is on so that the search is performed on the 
current level (catalog or section). To turn off this filter, see Filter QuickSearch. 

2. Select an item from the list by double-clicking on it. 

Note: QuickSearch displays a maximum of 50 matching parts. You can change this number in the 
Preferences dialog.  See QuickSearch preferences for details. 

Use QuickSearch from the Part Number field 

1. In the worksheet area, click in the Part Number field. 

2. Start typing the part number. 
 
As you type in the part number, the program will display a list of possible matches, 
up to a maximum of 50.  This list will contract as you type in more of the part 
number. 
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Note: By default, QuickSearch will provide a list of possible part numbers in all 
available catalogs.  If you want the search limited to a certain manufacturer or 
catalog, enter a value in the Mfg or Cat fields before typing the part number. 

3. Double-click on the desired part number to fill in the information. 

Note: QuickSearch displays a maximum of 50 matching parts.  You can change this number in the 
Preferences dialog.  See QuickSearch preferences for details. 

Filter QuickSearch 

By default, the QuickSearch filter is on so that QuickSearch searches only within the current level. For 
example, if you navigated down to a catalog, only that catalog will be searched.  If you navigated down 
to a section, only that section will be searched. 

To turn the filter on or off, click the filter button  in the Content tab. 

To see the difference with the filter on and off: 

1. Navigate to a part number. 
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2. Make sure that the QuickSearch filter is on. 

3. Type a part number that is from a different catalog.  Notice that nothing is found 
even if the entire part number is entered. 
 

 
4. Click the Filter QuickSearch button to deactivate it. 

5. Type the same part number. Notice the list of possible matches from all catalogs. 

Search for products 

Use 2020 Search to look for products in: manufacturer's catalogs, custom catalogs, and worksheets. 

This tool is useful when searching multiple catalogs for products with a common element (panels, for 
example). It displays the search results in the Explorer bar's Search tab. 

To access 2020 Search, click  from the Tools toolbar or from the Search tab in Explorer. 

You can search by part number or by part description. 
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Search by part number 

1. Click  from the Tools toolbar. 
  

2. Under Search Field, select Part Number. 

3. Under Manufacturer or Project File Type, select the manufacturer, Custom Catalog 
or Worksheets. 

4. Under Catalog or Project File, select the catalog, custom catalog or worksheet. 

5. Under Search String, type the full or partial part number. 
 
You can use wildcards to replace missing or unknown characters.  The “*” will 
replace a string of characters. The “?” will only replace one character. You may have 
more than one wildcard in a search string. 

6. Click Search. Your completed search should look similar to the image below. If there 
is no match, no items will appear. 
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7. Hover over an item to select it. 

8. Click any of the following: 
 
Specify to launch 2020 Options, where you can specify finish options for the 
selected item. 
Explore to go to the product's location in the Content tab. 
Send To to send the item to a custom catalog, worksheet or drawing 
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Note: The more catalogs you search through, the longer it will take. Click the Abort button if the search 
takes too long. 
 
When you finish a search, search results are displayed in the Explorer Search tab. From here you can 
select products and send them into drawings or worksheets as you would from the Content tab. 

Search by part description 

1. Click  from the Tools toolbar. 

2. Under Search Field, select Part Description. 

3. Under Manufacturer or Project File Type, select the manufacturer, Custom Catalog 
or Worksheets. 

4. Under Catalog or Project File, select the catalog, custom catalog or worksheet. 

5. Under Search String, type the full or partial part description. 
 
You can use wildcards to replace missing or unknown characters.  The “*” will 
replace a string of characters. The “?” will only replace one character. You may have 
more than one wildcard in a search string. 

6. Click Search. Your completed search should look similar to the image below. If there 
is no match, no items will appear. 
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7. Hover over an item to select it. 

8. Click any of the following: 
 
Specify to launch 2020 Options, where you can specify finish options for the 
selected item. 
Explore to go to the product's location in the Content tab. 
Send To to send the item to a custom catalog, worksheet or drawing 
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Note: The more catalogs you search through, the longer it will take. Click the Abort button if the search 
takes too long. 
 
When you finish a search, search results are displayed in the Explorer Search tab. From here you can 
select products and send them into drawings or worksheets as you would from the Content tab. 

Preview a product 
The Product preview helps in the visual selection of products from a catalog and the visual identification 
of products already in a worksheet. 

 
You can preview a single item if you select a product from a manufacturer catalog, or multiple items if 
you select a standard from a custom catalog. Note that the standard must have been created within 
CAP Designer, not Worksheet. 
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The product preview feature is available from different areas of 2020 Worksheet: 

 Explorer pane 

 Worksheet tab (Worksheet area) 

 Item Properties 

 Catalog Properties 

 Item Detail view (Task Pane) 

 Report Designer 

You can do the following when previewing a product or standard: 

 Change the preview image type 

 Rotate or move an image 

 Zoom an image 

 Change the ISO view 

 Change the rendering mode 

 Save the image 

 Load an image 

See also: Update preview images 

Note: Product preview may not be available for all manufacturer products. 
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Change the preview image type 

1. Click on the Auto button, which is the left-most on the toolbar. 
 

 
 
When you first preview an image, Auto is selected as the image type. Auto 
corresponds to the first image type checked in Visualization Preferences that has an 
available image. 

2. Select the image type from the drop-down. 
 
All image types (except text) allow zooming in and out. In addition, if you choose 
the Live Rendered image type, you can rotate and move the image. 
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Image type Definition 
Live 
Rendered Interactive rendered image 

Photograph Photograph 

Dimensional Image with dimensional information 

Context Image of the content in a typical environment 

Rendered 
Image Rendered image 

Text Text description 

  

The image is displayed using the image type you selected. 

Rotate or move an image 

You can rotate or move live rendered images only. 

To rotate an image horizontally: 

1. Left-click the image. Keep holding the left mouse button. 

2. Move the mouse left or right to rotate the image in a horizontal direction. 
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To move an image in any direction: 

1. Click and hold both left and right mouse buttons. 

2. Move the mouse in any direction. 

See also: 

 Change the ISO view 

Note: To reset the view back to the default zoom and rotation, click  . 

Zoom an image 

1. Right-click the image and hold. 

2. Zoom in/out my moving the mouse down/up. 

Note:  To reset the view back to the default zoom and rotation, click . 

Change the ISO view 

Click any of the view buttons to position the image in a different ISO view: 

 ISO SW — position the image in an ISO southwest view 

 ISO SE — position the image in an ISO southeast view 

 ISO NW — position the image in an ISO northwest view 

 ISO NE — position the image in an ISO northeast view 

 ISO Top — view the image from the top 

See also: 

Rotate or move an image 
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Change the rendering mode 

Click any of the rendering buttons to change the rendering mode: 

Icon Name Description 

 

Shaded view the image in a shaded rendering mode 

 

Wireframe view the image in a wireframe rendering mode 

 

Hiddenline 
Wireframe view the image in a hidden-line wireframe rendering mode 

 

Greyscale   use the greyscale color palette when rendering 

 

AutoCAD 
colors use the AutoCAD color palette when rendering 

 
Note:  The Preview feature displays an image using the default image type set in Visualization 
preferences. 

Save the image 

To save a snapshot of the image in BMP format: 

1. Click . 

2. Select the folder where you want to save the image. 

3. Type the image name. 

4. Click Save. 
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Load an image 

To use your own image for the preview: 

1. Click . 

2. Select the folder where the image is located. 

3. Click on the image name then click OK. 
 
The image you loaded is now displayed in the Preview. 
 
Notice that if you click the Image type button, User Image is checked. 
 

 
 

Note:  Selecting a user image does not change the default image displayed for the selected 
product/standard. 
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Options 
It is recommended to specify options once you are done adding all the products to your worksheet. 

Manufacturers cannot fill an order unless all the items on the worksheet have finish information such as 
fabric, laminate, and/or paint colors. 

There are several ways you can specify options in 2020 Worksheet: 

 Specify - access 2020 Options - apply options to one item at a time 

 Global options - apply options to several items at the same time (recommended to save time) 

 Option clipboard - apply options to several items from similar items in the current worksheet or 
from another worksheet 

See also: 

 Complete column 

 Search for an option line 

 Insert blank options and attributes 

 Update against a worksheet 

 Copy options and attributes (Block Assign) 

 Show or hide rows 

 Validate a worksheet 
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Specify - access 2020 Options 

To specify an item in a worksheet, right-click on the item then select Specify. 

Note: If the item is incomplete, click the Incomplete icon in the Complete column: 
 

 
You can also specify a product from any of the Explorer bar tabs by right-clicking on the product then 
selecting Specify. 

In the 2020 Options dialog, you can do the following: 

 Customize the 2020 Options dialog 

 Select options 

 Skip options 

 Change options 

 Apply default options automatically 

 Preview options 

 Preview structural options 

Note: See Global Options to specify options for several items at the same time. See also Option 
Clipboard  to apply options to several items from similar items in the current or another worksheet. 
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Global Options 

Global options gives you the ability to select and apply options to multiple items at the same time. This 
will save valuable time and reduce the chance for errors that occur during the specification stage of a 
project. 

This is different than the option clipboard. The dialog allows you to work through an entire specification 
at the same time. You will see the line items that you will be applying finishes to, the option groups that 
need to be selected as well as the options available. 

To set global options: 

1. Click the Global Options tab at the bottom of the current worksheet. 
 

 
2. You will be prompted to refresh global options based on any changes you have 

already made to finishes in the Worksheet view.  Click Yes to refresh. 
 
To make your choice the default behavior so that you do not see the prompt every 
time you click Global Options, check Do not ask this again. 

See: 

 Screen components - to become familiar with the Global Options screen layout 

 Select options using Global Options - for step-by-step instructions on selecting global options 

 Filtered items - to see which items are filtered from the Global options tab 
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Screen components 

The Global Options screen is divided into 3 areas: 

 Line item information 

 Option groups 

 Available options 
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Line Item Information 

The Line Item Information area tells you which line items are going to receive the finishes that you are 
selecting in the Option groups area. By clicking on any one of the option groups the line items affected 
will appear in this window.  

Global options will apply finishes to all items unless grouping is used in the Option Groups area. 

 
Click the Filtered items button in the Option Groups area to find out if items were filtered from the 
Global Options tab. This button is enabled only if there are filtered items. 

See also: 

 Available options 

 Select options using Global Options 

Option Groups 

Option groups are the different types of finishes that need to be applied in a specification.  By default, 
options are grouped by manufacturer code. 
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To group options by different criteria: 

1. Click the Group By button in the Option Group area.  
 

 
2. Check the columns of information that you would like to group by. For example, you 

may want to group by category so that panels, worksurfaces, accessories, etc. are 
grouped together. 
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3. Change the sort priority by dragging the column. 

 
In the above example, options will be sorted first by manufacturer, then by 
category. 

4. Check Use these settings as the default groupings if you wish to set these columns 
as your default groupings. 

5. Click OK. 
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The results help you to better understand the options that are being selected.  For 
example, you can  see easily that you have different paint colors for pedestals than 
for overheads. 
 

 

Available Options 

This window lists all of the available options for each option group as it is selected.  Options are selected 
by clicking on the desired option. 

You can skip over an option group by clicking on the Next Group button at the top of this area. Skipping 
options is useful if, for instance, the customer has not decided on a panel fabric color but has selected a 
grade of fabric. 
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Some catalogs allow you to preview options. For a list of catalogs that support option previews see the 
What's New file. 
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See also: 

 Line item information 

 Select options using Global Options 

 Filtered items 

Select options using Global Options 

Note: By default, option groups are shown by manufacturer. Click Group By and check Category to 
further group by category.  This way panels, worksurfaces, accessories, etc. are grouped together. 

1. In the Global Options tab, click on the first option group in the listing. 
 

Note that a question mark under the Flag  column shows that the option group is 
skipped or has not been selected. 
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The line item information area will tell you which line items in the specification will 
be receiving the selected option group. 

2. Click on the desired finish in the Available Options area. 
 

 
 
Some catalogs have option preview available. 
 
In some cases, a popup dialog will appear and you will have to enter your finish 
(customer's own material). 
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You can skip over an option group by clicking on the Next Group button at the top 
of this area. 

3. In some cases, sub-options may open under the selected option, indicated by a 
minus sign.   
 
Continue selecting options until the next top level option is highlighted. 
 

 
4. An option is selected and complete when there is a green checkmark in the Flag 

column. 
 
If you see a red flag in the Flag column, it means that the option was selected 
automatically by Quick Options. You can accept this selection by clicking on the red 
flag or change the selection by highlighting it and clicking the Verify button. 

5. If all option groups are checked when the finishes are applied, then all finishes are 
specified in the current worksheet. 
Click Apply to take the finishes selected and apply them to the appropriate line 
items in the specifications. If you forget to do this before leaving Global Options, 
you will be prompted to do so. 
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See also: 

 Filtered items 

 Screen components 

Note:   If you make changes in Global Options then click Refresh before clicking Apply, refreshing will 
discard the selections you made in Global Options and will reapply the options set in the worksheet. 
 
The Refresh button forces the Global Options tab to take a look at the current worksheet and pull 
existing finishes into the Global Options tab.  This is normally done when you enter the Global Options 
tab but if for some reason you chose not to refresh, this button will perform that function. 

Verify options if Quick Options is on 

Quick Options allows the same option to be tentatively selected.  This feature helps speed the selection 
process by looking for duplicate finish selections and applying the same finish. 

For example, if there is a paint option on pedestals and overheads, once the finish is selected for the 
pedestals, the same finish will tentatively be applied to the overheads. 

This is NOT a forced decision - you will still need to verify these selections. 

1. Click the Quick Options button in the Option Groups area. 
 
The Quick Options button is a toggle - if the button is highlighted the feature is 
turned on. If it is the same color as the other buttons the feature is turned off.   
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2. As finishes are selected, if a similar finish can be "assumed" quick options will 

pick that finish. 
 

A red flag will be placed under the Flag column  to let you know that this was 
selected automatically by Quick Options.   
 
Notice in the example below that the Core/Mica paint color was selected in the 
Design group and is indicated by a green check mark.  In the Sales group this 
same option has a red flag indicating it was selected by Quick Option. 
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3. To confirm an option selected by quick options, click on the red flag to turn it to 

a check. 
 
To change the finish, highlight the option and click the Verify button. 
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Note:  By default, Quick Options is automatically on. If you wish to change this setting, go to the Tools 
menu, Preferences, then click Specification. 

Filtered items 

To prevent Global Options from updating certain items, they are filtered from the Global Options view: 

 locked items 

 custom catalog items 

 items not found in the catalog 

 items not updated against the catalog 

 items created before Worksheet 3.0 that have never been updated against the catalog 
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To see the list of filtered items, click  in the Option groups area.  Note that the number of 
filtered items is indicated beside the button. 

You can resize the Filtered Items dialog and its columns. 

 
You can also right-click on an item and select Properties to display the Product Group Properties dialog. 

See also: 

 Select options using Global Options 

 Screen components 
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Option Clipboard 

The Option Clipboard view of the Task pane is used for quickly applying options to a worksheet from 
similar items in the same worksheet, a previously opened worksheet, or from a saved Option Set file. 

 
For details about the three sections in the Option Clipboard, see Option Clipboard sections. 
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To apply options to the worksheet: 

1. Copy options to the clipboard 

2. Use the Option trail to apply options to other items. 

If you wish, you may save options in an option set so that you can apply them to other worksheets. 

Note:  Remember to do an Update Against Catalog whenever you use the Option Clipboard. Updating 
against the catalog is vital if you assign finishes from one item to another because these finishes may 
include a price up-charge that needs to be reflected in the total pricing. 

Option Clipboard sections 

The Option Clipboard view has three sections: 

 Option Trail Actions - provides tools for capturing option trails (all of a line item’s assigned 
options) from items in a project, applying captured option trails to items in a project, and viewing 
and modifying properties of captured option trails. 

 Option Clipboard - displays captured option trails. These option trails are selected individually or 
in groups for application to items in a project. Right clicking on an option trail provides quick 
access to a menu of option trail action commands. 

 Option Set Actions - provides tools for saving the content of the Option Clipboard as an Option 
Set, loading a saved Option Set into the Option Clipboard, and emptying the entire contents of 
the Option Clipboard. 

Copy options to the Option Clipboard 

1. Switch to the Option Clipboard view in Task Pane. 

2. Select a completely specified line or make it current. 
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3. Click Copy on the Task Pane. 
 

 
 
The options from that line item will be copied to the Option Clipboard. 
 
If the option trail is already in the clipboard, a notification dialog opens. 

Note:  You can select multiple lines. Each unique option trail in the selection will be copied to the 
clipboard. Duplicate trails will not be copied. 
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Option trail 

Option trails copied to the clipboard can be used in a variety of ways: 

 Paste a single option trail onto a single line item in the worksheet 

 Paste a single option trail to multiple line items in the worksheet 

 Paste multiple option trails to multiple line items in the worksheet 

See also Option Trail Properties 

Option Trail Properties 

When an option trail is captured on the clipboard it carries with it additional properties associated with 
the line item from which it was copied. These properties can be edited for the captured option trail, but 
those edits are not reflected back to the original line item from which it was copied. Also, if these 
properties are changed on the original line item, they are not updated for the captured option trail on 
the clipboard. 

To view an option trail’s properties: 

Hove the cursor over an option trail in the clipboard. 
 
A popup dialog (Option Trail Properties) opens, listing that trail’s properties and current values. This 
dialog is for information only and disappears after a brief delay. 
 
If you do not see the popup dialog, activate it by going to the Tools menu, Preferences. Click 
Specifications. 

To edit an option trail’s properties: 

1. Click the option trail in the clipboard. 

2. Right-click then select Properties. 
 
This brings up the editable Option Trail Properties dialog. 
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3. You can edit, add or delete the value for any property as necessary.   
 
All property values come from the original line item, except for the Name property. 
The Name property allows an option trail to be labeled with freeform text. It can be 
used for any purpose, such as labeling the option trail according to the project 
location to which that trail applies. 
 

 
See also: 

 Apply an option trail to one item 

 Apply an option trail to several items 

 Apply several option trails to several items 
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Apply an option trail to one item 

1. From the Option Clipboard select one option trail. 

2. Drag it onto a line item in the worksheet and drop it to apply. 
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Once the option is applied, a results dialog box appears. The results show: 

 How many items were processed (how many items the options were copied to) 

 How many are complete with no skipped options 

 How many items are still incomplete and need more options added 

 How many unique option lines were pasted 

 How many options were skipped 

When you apply an option trail to an item, the software automatically does an update against the 
catalog for the options in that item.  This is a partial update — it does not affect the part description or 
the unit list price of the base item, only the option pricing.  You still need to update against the catalog. 

See also: 

 Option Trail Properties 

 Apply an option trail to several items 

 Apply several option trails to several items 

Note: Options will be applied similarly to the way default options are applied in the Specify tool. If you 
apply the options from one item to a different product type, each option will be checked to see if it’s a 
valid option — only the ones that are valid will be used. 
 

Apply an option trail to several items 

You can apply one option to items in the worksheet that share common characteristics. When using this 
technique you will ensure that options are assigned where desired. 
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You can apply an option trail to: 

 selected items in the worksheet 

 items that match a specific criteria 

 items that match the trail properties 

In the example below, we will apply an option trail to items that match the option trail's Mfg and 
Category columns: 

1. From the Option Clipboard, select one option trail. 

2. Click Paste with Criteria under Option Trail Actions. 

3. Check the Mfg and Category boxes in the option trail Column section and click the 
OK button. 
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After the application process has completed a status dialog opens reporting on the 
results. 

4. Click OK to review the results in the worksheet. 
 
Notice that all items in the worksheet matching both the Mfg and Category 
properties are populated with the option trail’s content. 

See also: 

 Option Trail Properties 

 Apply an option trail to one item 

 Apply several option trails to several items 

Note:  When you apply an option trail to an item, the software automatically does an update against the 
catalog for the options in that item.  This is a partial update — it does not affect the part description or 
the unit list price of the base item, only the option pricing.  You still need to update against the catalog. 

Apply several option trails to several items 

1. Select several items in the worksheet. 

2. In the Option Clipboard select several adjacent options by holding the SHIFT key or 
non-adjacent options by holding the CTRL key. 

3. Click Paste under Option Trail Actions. 
 
This will apply selected options from the clipboard to the selected line items in the 
worksheet. A status dialog opens reporting the results. 
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See also: 

 Option Trail Properties 

 Apply an option trail to one item 

  Apply an option trail to several items 

Note:  It is good practice to double check the results to ensure all options have been assigned as 
desired. 
 
When you apply an option trail to an item, the software automatically does an update against the 
catalog for the options in that item.  This is a partial update — it does not affect the part description or 
the unit list price of the base item, only the option pricing.  You still need to update against the catalog. 

Option Sets 

The Option Clipboard allows you to quickly apply pre-selected options to other worksheets. 

First, you must save the contents of the option clipboard to an Option Set. 

Then, you can then load this option set to the clipboard and apply the options to items in your 
worksheet. 

Save option sets 

The Option Clipboard allows you to quickly apply pre-selected options to other worksheets. You can do 
this by saving the contents of the option clipboard to an Option Set. 

To save all the contents of the option clipboard to an option set: 

1. Click Save As under Option Set Actions. 

2. In the Save As dialog enter a name for the file. 
 
By default, it will be saved in the My Documents\Cap\OptionSets directory with an 
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extension of .optionset. You may save this to another location by changing the Save 
in location. 

3. Click Save. 

Load and apply option sets 

To apply a saved option set: 

1. In a worksheet, clear the option clipboard if necessary by clicking Empty under 
Option Set Actions. 

2. Click Load under Option Set icons. 

3. In the Manage Option Sets dialog, click the Option Set to select it and load it in the 
Option Clipboard. 

Complete column 

The Complete column indicates if an item is optioned and complete, optioned but needing an update, 
incomplete, or unknown.  It is automatically populated when working on the Worksheet.  
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The four states are: 

 

Item has all the options specified. 

 

Item is missing option information.  Clicking on this icon will open the 
2020 Options dialog. 

 

This icon appears when options have been applied using Option Clipboard, 
Block Assign or Global Options but haven’t been updated against the 
catalog for pricing. Clicking on this icon will bring up the Update Against 
Catalog dialog. 

 

This icon appears when a blank line is added to the worksheet or if the 
item isn't found in the manufacturer's catalog. 

Search for an option line 

1. Click  on the Standard toolbar. 

2. Check Advanced. 

3. Under Item Detail Search Criteria, click Type to select Option. 
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4. Type in the number and/or description you are looking for. 
 

 
5. Click Find Next. 

 
Worksheet puts the cursor on the cell containing the text you entered. 

6. To search for the same text again using the same search direction, press F3. 
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See also: 

 Use Advanced Find to Select Items 

 Find and replace an item 

Discounts and price adjustments 
This section shows you how to: 

 apply various types of discounts to items in the worksheet 

 use price adjustments to change the total price 

 recalculate the Grand Total 

See also Sub-totals 

Discounts 

In this section, you will learn about the various types of discounts, how to apply discounts to a 
worksheet, and how to change columns to view the discount. 

There are various types of discounts in Worksheet. The following are definitions of each discount type. 
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Discount type Definition 

Sell -% The discount percentage off the list price given to the client or end user. 

Sell +% The mark-up percentage to the client or end user based on the dealer’s 
cost. 

Purchase % The dealer discount, a percentage off the list price. 

Margin % The gross profit percentage which is calculated as Margin$ divided by 
Sell$. 

 

Notes:  
 List $ = The manufacturer’s published list price. 

 Purchase $= the dealer’s cost after discounts. 

 Sell $ = The cost to the client or end user. 

 Margin $ = The profit margin in dollars which is the difference between what the end user paid 
(Sell $) and what the dealer paid (Purchase $). 

To apply a discount: 

1. From the Worksheet menu, click Apply Discount. 

2. To save this discount to the current discount schedule, type a discount Description. 

3. Click Sell- %, Sell+ % or Margin % and enter the percentage. 

4. Check the box for the Purchase % and enter the percentage. 
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5. Discount values can be entered as a straight percentage (i.e. 35%) or as a 

breakdown. Click the  button to apply discounts on top of discounts (i.e. 
50/10/5).  
 
Type the first discount in the top box, tab to the next field to enter the compound 
discount. The Discount Breakdown will automatically do the math. 
 

 
Note: If you have a four-tier discount, put the total discount on the first line then 
put the fourth discount on the second line. 

6. You can apply discounts based on Column Heading criteria, for example, Cat equals 
SCA. This will have the discount apply to only lines that have SCA in the Cat column. 
Using the "equals" Operator indicates that the column must meet the exact 
criteria.  You can also change the Operator to "is not equal" or "contains" by clicking 
in the Operator cell. 
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7. Click Apply discount to all items (within all levels). For information about levels see 

Standards and Outline levels. 
 
You can also apply discounts to the current item, or to the selected items. 

8. Check Add discount to the current schedule to save the discount to a schedule. 

9. Click OK. 

Note: To view the discount columns in the worksheet, right-click on any column header then select 
Customize columns. 
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See also: 

 View discounts applied to an item 

 Modify discounts 

 Discount schedules 

Discount schedules 

A Discount Schedule is a group of individual discounts saved in one file. This file can be shared and used 
again and again if you do projects where the same discounts will apply. 

To apply a discount schedule to a worksheet: 

1. From the Worksheet menu, click Apply Schedule. 
 
The Apply Schedule dialog will open. 
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2. Click Add and a blank Add Discount dialog box will open.  Here you can create other 
discounts to add to the current discount schedule. For example, you can add a 
discount for each Cat code in your worksheet. 

3. To apply selected discounts within the schedule to your worksheet, highlight the 
discounts you want to apply. Use the SHIFT or CTRL key. 
 
To apply all the discounts in the schedule to the worksheet, click the first line 
(Discounts in this Schedule). 

4. Under Schedule Application, select whether to apply the schedule to the current 
item, the selected items, or all items. 

5. Click Apply. 

See also: 

 Save discount schedules 

 Apply saved discount schedules 

 Modify or remove a discount from a schedule 

 Print a discount schedule 

Save discount schedules 

If you want to use discount schedules in other worksheets you can save them in your project folder. 

1. In the Apply Schedule dialog, click Save and the Save As dialog box will show the 
Projects folder. 

2. Type the schedule name then click Save. 

Note: If you do not save the schedule, 2020 Worksheet will prompt you to save it when you close the 
worksheet. 
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Apply saved discount schedules 

1. From the Worksheet menu, select Apply Schedule. 

2. Click Load to open the saved schedule. 

3. From the list of discounts in the schedule, select the ones you would like to apply. 
You can use the SHIFT or CTRL key. 
 
To apply all the discounts in the schedule, click the first line (Discounts in this 
Schedule). 
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4. Under Schedule Application, select whether to apply the schedule to the current 
item, the selected items, or all items. 

5. Click Apply. 

Notes: If your discounts overlap, apply the more general discount first, then go back to Apply Schedule 
and select the more specific discount. If there are discounts you commonly use, create a discount 
schedule with all the standard product lines you use and name it Standard.dsc. 

Modify or remove a discount from a schedule 

1. From the Worksheet menu, choose Apply Schedule. 

2. In the Apply Schedule dialog, if you have an existing discount, select the discount 
folder and click Modify. This will display the Modify Discount dialog box if you need 
to make changes. 
 
To remove a discount, select the discount folder and click Remove. A confirmation 
message will appear.  Click Yes. 
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3. If you want to apply the modified discount within the schedule to your worksheet, 

highlight the discount then click Apply. 

Print a discount schedule 

Use the Print command in the Apply Schedule dialog to open a text file containing all the discounts in 
your schedule.  This is a handy way to view all discounts, their percentages and criteria. You can then 
print this text file. 
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To print a discount schedule: 

1. From the Worksheet menu, choose Apply Schedule. 

2. In the Apply Schedule dialog, select the discount folder and click Print. This will 
open a text file with all the discount information. 

Modify discounts 

There are many ways you can modify discounts in a worksheet. 

If you saved the discount in a schedule, see Modify or remove a discount from a schedule. 

If you did not save the discount in a schedule: 

1. Right-click on the item and select Properties. 

2. Click on the Discounts tab. 
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3. To edit discounts, click Edit All.  Modify the discounts then click OK. 
 
To remove all discounts, click Remove All. When a confirmation message appears, 
click Yes. 

4. Click Close. 

View discounts applied to an item 

To view discounts applied to one item: 

1. Right-click on the item and select Properties. 

2. In the Item Properties dialog, click on the Discounts tab. 

3. Click Close. 

See Item properties for more information about the Item Properties dialog. 

See also: 

 Modify discounts 

 Discount schedules 

Price adjustments 

Price adjustments are bottom-line amounts that affect the grand totals of the worksheet. 

There are three different types of price adjustments: 

 fixed amount -  for example, a design fee or a handling charge 

 percentage - for example, a sales tax or bottom line discount 

 advanced - for scaled adjustments.  For example, you may want orders of less than $50,000 to 
receive a 2% reduction and orders above 50,000 to receive a 3% reduction. 
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To insert a price adjustment, from the Item toolbar, click  and select Price Adjustment. 

See also: 

 Modify or move adjustments 

 Delete an item 

 Show or hide rows 

Fixed amount 

Use the Fixed Amount Adjustment type for fixed amount charges or reductions, such as a design fee or 
handling charge. 

1. In the Select Adjustment Type screen of the Adjustment Properties Wizard, type the 
name in the Description field. 
 
This description will appear under the Part Description column. 

2. If you want information to appear under the Mfg, Cat and Part # columns, type the 
text in the appropriate boxes. 
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3. Leave the Adjustment Type as Fixed Amount. 
 

 
4. Check Include preceding adjustments... if you want adjustments that appear before 

this one to be factored in its calculation. 

5. Check Allow succeeding adjustments... if you want to allow adjustments that follow 
this one to use it in their calculations. For example, check this for a handling charge 
that must be taxed. 

6. Check Include in SIF output as a line item if you want this adjustment to appear as 
a line item in a SIF output. 

7. Check Add to worksheet template if you want to add this price adjustment in a 
worksheet template. 
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8. Click Next. 

9. In the Fixed Amount Adjustment Details screen, select Charge if you want to add 
this amount to the grand total. Select Credit if you want to subtract this amount 
from the grand total. 
 

 
10. Enter an amount in the Amount field. 

11. You can also discount this adjustment if necessary by typing in values under 
Adjustment Discount. 
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12. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 

Note: To see a fixed amount adjustment example, see Example - create a design fee. 

Example - create a design fee 

1. In the Select Adjustment Type screen, type Design Fee in the Description field. 

2. Leave the Adjustment Type as Fixed Amount. 

3. Clear Include preceding adjustments... 

4. Leave Allow succeeding adjustments... checked since you want to allow 
adjustments that follow this one to use it in their calculations. 

5. Click Next. 

6. In the Fixed Amount Adjustment Details screen, select Charge to add this amount 
to the grand total. 

7. Enter 200 in the Amount field. 

8. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 
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Percentage amount 

Use the Percentage amount adjustment type for charges such as taxes or credits such as bottom-line 
discounts. 

1. In the Select Adjustment Type screen of the Adjustment Properties Wizard, type 
the name in the Description field. 
 
This description will appear under the Part Description column. 

2. Under Adjustment Type select Percent. 

3. If you want information to appear in the Mfg, Cat and Part # columns, type the text 
in the appropriate boxes. 

4. Check Include preceding adjustments... if you want adjustments that appear before 
this one to be factored in its calculation. 
 
For example, if a handling charge appears before this price adjustment, check this 
option to apply a tax to the charge. 
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5. Check Allow succeeding adjustments... if you want to allow adjustments that follow 
this one to use it in their calculations. 
 
In most cases, if this is a tax type adjustment you would clear this box. 

6. Check Include in SIF output as a line item if you want this adjustment to appear as 
a line item in a SIF output. 

7. Check Add to worksheet template if you want to add this price adjustment in a 
worksheet template. 

8. Click Next. 

9. In the Percent Adjustment Details screen, select Charge if you want to add this 
amount. Select Credit if you want to subtract this amount. 
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10. Enter the Adjustment Percentage. 

11. Beside Calculate off Column, select the column you want to use to calculate the 
adjustment percentage. 
 
For example, if Adjustment Percentage = 10% and you selected Ext. Sell, which has 
a value of $5,000, the adjustment amount would be .10 X 5,000 = 500. 
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12. Select the column(s) where you want to add or subtract the adjustment - List, 
Purchase and/or Sell. 

13. Click Next. 

14. In the Price Adjustment Criteria screen, you can use criteria to filter which item's 
values are used to find the ending percentage. 
 
For example, your percentage adjustment could only consider items from a specific 
catalog. In that case you would check the Cat column, select the equals operator 
then type in the catalog code in Value. 
 
If you do not wish to use any criteria simply leave this screen blank. 

15. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 

Note: To see percentage amount adjustment examples, see Example - add a tax and Example - price 
reduction for parts from a specific catalog. 

Example - add a tax 

Before doing this exercise, do Example - create a design fee. 

1. In the Select Adjustment Type screen, type Sales Tax in the Description field. 

2. Under Adjustment Type select Percent. 

3. Check Include preceding adjustments... so that the adjustment you created 
previously will be included in this adjustment's calculation. 

4. Clear Allow succeeding adjustments... since you do not want subsequent 
adjustments to include this tax in their calculations. 

5. Click Next. 
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6. In the Percent Adjustment Details screen, select Charge. 

7. Enter 7 in the Adjustment Percentage. 

8. Beside Calculate off Column, select Ext. Sell. 

9. Under Add or Subtract Adjustment's Value to these Columns check Sell. 

10. Click Next. 

11. In the Price Adjustment Criteria screen, simply leave this screen blank. 

12. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 
 
If you did the Example - create a design fee, you will notice that the tax you just 
created is applied to the design fee. 
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Example - price reduction for parts from a specific catalog 

1. In the Select Adjustment Type screen, type Price Reduction in the Description 
field. 

2. Under Adjustment Type select Percent. 

3. In the Part # column, type Promotion. 

4. Clear Include preceding adjustments... 

5. Clear Allow succeeding adjustments... 

6. Click Next. 

7. In the Percent Adjustment Details screen, select Credit. 

8. Enter 5 in Adjustment Percentage. 

9. Beside Calculate off Column, select Ext. Sell. 

10. Under Add or Subtract Adjustment's Value to these Columns check Sell. 

11. Click Next. 

12. In the Price Adjustment Criteria screen,  check the Cat column, select the equals 
operator then type in a catalog code (make sure that there are items from this 
catalog in your worksheet) in Value. 

13. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 
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Note: Although you can use the Apply Discount dialog to achieve the same result, creating a Price 
Adjustment will call special attention to this discount since a line is added to the worksheet. 

Advanced adjustment 

Use this adjustment type for scaled adjustments.  For example, you may want orders of less than 
$50,000 to receive a 2% reduction and orders above 50,000 to receive a 3% reduction. 

1. In the Select Adjustment Type screen of the Adjustment Properties Wizard, type 
the name in the Description field  (for example, Large Order Discount). 
 
This description will appear under the Part Description column. 

2. Under Adjustment Type select Advanced. 

3. If you want information to appear in the Mfg, Cat and Part # columns, type the text 
in the appropriate boxes. 

4. Check Include preceding adjustments... if you want adjustments that appear before 
this one to be factored in its calculation. 

5. Check Allow succeeding adjustments... if you want to allow adjustments that follow 
this one to use it in their calculations. 
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6. Check Include in SIF output as a line item if you want this adjustment to appear as 
a line item in a SIF output. 

7. Check Add to worksheet template if you want to add this price adjustment in a 
worksheet template. 

8. Click Next. 

9. In the Advanced Adjustment Details screen, select Charge if you want to add this 
amount. Select Credit if you want to subtract this amount. 

10. Under Adjustment Conditions, specify pricing criteria to use to determine which 
adjustment should be applied. You can specify up to 5 criteria. 
 
Important - conditions are evaluated from top to bottom. The first condition that 
matches will determine the calculation used. 
 
Note: Read each condition as: When Total _ Is _ Amount, Use _. 
 
In the example below, a flat fee of $150 will be charged if the Ext. Weight is less 
than 5,000. If the Ext. Weight is greater than or equal 5,000 pounds, a charge of 5 
cents per pound will be applied. 
 

 
 
You could read the above conditions as: When Total Ext. Weight Is < 5000, Use 
$150.00. When Total Ext. Weight Is < Max, Use $0.05 X Ext. Weight. 

11. Select the column where you want to add or subtract the percent adjustment - List, 
Purchase or Sell. 
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12. Click Next. 

13. In the Price Adjustment Criteria screen, you can use criteria to filter which item's 
values are used to find the ending percentage. 
 
For example, your adjustment could only consider items from a specific catalog. In 
that case you would check the Cat column, select the equals operator then type in 
the catalog code in Value. 
 
If you do not wish to use any criteria simply leave this screen blank. 

14. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 

Note: To see advanced adjustment examples, see Example - discount for large orders and Example - 
shipping charge based on weight. 

Example - discount for large orders 

In this example, you will define the following discounts: 

2% for orders >= 50,000 and < 100,000 

3% for orders >= 100,000 and < 250,000 

4% for orders >= 250,000 

1. In the Select Adjustment Type screen, type Large Order Discount. 

2. Under Adjustment Type select Advanced. 

3. Clear Include preceding adjustments... 

4. Clear Allow succeeding adjustments... 

5. Click Next. 
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6. In the Advanced Adjustment Details screen, select Credit. 

7. Under Adjustment Conditions, select the following information: 
 

 
 
The order of conditions is important as they are evaluated from top to bottom. The 
first condition that matches will determine the calculation used. 

8. Under Add or Subtract Adjustment's Value to these Columns check Sell. 

9. Click Next. 

10. In the Price Adjustment Criteria screen, simply leave this screen blank. 

11. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 
 
In the example below, the order was greater than 100,000 so a discount of 3% was 
applied. 



275 

 

 

Example - shipping charge based on weight 

In this example, you will add a shipping charge to the worksheet. You will charge a flat fee of $150 if the 
Ext. Weight is less than 5,000 pounds. If the order is greater than or equal 5,000 pounds, you will charge 
5 cents per pound. 

1. In the Select Adjustment Type screen, type Shipping Charge. 

2. Under Adjustment Type select Advanced. 

3. Clear Include preceding adjustments... 

4. Clear Allow succeeding adjustments... 

5. Click Next. 

6. In the Advanced Adjustment Details screen, select Charge. 

7. Under Adjustment Conditions, on the first line enter the following: 
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8. On the second line, enter the following information: 
 

 
9. Under Add or Subtract Adjustment's Value to these Columns check Sell. 

10. Click Next. 

11. In the Price Adjustment Criteria screen, simply leave this screen blank. 

12. Click Finish. 
 
At the bottom of your worksheet, you will see a new green line with the price 
adjustment. 
 
In the image below, the Ext. Weight exceeded 5,000 pounds, meeting the second 
condition, so the shipping charge equals $0.05 X Ext. Weight. 
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Modify or move adjustments 

You can modify adjustments two ways: from the Worksheet Properties dialog, and directly from the 
worksheet. 

From the Worksheet Properties dialog box: 

1. Click the Adjustments tab. 

2. In this tab, you can: 
 
- Click Add to create a new fixed or percent adjustment. 
- Select a price adjustment then click Remove to delete it. 
- Click Remove All to delete all price adjustments. 
- Select an adjustment then click Edit to modify it. 
- Use the arrows to change the order in which an adjustment takes effect and its 
order of appearance in this window. 
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3. Click OK or Apply. 
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From the worksheet: 

1. Right-click on any adjustment to edit it directly from the worksheet. 

2. In the pop-up menu you can: 

 Select Insert Adjustment to create a new fixed or percent adjustment 

 Select Delete Adjustment 

 Select Properties to edit the adjustment 

 Click Move Up or Move Down to change the order in which an Adjustment takes effect and its 
order of appearance in the worksheet. 
 

 
Note: You can edit an adjustment by clicking on the line. 
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Recalculate the Grand Total 

If you delete a price adjustment from the Worksheet Properties dialog, the Grand Total values might not 
immediately reflect the removed amount. 

Use the Recalculate command from the Worksheet menu to recalculate the Grand Total amounts. 

Subtotals 
Subtotals are added to the worksheet as another line similar to the Total line.  The items continue to be 
numbered normally above and below them. 

See: 

 Insert subtotal through MultiSort 

 Insert subtotal manually 

 Insert subtotal by a selection set 

 Remove subtotals 

Insert subtotal through MultiSort 

The easiest way to insert subtotals is through MultiSort. 

1. Click  on the Worksheet toolbar. 

2. Notice that the first checked column is in bold font.  This is the primary sort column 
that will be used to insert subtotals. 
 
If you want to change the primary sort column, use the Top, Move Up, Move Down 
and Bottom buttons. 
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3. Check Insert subtotals after each unique value of the primary sort field. 

4. Click OK. 
 
This will add subtotals lines of the primary sort column to your worksheet. 
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See also: 

 Insert subtotal manually 

 Insert subtotal by a selection set 

 Remove subtotals 
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Insert subtotal manually 

To insert a price adjustment, click   on the Item toolbar then select Subtotal, Single. 

The subtotal will do the sum of all the items above it to the top of the worksheet or to the previous 
subtotal. 
 

 
You can move the subtotal line up or down in the worksheet and it will total the items above it.  
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Move it using the move  buttons. Notice the subtotal will automatically update as you move 
the lines. 

See also: 

 Insert subtotal through MultiSort 

 Insert subtotal by a selection set 

 Remove subtotals 

Insert subtotal by a selection set 

Another way to add a subtotal to the worksheet is to select a range of items. 

From the Item toolbar, click  and select Subtotal, By Selection. 

If there are unselected items before the first selected item, the selected items will be moved up in the 
worksheet to follow the first subtotal appearing before the first selected items, or the top of the 
worksheet if there are no subtotals above the first selected item.  

If the selection set was not contiguous, the unselected items will be moved below the inserted subtotal. 

See also: 

 Insert subtotal through MultiSort 

 Insert subtotal manually 

 Remove subtotals 
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Remove subtotals 

To remove one or many subtotals: 

1. Select the subtotal or make it current. 
 
If there is both a current item and a selected item in the worksheet, the selected 
item will be deleted. 

2. Right-click and select Delete, Current Item (or Selected Item). 

3. Click Yes when you see a confirmation message. 

To remove all subtotals, from the Item menu select Delete, All Subtotals. 

To hide subtotals but not remove them, see Show or hide rows. 

Custom catalogs 
Custom catalogs are a powerful way to capture, store, and reuse tools that you create in Worksheet and 
CAP Designer. 

 A Custom Catalog is a separate file that captures, manages, and allows the user to reuse products. 

 This Custom Catalog file (.cc4) can be used and accessed by other people in a company by placing 
the custom catalog on a network. 

 They are flexible and powerful because you, the user, can define them. 

 You can place items into your Custom Catalog through both Worksheet and CAP Designer. 

 A Custom Catalog is different from a Manufacturer’s Catalog in that you can add and edit items, 
descriptions and pricing into your Custom Catalog. 
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See also: 

 Custom catalogs vs. manufacturer catalogs 

 Add items to a custom catalog 

 Create a custom catalog 

 Manage custom catalogs 

 Modify an item in a custom catalog 

 Reuse and update items from a custom catalog 

 Break custom catalog link 

Note:  When you place an item in a custom catalog, you are responsible for updating its price.  If you 
want to use the current pricing from the manufacturer's catalog, you will need to update against a 
manufacturer catalog 

Custom catalogs vs. manufacturer catalogs 

Standard manufacturer catalogs appear in the Explorer's Content Tab. 

Custom catalogs appear in the Projects tab. 

As with standard catalogs, you drill down to the custom catalog. The difference is that you can add 
items into your custom catalogs. Example: If you have saved a CAP Standard into your custom catalog, 
you will see the following appear in the Projects tab: 

 The custom catalog icon  

 A custom catalog CAP Standard icon  

 An individual product within that CAP Standard  

 You can also place a specific part from that Standard into a worksheet 
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Add items to a custom catalog 

You can add different types of items to your custom catalog: 

 Individual Products 

 Standards 

 Specials (Individual Products or Custom Items) 

You can add items to your custom catalog from: 

 a worksheet 

 the Content tab 

 Specify 

 a Search window 

Add items into a custom catalog from a worksheet 

1. Select one or several items or make a line item current in the worksheet. 

2. Click   on the Item toolbar and select Custom Catalog Wizard. 

3. In the Send to Custom Catalog Wizard, select a custom catalog (ending with 
.cc4).  To create a new custom catalog, see Create a custom catalog. 

4. Click Next. 

5. In the next screen, you can choose to: 
 
Add in a custom catalog as a product 
or 
Add in a custom catalog as a Standard 
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Note: If you made a mistake and want to delete a custom catalog, select it then press Delete. For more 
information about managing custom catalogs, click here. 

Add items into a custom catalog from the Content tab 

1. In the Content tab of the Explorer pane, navigate to a specific product. 

2. Right-click on a part number. 

3. Select Send To, Custom Catalog Wizard. 

4. In the Send to Custom Catalog Wizard, select a custom catalog (ending with 
.cc4).  To create a new custom catalog, see Create a custom catalog. 

5. Click Next. 

6. See: Add in a custom catalog as a product. 

Note: Sending an item into your custom catalog this way will send the item without any options added. 

Add items into a custom catalog from Specify 

1. From the 2020 Options dialog, select options for the item. 

2. Click Send To, Custom Catalog Wizard. 

3. In the Send to Custom Catalog Wizard, select a custom catalog (ending with 
.cc4).  To create a new custom catalog, see Create a custom catalog. 

4. Click Next. 

5. See Add in a custom catalog as a product. 
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Add items into a custom catalog from Search 

1. Do a Search by part number or by part description. 

2. After the search is complete, click Send To then Custom Catalog Wizard. 

3. In the Send to Custom Catalog Wizard, select a custom catalog (ending with 
.cc4).  To create a new custom catalog, see Create a custom catalog. 

4. Click Next. 

5. See Add in a custom catalog as a product. 

Add in a custom catalog as a product 

First, access the Custom Catalog Wizard from a worksheet, the Content tab, 2020 Options, or Search 
and then select a location within the custom catalog to store the item. 
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1. Select Store in the custom catalog as a Product. 
 

 
2. Click Next. 

3. In the Product Properties dialog box make any necessary changes to the 
information being displayed. You can put a special price. Make sure the Quantity is 
set to 1. 



291 

 

 
4. Click Finish. 

5. Go to the Projects tab in Explorer and click   to display the custom catalog you 
created as well as the product you just added to that custom catalog. 

6. To add this product to a worksheet, see Reuse an individual part from a custom 
catalog. 

See also: 

 Add in a custom catalog as a Standard 

Add in a custom catalog as a Standard 

You may want to select several items in your worksheet and add those items as a Standard into your 
custom catalog. By adding these items as a Standard they will appear within one group. 

You must first select several items, access the Custom Catalog Wizard from a worksheet and then 
choose a location in the custom catalog. 
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1. When you are in the Saving Your Work screen you can only select Store in the 
custom catalog as a Standard because you have selected multiple items. 

2. Click Next. 

3. Enter a name and a description for the Standard. 
 

 
4. Leave Consolidate the parts in this Standard checked so that identical parts in the 

standard will be consolidated. 

5. If necessary, assign Alias values to all the components of the Standard. 

6. Click Finish. 

7. Go to the Projects tab in Explorer and click  to display the Standard in the custom 
catalog. 
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8. To add this Standard to a worksheet, see Reuse a Standard from a custom catalog. 

 
To add an individual part from this Standard to a worksheet, see Reuse an individual 
part within a Standard from a custom catalog 
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Create a custom catalog 

1. In the Custom Catalog Wizard, right-click on Local Projects, select New, then 
Custom Catalog. 
 
Or click the New button. 
 

 
2. A New Custom Catalog.cc4 appears. Highlight the New Custom Catalog.cc4 and 

rename it. 
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Note: If you want to delete a custom catalog, click on it then press Delete. 

Manage custom catalogs 

To manage custom catalogs (remove, rename, etc.), right-click on a custom catalog in the Projects tab 
of the Explorer pane. 

Then, select the option corresponding to the modification you need to make. 
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Modify an item in a custom catalog 

The Projects tab in Explorer gives you the ability to modify items that are within a custom catalog. You 
can: 

 delete an item within the custom catalog 

 update against a current manufacturer’s catalog 

 specify options on a part within a custom catalog 

Delete an item from a custom catalog 

1. In the Projects tab of Explorer, expand the custom catalog. 

2. Select the part then Press Delete. 

3. Click Yes when a confirmation message appears. 

Update an item against a manufacturer catalog 

When a product is in the Custom Catalog, the price will not automatically update when a new price list 
is released on the Worksheet Monthly Update. You can use this to your advantage for clients that are 
on old pricing or have special prices for items.  For example, if they don't pay upcharges for certain 
items you can change the price on those products. 

If you want to have the prices use the current pricing from the Manufacturer Catalog, you need to 
update your Custom Catalog when a new price list is released. You can update the entire catalog or just 
individual items in it.  

1. In the Projects tab of Explorer, highlight the catalog or part you want to update. 

2. Right-click and select Update. 
 
This will launch the Update Against Catalog Wizard. 
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Add options to an item in a custom catalog 

1. In the Projects tab of Explorer, highlight the part you want to add options to. 
 
If the part is within a Standard you will need to expand the Standard to view the 
part. 

2. Right-click and select Specify. 

3. Select options for the item and then click OK. 

4. Go back to the Projects tab and click Refresh to display the options you added to 
the item in your custom catalog. 
 
Notice that the options you specified appear listed under that product. 
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Reuse and update items from a custom catalog 

Custom catalogs give you the ability to reuse items in worksheets and drawings. 

You can reuse: 

 Individual products 

 Standards 

 Individual products pulled from within a Standard 

Depending on which option you chose above, updating an item against a catalog either updates against 
the custom catalog or the manufacturer's catalog.  See What happens when you update custom catalog 
items. 

Reuse an individual part from a custom catalog 

1. In the Projects tab of Explorer, highlight the part you want to reuse in your custom 
catalog. 

2. Drag and drop it into the worksheet on the right side of the screen. 
 
The part will appear in the worksheet as a line item. The item appears in yellow in 
the worksheet. This represents a individual item from a custom catalog. 
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When you do an Update Against Catalog on this item, it will update against the custom catalog. 

Because this item is linked to the custom catalog, when changes occur in the custom catalog they will be 
reflected in the worksheet. 

Note:  You can reuse any item in a custom catalog, regardless of whether it was created in Worksheet or 
in CAP Designer. 

  



300 

Reuse a Standard from a custom catalog 

1. In the Projects tab of Explorer, highlight the Standard you want to reuse from your 
custom catalog. 

2. Drag and drop it into the worksheet on the right side of the screen. 
 
Notice the pink color that represents a Standard line item in a worksheet.  
 

 
 
If you step into the Standard, the products within a Standard appear in yellow in the 
worksheet. 

  



301 

The Standard is linked to the custom catalog (as indicated by the yellow lines). When you do an update 
against a catalog in the worksheet, the Standard will be updated against the custom catalog. 
 
If changes are made to the Standard in the custom catalog, such as adding options or changing prices, 
the Standard in the worksheet will reflect that change the next time an Update Against Catalog is 
performed in the worksheet. 

To better understand this, do the exercise below: 

1. Go to the Projects Tab in Explorer and add or change the options to one line of your 
Standard. 

2. Click on the Standard line and do an Update against Catalog in the worksheet. 
 
You should see that the Standard price has changed and the options have been 
added to that line in the Standard. 

Reuse an individual part within a Standard from a custom 
catalog 

1. In the Projects tab of Explorer, expand the Standard, and highlight the individual 
part you want to reuse in your custom catalog. 

2. Drag and drop it into the worksheet on the right side of the screen. 

3. The Individual Part from the Standard will appear in the worksheet as a line item. 
Notice the color that represents an individual part in the worksheet. 
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Note:   The individual part taken from a Standard will update against the manufacturer catalog when 
you perform an Update Against a Catalog. 
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What happens when you update custom catalog items 

Here's a summary of what will happen when you reuse individual products, standards, or individual 
products from standards in a worksheet then do an update against catalog: 

Individual Products Update against → Custom Catalog 

Standards Update against → Custom Catalog 

Individual Products 
pulled from a 
Standard 

Update against → Manufacturer 
Catalog 

Break custom catalog links 

If you do not want the individual products or Standards to update against the custom catalog they came 
from but rather against the current manufacturer catalog, you can break the link. 

See: 

 Break a link on an individual product 

 Break a link on a Standard 

Break a link on an individual product 

1. Make the custom individual product line item current or select the items to unlink. 

2. From the Edit menu and select Break Custom Catalog Link. 

3. Click Yes on the confirmation message. 
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Notice that the product now appears as a normal product line, that is, the color has 
changed to white. 

Note:   If you were now to update against a catalog, this item would update against the current 
manufacturer catalog and not the custom catalog from which it came. 

Break a Link on a Standard 

There are two ways to break a Standard link: 

 flatten all the components into the worksheet as individual line items 

 break the link to the custom catalog and convert the Standard to an Outline level. 

The advantage of the Outline method is that you can update against the manufacturer's catalog, but still 
have a line representing the whole Standard. 

 See also Save as single level worksheet - to create a new worksheet with individual line items 

Flatten a Standard 

1. Make the Standard line item current. 

2. From the Edit menu, select Flatten Standard or Outline Level. 

3. Click Yes when you see a confirmation message. 

Now all the components from the Standard are individual items in the worksheet. Similar items will not 
be combined. Use Consolidate to combine them. 

Break a Standard Link 

If you would rather the items be in a separate folder but still be able to update against the catalog you 
can also use Break Catalog Link. 

1. Make the Standard line current. 

2. From the Edit menu and select Break Custom Catalog Link. 
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3. Click Yes when you see a confirmation message. 
 
Notice that the Standard now appears as a green outline level. 
 

 
If you step into this Outline level, you would see that the items within the Standard now appear as 
normal product lines and have been multiplied by the number of Standards that were originally 
there.  Notice that the header is the same green, indicating that you have stepped into an Outline level. 
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If you were now to update against a catalog, all of the products in this Outline level would update 
against the current manufacturer catalog and not the Custom Catalog from which they came. 

You can later Flatten the Outline level from the Edit menu. 
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Standards 
Standards are groups of products that usually represent a workstation.  You can create a Standard from 
the worksheet or from a CAP Designer drawing. See Add items to a custom catalog for information on 
creating Standards from a worksheet. See the Create a CAP Standard section in the CAP Designer help 
file for more information on creating Standards from a drawing. 

Once you have created a Standard you can reuse it by dragging it into a worksheet.See Reuse a 
Standard from a custom catalog for details. 

This section describes how to modify and use Standards. 

See also: 

 View the contents of a Standard 

 Step out of a Standard 

 Redefine a Standard 

 Save as single level worksheet 

 Print multiple levels 

 Show levels in Explorer 

 Break a link on a Standard 

 Outline levels 

 Delete an item 
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View the contents of a standard 

Viewing the contents of the Standard is also called Stepping into a Level. 

To view what is in a Standard you can: 

 Click the Level drop-down on the header then select Step In. 
 

 
 Use the Name fly out.  You can also jump from one Standard to another from here. 
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When you step into a Standard, notice that the lines are yellow, because the parts come from a Custom 
Catalog.  Also notice the title has changed to the name of the Standard in the header (Level bar). 
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Step out of a Standard 

The most common ways of stepping out of a Standard are: 

 Click the Level drop-down on the header then select Step Out. 
 

 
 Use the Name fly out.  You can also jump from one Standard to another from here. 

 

 

  



311 

Redefine a Standard 

When a Standard is in a custom catalog it can be edited from Explorer, Worksheet or in CAP Designer. 

Example of redefining a Standard in the worksheet: 

1. Add options to the Standard in the worksheet. 

2. Select all the items in the Standard. 

3. Click   on the Item toolbar and select Custom Catalog Wizard. 

4. In the Send to Custom Catalog Wizard, select the Standard that you wish to 
redefine. 
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5. Click Next. 

6. Click Next on the Saving Your Work dialog. 

7. Type in the exact same name as the Standard you are replacing. 

8. Type in a description. 

9. Check Replace the contents of the existing Standard. 
 

 
10. If necessary, assign an Alias to all the components of the Standard. 

11. Click Finish. 
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12. Go to the Projects tab in Explorer and click . 
 
Notice that the Standard will now have the options in it. 

To redefine a standard from the Explorer bar: 

1. Go to the Projects Tab in Explorer and add or change the options to one line 
of your Standard. 

2. Click on the Standard line and do an Update against Catalog in the worksheet. 
 
You should see that the Standard price has changed and the options have been 
added to that line in the Standard. 

Save as single level worksheet 

When you are ready to order items that are in your worksheet, they must be listed as individual items, 
with no outline or standard levels. 

To create a new worksheet with items from standards/outline levels listed individually: 

1. From the File menu, select Save As Single Level Worksheet. 

2. In the Save in field, choose the disk/folder where you want to save the worksheet. 
 
In the File name field, type in the name of the file and press ENTER. 
 
Note:  Type in a meaningful name so you can easily link this worksheet to the 
original one.  For example, if the original worksheet is named Client1, name the 
single-level worksheet Client1_order. 
 
Notice that the new worksheet has items listed individually, with each line no 
longer in yellow. 
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This way, you still have the original worksheet with the Standard lines in it. If you ever make changes to 
the Standard, you just need to Save As Single Level Worksheet again to create a new worksheet with 
items listed individually. 

  

Note:   Saving as a single level worksheet is different from flattening a standard or breaking a standard 
link, which breaks the link to the custom catalog. 

Print multiple levels 

A quick way to print all the levels (Standards or Outline) in a worksheet is to use the Print Levels tool. 
Before you print you will need to set the default printer using the Print Setup dialog. 

1. From the menu select File, Print Levels. 

2. In the Print Levels dialog box, select which worksheets you wish to print.  For each 
line checked you will have one printout. 

3. Check whether you also want to print the cover page and/or the report. 

4. Click Print. 

 Note:  The title on each sheet will be the name of the Standard or the Outline level. 
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Show levels in Explorer 

Click the Level dropdown on the header then select Show Levels In Explorer. 

 
The Explorer bar's Projects tab highlights the level you are currently in (whether you are in the 
worksheet or Standard level). 

Outline levels 
Outline levels allow you to better organize your worksheet. For example, you would use an outline level 
for a floor, building or room name.  Within each outline level you would have your parts and standards. 
When you print the worksheet, you can show only the outline levels to be able to quickly look at pricing 
per level. 

You can create outline levels from the worksheet or from a CAP Designer drawing. In CAP Designer, you 
would create CAP bounds and this will be represented in 2020 Worksheet as an outline level.  See the 
Bounds section in the CAP Designer online help for details. 

To create an outline level in 2020 Worksheet: 

1. Click  on the Item toolbar then select Outline level. 
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2. A green line is inserted in your worksheet, representing an outline level. 
 

 
3. Click in the Part Number column to change the outline level name, if necessary. 

You can use the same commands available to Standards for Outline levels.  See the following topics 
under the Standards section: 

 View the contents of a Standard - to step into an outline level to view and modify its contents. 

 Step out of a Standard 

 Save as single level worksheet 

 Print multiple levels 

 Show levels in Explorer 

To delete an outline level, see Delete an item. 

Note:   You can also create an outline level by breaking a standard link. 
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Panel configurations 
Panel configurations are usually created and modified in CAP Designer so that they are updated 
automatically in the design. However, Worksheet also gives you the option to create and modify panel 
configurations. 

You can either: 

 Use the Custom Catalog Wizard to create a panel configuration and then insert it into the 
worksheet 

 Create and insert a panel configuration without the Wizard 

Use the Custom Catalog Wizard to insert a panel 

1. Click  on the Item toolbar then select Panel Configuration from a 
Custom Catalog. 

2. In the Custom Catalog Wizard, click Panel Builder to create a new panel 
configuration. 

3. Create your panel configuration(s) in Panel Builder. For more information, see the 
Panel Builder help. Close Panel Builder when done. 

4. Back in the Custom Catalog Wizard, click Refresh to update the custom catalog list. 

5. Open the custom catalog where you saved the panel configuration, select the 
appropriate panel configuration width then click Finish to insert the item into the 
worksheet. 
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See also: 

 Modify a panel configuration 

 Specify options for a panel configuration 

Create a panel configuration without the Wizard 

1. From the Tools menu, select Panel Builder. 

2. Create one or more panel configurations in Panel Builder.  For more information, 
see the Panel Builder help file. Close Panel Builder when done. 

3. Right-click on the custom catalog where you just added the panel configurations 
then select Refresh. 
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4. After creating the panel configuration, select a particular width then drag it to the 

worksheet. 
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See also: 

 Modify a panel configuration 

 Specify options for a panel configuration 

Modify a panel configuration 

Important:  A panel configuration is like a standard, with one exception: a panel configuration already 
inserted in a worksheet is NOT linked to its custom catalog.   

If you make changes to the panel configuration in the custom catalog, the panel configurations already 
in the worksheet do not change even if you do an Update against catalog. You will need to delete the 
existing panel configuration in the worksheet and drag the panel configuration again from the custom 
catalog to the worksheet. 
 
It is therefore recommended to specify options for the panel configuration only after the panel 
configuration has been finalized. 

1. Right-click on the panel configuration then select Specify. Panel Builder opens so 
you can make your changes. 
 
Note that even if you right-click on a particular width, all panel configuration widths 
get modified, not just that specific width. 
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2. Make the changes in Panel Builder, save and close Panel Builder. 

3. Right-click on the custom catalog (.cc4 extension) then select Refresh. 

4. If you had previously inserted that panel configuration into the worksheet, you will 
need to delete that panel configuration in the worksheet then drag and drop from 
the Custom Catalog. 
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Specify options for a panel configuration 

A panel configuration is represented on the worksheet as a standard.  However, unlike a standard, a 
panel configuration already inserted in a worksheet is NOT linked to its custom catalog.  It is therefore 
recommended to specify options for the panel configuration only if the panel configuration no longer 
needs to be modified. 

1. From the worksheet, step into the standard. 
 

 
2. Do an Update Against Catalog. 

Notice that in the Complete column, the Question mark is replaced by the   
icon. 

3. Specify each item one by one or use Global Options. 

Note:   If you want to display the image in the Preview column, you must do an Update Preview image. 
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Validate a worksheet 
To ensure that you have entered accurate orders, use the Validate command. This command checks a 
worksheet against a set of validation criteria. After running the verification you can view a list of errors 
encountered. From this list you can flag the erroneous parts or go to the part number in the worksheet. 

1. From the Worksheet menu, select Validate. 
 
The Validate Worksheet dialog appears. You can resize this dialog or go to the 
worksheet while this dialog is open. 
 
The dialog lists part numbers in the worksheet that are not valid. You also see the 
errors on each part number. 
 

 



324 

2. To change the validation criteria, click Criteria. In the Validation Criteria dialog 
check the ones you want verified then click OK. 
 
The information on the Validate Worksheet dialog will be refreshed automatically. 

3. To make corrections, you can either: 
 
- Click on Flag All to flag parts that are not valid. Without closing the dialog, make 
the corrections in the worksheet. Go back to the Validate Worksheet dialog and 
click Refresh to update the information. 
- Click on a part number to make that part number current in the worksheet. 
Without closing the dialog, make the corrections in the worksheet. Go back to the 
Validate Worksheet dialog and click Refresh to update the information. 

4. Click Close to close the dialog. 

Visualize a scene or all products in Visual 
Impression 
If the current worksheet was created from a CAP Designer or Giza Designer drawing, you can open 
Visual Impression to visually specify product and room finishes. 

Click the Visualize menu and Select Scene, and then select a scene from Visual Impression. 
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You can also click a named scene or Entire Design to start Visual Impression. 
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 See also Define a scene for Visual Impression in the CAP Designer help file or the Giza Designer 
help file and the Visual Impression Quick Tour help file. 

Worksheet links 
Worksheet Links are similar to Standards. You can use Worksheet Links to help create a Total Budget 
Recap for a job. You can use them to link to other worksheet files. 

For example, let's say you want to create a budget for a job with several workstations, panels and lateral 
files but do not need a drawing. By creating a worksheet for each group of items you can easily add 
them together using Links. 

See: 

 Insert worksheet links 

 Change worksheet links 

 Save as single level worksheet 

 Delete an item 

Insert worksheet links 

In the exercise below, you will create a proposal worksheet for client ABC's Mortgage Department.  The 
client wants 6 TypA workstations and 4 TypB workstations. You will use worksheet links in the proposal. 

Before starting the exercise, create 2 worksheets: 

1. Name the first worksheet TypA.sp4. Add a Standard in it. 

2. Name the second worksheet TypB.sp4. Add a Standard in it. 
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Exercise - insert worksheet links: 

1. Create a new blank worksheet.  Save the worksheet as ABCProposal.sp4. 

2. Click  on the Item toolbar then select Worksheet Link. 

3. In the Open dialog box, double-click TypA.sp4 to insert it into your ABCProposal 
worksheet. 
 
Line item 1 will now have TypA.sp4 inserted and subtotaled. 

4. Repeat Step 2 to insert another worksheet link. 

5. Double-click TypB.sp4 to insert it into your ABCProposal worksheet. 

Now we can edit the quantity fields of each line: 

1. Click in the Qty column of line item 1 (TypA) and change the quantity to 6. 

2. Click in the Qty column of line item 2 (TypB) and change the quantity to 4. 

Here you have a great way to look at and keep track of the project. Your client can see the individual cost 
of the workstations, the subtotal for the department, and how many of each type of workstation is 
going in the department. 

As long as the individual typical worksheets are correct (have the correct items, brackets, grommets, 
cantilevers, task lights, etc), you know the bottom line is correct. 

 See Change worksheet links to view how making a change to the TypA.sp4 standard also 
changes the file ABCProposal.sp4 
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Change worksheet links 

Before starting this exercise, make sure you did the exercise Insert worksheet links. 

Let's say that the client has seen the sub-totaled proposal, and they would like to make changes to TypA 
by adding a guest chair. 

1. In the worksheet ABCProposal.sp4, make line item 1 current by clicking in the 
part description column for Typical A. 

2. From the File menu, click Worksheet Link, Open. 
 
This will open the original TypA.sp4 worksheet so that you can add a guest chair. 
Using Explorer, search for a chair and drag it into the worksheet. 

3. Save the TypA.sp4 worksheet and close it. 

4. Verify the changes have been made to ABCProposal.sp4 by checking that the 
price has increased. 

Once client ABC is satisfied with the proposal, you can merge all the furniture items onto one worksheet 
and create one order.  To do this, you need to save the file ABCProposal.sp4 as a single level 
worksheet. See Save as single level worksheet for details. 

Contacts 
The 2020 Contacts Manager is a small database that helps you integrate and organize contact 
information such as customers, vendors and staff. 

You can then display this information in your worksheet cover page and reports by selecting the 
appropriate contact through the Worksheet Properties General tab. 

To enter contacts, from the Tools menu, select Contacts. 
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To: Do this: 

Add a new 
contact 

1. Click the Add New button. 

2. Enter the contact information on the right side 
of the screen. 

3. Click OK to save your changes. 

Modify a contact 

1. Highlight the contact on the left side of the 
screen. 

2. Modify the contact information on the right 
side of the screen. 

3. Click OK to save your changes. 

Delete a contact 

1. Highlight the contact on the left side of the 
screen. 

2. Click Remove. 

3. Click OK to save your changes. 
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Set a contact as 
the Prepared by 
contact in 
Worksheet 
Properties. 

1. Highlight the contact on the left side of the 
screen. 

2. Click Set Default. 

3. Click OK to save your changes. 

Import contacts 
from a comma-
separated (.csv) 
file or an XML 
file 

4. Click Import File. 

5. In the Open dialog, select the file to import then 
click Open. 

Export contacts 
to a comma-
separated (.csv) 
file 

6. Click Export File. 

7. In the Save dialog, type in the name of the file 
then click Save. 

 
 See also Edit contact information for the current worksheet only 

Edit contact information for the current worksheet only 

You can edit a contact's information for the current worksheet, so that it is different than what is stored 
in the Contacts database. This feature also allows you to update your Contacts database when you 
receive a worksheet that has newer contact data. 

1. Click  on the Standard toolbar.  

2. In Worksheet Properties, click General on the left. 

3. Click the button beside one of the contact fields. 
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4. In the Edit Worksheet Contact... dialog, modify the contact information under This 
Worksheet's Copy. 
 
If you make a mistake and want to copy the information from the Contacts 
database, click Copy from Database. 
 
If you want to copy the information in the current worksheet to the Contacts 
database, click Save To Database. 

5. Click OK in the Edit Worksheet Contact... dialog. 

6. In the Worksheet Properties dialog, click OK to save and close or Apply to save and 
keep the dialog open. 

Cover Page 
Cover Page helps you create attractive, informative cover pages for several different uses. Here are a 
few examples of possible uses for a cover page: 

 Approval pages — allow an end user to sign off on pricing and information within a specific 
worksheet for an upcoming project. 

 Proposal page — for bid purposes on a job, where a dealer could prepare a page that specifies 
that the information is for estimates only. 

 Fax cover pages —  to send as a fax front page on a worksheet that a user may want to send to a 
client. 

 Interoffice cover — to pass information from one department to another within an office.  This 
could serve as a verification that information has been passed from design to sales and then to 
order entry. 

There are infinite ways to customize a cover page.  A company or dealer could create a cover page and 
have everyone in the company use it. Once it is created it can become the default for a dealership to 
create a consistent look when preparing internal information or presentation for clients. 
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Cover Page includes an editor and WYSIWYG (What You See is What You Get) preview screen. In Cover 
Page you can include: company logos, imported graphics, freehand drawing elements and worksheet 
data that is dynamically updated from a worksheet, such as pricing and customer information from 
Worksheet Properties. 

See: 

 Edit an existing cover page 

 Manage cover page layouts 

 Create a new cover page layout 

 Apply a cover page layout 

 Zoom the cover page 

 Print a cover page 

Edit an existing cover page 

1. Click the Cover Page tab in the Worksheet area. 
 

 
2. Beside Selected CoverPage, select Plain. 
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3. Click the Edit CoverPage Layout icon. 
 

 
 
This launches the 2020 CoverPage Designer for the default cover page titled Plain. 

4. See the 2020 CoverPage Designer online help for information on using this program. 

5. After making changes in 2020 CoverPage Designer, click  on the Cover Page 
toolbar to view your changes. 

Manage cover page layouts 

1. Click the Cover Page tab in the Worksheet area. 
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2. Click the Manage CoverPage Layouts icon on the CoverPage toolbar. 
 

 
3. In the Manage Cover Page Layouts dialog box you can do any of the following: 

To: Do this: 

Create a new cover 
page layout Click New to create a blank cover page layout 

Create a new cover 
page layout based on an 
existing one 

See Create a new cover page layout. 

Edit a cover page layout 
Select the cover page layout then click Edit. The 2020 
CoverPage Designer appears. See the 2020 CoverPage 
Designer help for details. 

Rename a cover page 
layout Select the cover page layout then click Rename. 

Delete a cover page 
layout Select the cover page layout then click Delete. 

Apply a cover page 
layout to the current 
layout 

Select the cover page layout then click Apply. 
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Set a cover page layout 
as default 

Select the cover page layout then click Set Default. 

Notice that the selected layout is now in bold. 

Reset the default cover 
page layout Click Clear Default. 

Create a new cover page layout 

1. Click the Cover Page tab in the Worksheet area. 
 

 
2. Click the Manage CoverPage Layouts icon on the CoverPage toolbar. 

 

 
3. In the Manage Cover Page Layouts dialog box, click New Based on to create a cover 

page layout based on an existing one. 

4. In the Browse for File dialog, click the + sign beside the CoverPages folder to expand 
it. 
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5. Select an existing cover page layout. 
 

 
6. Click OK. 

7. Enter a unique name for the cover page layout then click OK. 

8. Click Close in the Manage Cover Page Layout dialog. 
 
You will now be able to select the new cover page layout by clicking beside Selected 
CoverPage and then selecting it under My Cover Pages. 
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Apply a cover page layout 

To apply a standard or user cover page layout to the current cover page: 

1. From the menu, select Reports, then Apply CoverPage Layout. 

2. Select the standard or user cover page layout from the list. 

Note:  A faster way is to click the arrow beside Selected CoverPage, then select the cover page layout. 
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Zoom the cover page 

1. In the Cover Page tab in the Worksheet area, click the dropdown arrow beside 
Zoom on the Cover Page toolbar. 

2. Select the level you want to zoom. 
 

 

Print a cover page 

You can print a cover page independently or along with product items. 

To print the cover page only: 

While you in the Cover Page tab, click File menu then select Print. 

To print the cover page with product items: 

1. Click the Worksheet tab. 

2. From the File menu, select Print Levels. 

3. In the Print Levels dialog, check Include the Cover Page. 

4. Click Print. 

 See also Print reports 
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Reports 
2020 Worksheet's reporting tool allows you to build completely customized internal or external 
reports.  You can do this by creating your own report or customizing report templates. 

See: 

 View a report 

 Apply a standard or user report design 

 Generate Quick Reports 

 Create, edit and manage reports 

 Report Designer 

 View report pages 

 Export a report to PDF 

 Print reports 

View a report 

Click the Report tab at bottom of the worksheet area. 
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Apply a standard or user report design 

In the Report tab, there are standard report designs (templates) that you may use to create reports. You 
can also select one of the user reports you created. 

1. Click the Report Designs drop down on the Report Toolbar. 
 

 
2. Select one of the standard reports or user reports listed.  The report will 

automatically generate and you will see a preview on the Report tab. 
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Generate Quick Reports 

A Quick Report can be generated based on the columns that are turned on in the Worksheet tab. 

To generate a quick report, click   on the Report Toolbar. 

Note:  Once you have run the Quick Report once, it will be available from the Report Designs drop down 
on the Report Toolbar. 

This quick report can then be customized and renamed. 

See also: 

 View a report 

 Apply a standard or user report design 

 Create, edit and manage reports 

 Report Designer 

 Export a report to PDF 

 Print reports 

Create, edit and manage reports 

The Manage Report Designs dialog allows you to create and modify your own report designs. These 
reports will be stored as user reports. 

1. Click   on the Reports toolbar. 

2. In the Manage Report Design dialog: 

  



342 

To: Do this: 

Create a new 
blank report 

1. Click New. 

2. Enter a name for the report then click OK. 
 
2020 Report Designer launches with the new 
report opened.  See the Report Designer 
help to edit the report. 

Create a new 
report based on 
an existing one 

1. Click New Based On. 

2. The Browse for File dialog opens. 
 
Select the report in the Standard Reports 
directory.  If you would like to browse to the 
User Reports they can be found under:  
My Documents\CAP\UserReports. 

3. Enter a name for the report then click OK. 
 
2020 Report Designer launches with the new 
report opened.  See the Report Designer 
help to edit the report. 

Edit a report 
Select the report then click Edit. 

2020 Report Designer launches with the new report opened.  See the 
Report Designer help to edit the report. 

Rename a report Select the report then click Rename. 

Delete a report Select the report then click Delete. 



343 

Apply a report 
design to the 
current one. 

Select the report then click Apply. 

Set a report as 
default 

Select the report then click Set Default. 

Notice that the selected report is now in bold. 

Reset the default 
report Click Clear Default. 

Create a Panel Builder Report 

To generate a report on panel configurations showing Panel Builder elevations and finishes, click 
Reports, Panel Builder Reports... 
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This dialog box allows you to: 

 Select one or all Panel Builder configurations. 

 Insert graphics and finish text on the report or insert graphics with details of options. 
 

 
 Obtain more information on reports such as catalog and manufacturer information, effective 
date of the catalog, project name and long part number description and user-defined logos 
(Include Header Image). 

Choose the configuration(s) you wish to generate a report for, add the options Details you want, check 
Include detail information following... and Include Header Image, as you wish, then click OK. 

Report Designer 

You can modify standard reports and also create and edit user reports in the 2020 Report Designer 
program.  

1. Click  on the Reports toolbar. 

2. See the Report Designer help for information on using this program. 

3. After making changes to a report design, click  on the Reports toolbar to 
regenerate the report. 
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View report pages 

From the Report tab toolbar, use the arrow buttons to view pages in the report: 

 
Or, type the page number in the Go To Page box then press Enter: 

 
To zoom in or out, click the Zoom icon and select the zoom factor. 
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Export a report to PDF 

Once you created a report, you can export it to a .pdf file. 

1. From the Report tab, click the Export Report button on the toolbar. 
 

 
2. In the Save As dialog, choose the disk/folder where you want to save the PDF file in 

the Save in field. 
 
In the File name field, type in the name of the file and press ENTER. 
 
The exported PDF file will now be in the location you specified.  
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Print reports 

You can print the report independently or with the cover page and worksheet. 

To print the report only: 

1. From the Report tab toolbar, click . 
 

 
2. Select the Printer, the Print range and the Number of copies. 

3. Click OK. 

To print the report with the cover page and worksheet: 

1. Click the Worksheet tab. 

2. From the File menu, select Print Levels. 
 
The Print Level dialog will open. 

3. Check Include the Cover Page and Include the Report. 

4. Click Print. 
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Frame Designer (Giza only) 
Many manufacturers have a frame and tile system that you can work with. Your design may start as a 
drawing or as a specification. During the design process you will need to define the buildup of the frame 
— this is called a frame design.  The design will combine frame designs with the frames and other 
furniture components to create an order. 

A frame design stores the frame type, frame height, and all components for a complete frame. Frame 
components include tiles, topcap, add-on frames, load bars, and segment kits. Color and option set 
values can be specified for tiles and top caps. 

You can create frame designs using either of the following methods: 

 Create a frame design in 2020 Worksheet 

 Import frame designs from manufacturer design files, Giza drawings, and design sets created 
using Frame Designer 

Once you have created a frame design, you can add it to the current worksheet. 

Note: Frame designs can only be specified for manufacturer libraries which support Frame Designer.  A 
frame design is independent of the frame width. 

See: 

 Access the Frame Designer 

 Create a frame design 

 Modify a frame design 

 Print a frame design 

 Export frame design sets 

 Import frame design sets 

 Add frame designs to a worksheet 

 Frame Designer preferences 
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Access the Frame Designer 

1. Click  on the Worksheet toolbar. 
  

2. Select the Manufacturer and Catalog that you wish to use. The dialogs/choices will 
vary with each manufacturer. 
 

 
3. Click Designer. 
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See also: 

 Create a frame design 

 Modify a frame design 

 Print a frame design 

 Export frame design sets 

 Import frame design sets 

 Add frame designs to a worksheet 

 Frame Designer preferences 

Create a frame design 

1. Click  on the Worksheet toolbar. 

2. In the Frame Designs dialog, select the Manufacturer and Catalog that you wish to 
use. The dialogs/choices will vary with each manufacturer. 

3. Click Designer. 
 
The Frame Designer dialog displays the Catalog selected, the default frame type 
and size, usually the smallest. If  this is the first frame design you are creating for 
the selected catalog, the Design name box is empty. 

4. Change the Frame Type and Frame Height to a standard panel height, for example 
61”. 
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5. Use the Tile drop down menus to pick the tiles required. 

6. Click the Color button to the right of each tile dropdown to specify color for tiles 
and topcaps. 
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7. In the text box to the right of the Color button, you can specify the Option Set 

value. 

8. To place a stack-on or segment kit in a slot, right-click in the Stack-on location of the 
frame. Select an available kit from the submenu. 
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Each manufacturer will have different items that can be stacked. If the Stack-on frames menu is 
grayed out you cannot add any more. 

To remove an add-on frame, right-click on it then click the Remove command on the submenu. 

To change an add-on frame, right-click on it then select another add-on frame. 

9. Click the Preview tab to see a front and back elevation of the frame. 

10. Click the BOM tab to review the part numbers of the tiles selected. 

11. Save the configuration by clicking either the Save  or Save as  icon on the 
toolbar. 

12. In the Save As dialog, type a Design Name (maximum 15 characters, no symbols) 
and a Description (maximum 20 characters). 
 
If a design of the same name already exists, 2020 Worksheet will prompt you to 
overwrite the existing design. 

13. Click OK. 
 
Notice that the design name is now displayed. 
 

 
14. Close the Frame Designer dialog when finished by clicking the red X at the top of 

the dialog. 
 
In the Frame Designs dialog, notice that the Name of the design you created is now 
available under Frame Design. 
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15. Click the Update button to create all the frame design sizes for that configuration. 

16. Click OK when you see the confirmation message. 
 
2020 Worksheet updates all frame designs in the current 2020 Worksheet. During 
the update, if a frame design does not exist, its dependent items are removed from 
the project. 

The frame design is accessible from the current worksheet only.  If you wish to use it in other 
worksheets, you will need to export it to a design set then import the design set into another 
worksheet. 
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See also: 

 Modify a frame design 

 Print a frame design 

 Add frame designs to a worksheet 

 Frame Designer preferences 

Note: You can also create a new frame design by clicking   in the Frame Designer dialog. You will 
have to enter the design name and description right away. Follow the same steps as above. 

Modify a frame design 

Note: For instructions on creating a frame design, see Create a frame design. 

1. Access the Frame Designer. 
 
To access the frame design right away, select the name in the Frame Designs dialog 
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2. In the Frame Designer dialog, select the frame design Name. 
 

 
3. Make modifications to the design as necessary. 

4. Save the configuration by clicking  on the toolbar. 
 
If you want to create a new frame design based on the current one, click Save as 

  . 

5. Close the Frame Designer dialog when finished by clicking the red X at the top of 
the dialog. 

6. Click the Update button to create all the frame design sizes for that configuration. 

7. Click OK when you see the confirmation message. 
 
2020 Worksheet updates all frame designs in the current 2020 Worksheet. During 
the update, if a frame design does not exist, its dependent items are removed from 
the project. 

See also: 

 Print a frame design 

 Export frame design sets 

 Import frame design sets 

 Add frame designs to a worksheet 

 Frame Designer preferences 
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Note: To delete a frame design, select the frame design name then click Delete . To print a frame 
design, see Print a frame design. 

Print a frame design 

1. Access the Frame Designer. 

2. In the Frame Designer dialog, select the frame design name. 
 

 
3. Click the Print button. 

4. Select the Printer, the Print Range, and the number of copies. 

5. Click OK. 
 
This will print a page showing the front and back elevation of the frame. 

See also: 

 Create a frame design 

 Modify a frame design 

 Export frame design sets 

 Import frame design sets 

 Add frame designs to a worksheet 

 Frame Designer preferences 
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Export frame design sets 

You can export frame designs so that they can be used in other worksheets or Giza designs. 

1. After creating or modifying frame designs, click . 

2. In the Export Design dialog, click New. 

3. Type a name for the Design Set. 
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4. Click OK. 

5. Pick all the frame designs you wish to export. 
 
Use the SHIFT or CTRL keys to select more than one frame design. 

6. Click Export. 
 
This frame set can be used in other worksheets or Giza designs. When you import 
Giza Designer projects, frame designs defined in the project are also imported as 
Standards. 

See also: 

 Print a frame design 

 Add frame designs to a worksheet 

 Frame Designer preferences 

Import frame design sets 

You can import design frames from manufacturer design files, Giza projects, and other 2020 Worksheet 
projects. 

Some manufacturers provide special frame designs. These are installed with the manufacturer's 
libraries. 

To import a frame design set into a Worksheet: 

1. Access the Frame Designer. 

2. Click . 

3. Beside Import From, select Design Set. 
 
You can also select Giza Project or Manufacturer Design file. 
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4. Select the Design Set you wish to import from. 
 
If you chose Giza Project in the previous step, select the location of the Giza 
drawings and the project which contains the frame designs. 

5. Select the frame designs you need. 
 
Use the SHIFT or CTRL keys to select more than one frame design. 
 

 
6. Click Import. 
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7. Click Close when you are finished. 
 
Now you will be able to use the frame designs in the worksheet or in a Giza Design. 

See also: 

 Print a frame design 

 Add frame designs to a worksheet 

 Frame Designer preferences 

Add frame designs to a worksheet 

After creating the frame designs you will need to add them to the current worksheet. 

1. Click   on the Item toolbar then select Frame Design. 

2. In the Import Frame Design dialog, select the Manufacturer and Catalog. 

3. Select the Frame Design Name. 

4. Select a width. 

5. Click Insert. 

6. Continue to add frames of different configurations and sizes. 

7. Click Close. 
 
Your worksheet will have a Standards line for each Frame Design size you added. 

8. If necessary, change the quantity of the frame designs. 

9. Click the Worksheet Title dropdown to see a list of the Frame Designs. 

10. Select a frame design to see the details. 
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A frame design is a Standard and will open the same way. 
 

 
Note: Option set values are stored in the Alias3 column. 

For more on working with Standards, see Standards. 
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See also: 

 Modify a frame design 

 Print a frame design 

 Export frame design sets 

 Import frame design sets 

 Frame Designer preferences 

Frame Designer preferences 

1. Access the Frame Designer. 

2. Click the Preferences button. 
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3. Make changes to the Design and Report preferences. 

4. Click OK to save your preferences and close the dialog box. 

Note: If you want to load the default configuration, click Default. 

Design preferences 

In this area, you can configure frame design options. 

Check box Description 

Clear 
option set 

When checked, the Option set field is cleared when you 
select another tile on the Define tab. 

Select 
default 
color 

When checked, the color is changed to the default color of 
the new tile when you select another tile on the Define tab. 

Include 
color 

When checked, 2020 Worksheet includes color in the 
comparison for similar designs. 

Show 
controls 
only 

When checked, 2020 Worksheet displays the tile list, color 
button, and Option Set box only for the active slot on the 
Define tab. 
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Report preferences 

In this area, you can select the details you wish to display in the BOM tab, Preview tab, and the Frame 
Layout. 

Field Description 

Translated 
partcodes   

When checked, exact product numbers are displayed on the BOM tab 
and printed in the Frame Layout. Also, Frame Width is available. When 
cleared, the Frame Layout and BOM tab display the product number 
formulae. 

Frame 
Width 

The value specified in this box is used for evaluating the product number 
formulae. Frame Designer does not check if the product number 
displayed is available in the library. 

Element 
names 

When checked, product descriptions are printed in the Frame Layout 
report. 

Element 
heights      When checked, product heights are printed in the Frame Layout report. 

Element 
part codes    When checked, product numbers are printed in the Frame Layout report. 

Element 
options       When checked, option sets are printed in the Frame Layout report. 

Click Font to select the font for text on the Preview tab. 
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Command reference 
This section lists commands available through the various menus. All commands are already referenced 
by their respective tasks in this help file. The following topics give you a brief description of menus and 
commands and provide links to corresponding topics. 

 File menu 

 Edit menu 

 View menu 

 Item menu 

 Worksheet menu 

 Reports menu 

 Visualize menu 

 Tools menu 

 Help menu 

File menu 

Command Shortcut Description Help topic 

New Ctrl+N Create a new worksheet New blank worksheet 

New 
Worksheet 
Wizard 

  Create a new worksheet 
using the Worksheet Wizard 

New worksheet using the 
Wizard 

Open Ctrl+O Open a worksheet Open a worksheet 
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Open Recent 
Worksheet 

  Open a file you recently 
worked on 

Open a worksheet 

Close Ctrl+F4 Close the current worksheet Close a worksheet 

Close All   Close all open worksheets Close a worksheet 

Save Ctrl+S Save the current worksheet Save a worksheet 

Save As   Save the current worksheet 
under a different name 

Save a worksheet 

Save As Visual 
Worksheet 

  Save an associated 
worksheet as a visual 
worksheet 

Associated-visual and 
visual-only worksheets 

Save As Classic 
Worksheet 

  Save an associated or a visual 
worksheet as a classic 
worksheet 

Associated-visual and 
visual-only worksheets 

Save As Single 
Level 
Worksheet 

  Create and save a new 
worksheet with items from 
standards/outline levels 
listed individually. 

Save as single level 
worksheet 

Save All   Save all open worksheets Save a worksheet 

Purge   Purge a worksheet to control 
its size 

Purge a worksheet 

Project 
Management 

Ctrl+M 

  

Edit project notes 

  

Manage projects 
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Project 
Properties 

Ctrl+Enter Edit project template settings 

  

Project templates 

Worksheet 
Properties 

Alt+Enter Edit Worksheet properties: 
title, customize column 
settings, page header and 
footer setup and price 
adjustments 

Worksheet properties 

Worksheet 
Link 

  Insert links to other 
worksheet files 

Worksheet links 

Print Ctrl+P Print the current worksheet Print a worksheet 

Print Levels   Print the current worksheet 
and/or items within standard 
or outline levels.  From here 
you can also print the cover 
page and the report. 

Print multiple levels 

Print Preview   Preview the current 
worksheet before printing 

  

Preview before printing 

Print Setup   Select the default printer to 
be used when printing 

Set the default printer 

Page Setup   Set the page margin, the 
header and footer's distance 
to frame, the worksheet 
appearance, page orientation 
and centering 

Page Setup 
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Page 
Header/Footer 

  Customize the header and 
footer when printing a 
worksheet 

Header / Footer 

Send   E-mail the current worksheet E-mail a worksheet 

Merge   Combine two or more 
worksheets into one 

Merge worksheets 

Import Center   Import data from other 
applications into the current 
worksheet 

Import data 

Export Center   Export the current worksheet 
to different file formats 

Export data 

Convert   Export multiple worksheets 
at one time to OFDA XML or 
CAPSIF. You can also convert 
a Giza User Library to a 
Custom Catalog. 

Convert data 

Exit   Close the 2020 Worksheet 
program. 

If one or more worksheets 
are on screen when using this 
command and some were 
not saved, the program asks 
you to Save (Yes or No) or to 
Cancel the Exit command. 
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Edit menu 

Command Shortcut Description Help topic 

Undo Ctrl+Z, 

Alt+Backspace 

Undo an action. The 
drop down allows 
multiple steps to be 
undone at one time. 

Undo an action 

Redo Ctrl+Y, 

Ctrl+Backspace 

Redo an undone 
action. The drop down 
allows multiple steps 
to be redone at one 
time. 

Redo an action 

Cut Ctrl+Shift+X Cut selected item or if 
nothing is selected, 
the current item 

Cut, copy and paste 
an item 

Copy Ctrl+Shift+C Copy selected item or 
if nothing is selected, 
the current item 

Cut, copy and paste 
an item 

Paste Ctrl+Shift+V Paste the last items 
that were cut or 
copied 

Cut, copy and paste 
an item 

Select   Select any of the 
following: all, flagged, 
locked, complete or 
incomplete items.  You 

 Select items 

 Select flagged, 
locked, complete or 
incomplete items 
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can also select by 
criteria. 

 Select by criteria 

Clear 
Selection 

Esc Clear selected items Select items 

Invert 
Selection 

  Select items that were 
not selected and clear 
selected items 

Select items 

Find Ctrl+F Find any string in the 
worksheet 

Find text in a 
worksheet 

Replace Ctrl+R Replace an existing 
value with a new one 

Find and replace an 
item 

Find/Replace 
Again 

F3 Run Find or Replace 
again 

  

Go To Ctrl+G Go to a specific line 
and column in the 
current worksheet 

Go to a specific line 
and column 

Assign   Fill in cell values in the 
current worksheet 

Quickly fill in cell 
values (Assign) 

Block Assign   Copy the options 
and/or attributes of 
one item to other 
items on the 
worksheet 

Copy options and 
attributes (Block 
Assign) 
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Column Copy   Copy values from one 
column to another 

Copy values from 
one column to 
another 

Break 
Custom 
Catalog Link 

  Break the link to the 
custom catalog 

Break custom 
catalog links 

Flatten 
Standard or 
Outline Level 

  Flatten the Standard 
or Outline level so that 
all its components are 
listed as individual 
items in the worksheet 

Flatten a Standard 

Convert to 
Custom Item 

  Convert the current 
item to a custom item. 

All options will be 
converted to ISF 
attributes 

Manufacturer-
specific information 
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Convert B2B 
to OEM 

  Convert items from 
their B2B codes back 
to the regular MFR 
codes 

  

Manufacturer 
Specific 

  Convert to Steelcase 
Special, Haworth 
Special or Haworth 
Customer's Own 
Material 

Manufacturer-
specific information 

Option 
Clipboard 

  Access Option 
Clipboard commands 

Option Clipboard 

View menu 

Command Shortcut Description Help topic 

Full Screen Ctrl+Alt+V Turns Full Screen 
View on or off 

Full screen view 

Menu Bar   Turns Menu bar on 
or off 

Menu bar 

Status Bar   Turns Status bar on 
or off 

Status Bar 

Caption 
Bar 

  Turns Caption bar on 
or off 

Caption Bar 
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Toolbars   Turns toolbars on or 
off 

Show or hide a toolbar 

Explorer 
Bars 

  Turn Explorer bar 
tabs on or off 

Show or hide Explorer bar 
tabs 

Task Pane   Show or Hide the 
Task Pane; access a 
view in the Task 
Pane 

Access the Task pane 

Preview 
Bar 

  Show or hide the 
Preview pane 

Preview a product 

Worksheet   View the Worksheet 
tab of the 
Worksheet area 

Worksheet Tab 

Global 
Options 

  View the Global 
Options tab of the 
Worksheet area 

Global Options 

Cover Page   View the Cover Page 
tab of the 
Worksheet Area 

Edit an existing cover page 

Report   View the Report tab 
of the Worksheet 
area 

View a report 

Rows   Turn rows on or off 
in a worksheet 

Show or hide rows 
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Columns   Access column 
commands 

Customize columns 

Resize columns 

Sort records by column 

Levels   Access commands 
specific to Standards 
or Outline levels 

View the contents of a 
standard 

Step out of a Standard 

Print multiple levels 

Show levels in Explorer 

Templates   Access Worksheet 
Template commands 

Apply a template to a 
worksheet 

  

Item menu 

Command Shortcut Description Help topics 

Insert   Insert a row in 
the worksheet 

Add a product line 

Insert blank options 
and attributes 

Insert worksheet links 

Reuse a Standard 
from a custom catalog 

Outline levels 
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Add frame designs to 
a worksheet 

Price Adjustments 

Insert Subtotal 
Manually 

Delete Ctrl+Shift+Del Delete the 
current row 

Delete an item 

Move Ctrl+Shift+UpArrow 
(Move Up) 

Ctrl+Shift+DownArrow 

(Move Down) 

Move the 
current item in 
the Worksheet 

Move an item 

Split   Separate one 
line item into 
two identical 
items and split 
the quantity 

Split an item 

Flags   Access Flag 
commands 

Flag lines 

Locks   Access Lock 
commands 

Lock lines 

Properties Ctrl+Alt+Enter View all the 
details of the 
current item 

Item properties 
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Specify F8 Add finishes in 
2020 Options 

Specify - access 2020 
Options 

Edit 
Options 
and 
Attributes 

  Add, delete or 
modify options 
and attributes 

Options, Attributes, 
Copy options and 
attributes (Block 
Assign) 

Select 
Service 
Parts 

  Insert service 
parts in the 
worksheet 

Add service parts 

Explore F9 Open Content 
tab to the 
location of the 
current item 

Go to an item's 
location in Explorer 

Send To   Send items to 
Custom 
Catalogs, 
Worksheets, 
and Drawings 

Add items into a 
custom catalog from a 
worksheet 

Send To a Worksheet 

Send To a Drawing 
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Worksheet menu 

Name Shor
tcut 

Description Help topic 

Consolidate   Merges like items in the 
Worksheet 

  

Consolidate identical items 

Update Against 
Catalog 

Ctrl+
U 

Updates all or selected 
items against the 
Manufacturer or Custom 
Catalog 

Update Against a Catalog 

Update Against 
Worksheet 

  Updates items against a 
selected Worksheet by 
product number or tag 

Update against a worksheet 

Update Preview 
Images 

  Updates preview images 
of items in the Worksheet 

Update preview images 

Apply Discount Ctrl+
D 

Opens the Discount dialog 
box 

Discounts 

Apply Schedule   Apply discounts from a 
saved discount schedule 
to the current worksheet 

Apply Saved Discount 
Schedules 

Price 
Adjustments 

  Insert a price adjustment Price Adjustments 

Validate   Check items on the 
worksheet for invalid 

Validate a worksheet 
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pricing, incomplete 
options or other specified 
criteria 

Recalculate   Refreshes the Grand Total 
amounts 

Recalculate the Grand Total 

Frame Designs   Launches Giza Frame 
Designer to configure 
frame and tile products if 
the Automation is 
available 

Frame Designer 

Global Options 

  

  Access Global Options 
commands. These are 
accessible only if you are 
in the Global Options tab. 

Global Options 

Show Associated 
Drawing 

  If the current worksheet is 
associated to a drawing, 
opens AutoCAD and loads 
the associated drawing 

Associated worksheets 
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Reports menu 

Command Description Help topic 

Create Quick 
Report 

Creates a quick report 
based on the columns 
displayed in the 
worksheet 

Generate Quick Reports 

Panel Builder 
Report 

Creates a report of one 
or more Panel Builder 
configurations with 
graphics only information 
or with detailed options 
information 

Create a Panel Builder Report 

Edit Report 
Design 

Edit the active report in 
the Report Designer 

Report Designer 

Manage Report 
Designs 

Create, edit, and manage 
your report designs 

  

Create, edit and manage reports 

Refresh the 
Report View 

Refreshes report view to 
show any changes in 
report design or content 
of the current worksheet 

Report Designer 

Apply Report 
Design 

Shows the available 
standard and user report 
designs that can be 
applied 

Apply a standard or user report design 
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Edit CoverPage 
Layout 

Edit the cover page 
layout in 2020 CoverPage 
Designer 

Edit an existing cover page 

Manage 
CoverPage 
Layouts 

Create, edit, rename or 
delete cover page 
layouts.  Set a cover page 
layout as default or apply 
it to the current cover 
page. 

Manage cover page layouts 

Refresh the 
Cover Page 
View 

Refresh the cover page to 
show any changes in 
cover page design or 
content of the current 
worksheet 

Edit an existing cover page 

Apply 
CoverPage 
Layout 

Shows the available 
standard and user cover 
page layouts that can be 
applied 

Apply a cover page layout 
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Visualize menu 

Command Description Help topic 

Select 
scene 

To start Visual 
Impression and 
select a scene that 
was created in CAP 
Designer or Giza 
Designer 

Visualize a scene or all products in Visual Impression 

Scene To select a CAP 
Designer or a Giza 
Designer scene in 
Worksheet to start 
Visual Impression 
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Tools menu 

Command Shortcut Description Help topic 

Preferences   Set Worksheet 
preferences 

Preferences 

Contacts   Add and edit 
contacts in the 
Contact database 

Contacts 

Visual 
Impression 

  To launch Visual 
Impression to 
visualize scenes or 
all products 

Visualize a scene or all products in Visual 
Impression 

Visual 
Materials 

  To launch Visual 
Materials to apply 
and manage 
color/texture 
samples from the 
generic, supplier 
or manufacturer 
database for use 
in Visual 
Impression 

Visual Materials in Visual Impression help 

Report 
Designer 

  Open 2020 Report 
Designer to create 
and edit reports 

  

See 2020 Report Designer help 
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CoverPage 
Designer 

  Open 2020 
CoverPage 
Designer to create 
and edit cover 
page layouts 

See 2020 CoverPage Designer help 

Panel Builder   Launch Panel 
Builder to create 
panel configurations 

See Panel Builder help 

Search F11 Search the 
manufacture 
catalogs for a part 
by part number or 
description 

Search for products 

Compare F12 Compare two or 
more worksheets 
to determine 
reusable, excess 
and new product 

Reconfiguration projects 
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Manufacturer 
Specific 

  Run the Steelcase 
Style Number 
Conversion Wizard 
or the Global 
Order Entry Field 
Import 

See the Help file on 2020 Worksheet 
Manufacturer-Specific Information. 

User Defined   Contains user-
defined 
commands.  Click 
Customize to add 
a menu item and 
associate it to an 
executable file. 

  

Help menu 

Command Shortcut Description Help topic 

Topics F1 Open the 
2020 
Worksheet 
online help 

  

What's New   Open the 
What's New 
window 
where you 
can read 
about and 

What's new 
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download 
software and 
manufacturer 
catalog 
updates. 

User Guide   Open a PDF 
version of 
the online 
help 

View or print the User Guide 

Release Notes   To read 
notes about 
the current 
release 

  

www.2020technologies.com   View the 
2020 
Technologies 
website 

  

Diagnostics   Troubleshoot 
and repair 
damaged 
files 

Diagnostics 

Check for Software Updates   To view 
updates for 
your system, 
view update 
descriptions 
and 
download 
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and install 
updates 

Check for Catalog Updates   To view 
manufacturer 
catalogs 
updates, 
view update 
descriptions 
and 
download 
and install 
updates 

  

About 2020 Worksheet   Displays the 
2020 
Worksheet 
version 
number 

Software version (About 2020 
Worksheet) 
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Manufacturer-specific information 
The following Worksheet features/commands apply to certain manufacturer product lines only.  Refer 
to the appropriate topic in the help file on 2020 Worksheet Manufacturer-Specific Information. 

 Global Order Entry 

 Convert to Steelcase Special 

 Convert to Haworth Special 

 Convert to Haworth's Customer Own Material 

 Steelcase Style Number Conversion Wizard 
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